
Commands

Add Component Name
Align Objects
Align objects on bottom
Align objects on left
Align objects on right
Align objects on top
Bring To Front
Bring To Front Of
Center objects around horizontal axis
Center objects around vertical axis
Change
Change Object Graphically or Move
Change Object Graphically or Set Focus
Change Single Object
Clear
Component Description
Component Rule Check
Copy
Copy Component
Cursor Down
Cursor Left
Cursor Right
Cursor Up
Cut
De-Select All
De-Select Inside Area
De-Select Outside Area
Delete
Delete Single Object
Distribute equally along horizontal axis
Distribute equally along vertical axis
Execute Paste Array
File Close
File Exit
File Merge
File New
File Open
File Print
File Save
File Save All
File Save As
Find Next Text
Find Text
Find and Replace Text
First Component
Help About
Help Basic Concepts
Help Commands
Help Index
Help Printing
Help Reference
Hot Keys
Information System Status



Jump New Location
Jump To Origin
Last Component
Memory Monitor Setup
Move
Move Component
Move Selection
Move Single Object
Move To Front
New Component
New Part
Next Component
Next Part
Open Environment Configuration File
Paste
Paste Array
Place Arc
Place Bezier
Place Ellipse
Place Elliptical Arc
Place Graphic
Place IEEE Symbol
Place Junction Symbol
Place Line
Place Part
Place Pie Charts
Place Pin
Place Polygon
Place Rectangle
Place Round Rectangle
Place Text
Popup Alignment Menu
Popup Component Menu
Popup De-Select Menu
Popup Edit Menu
Popup File Menu
Popup Help Menu
Popup Info Menu
Popup Jump Menu
Popup Move Menu
Popup Options Menu
Popup Place Menu
Popup Select Menu
Popup Window Menu
Popup Zoom Menu
Preferences
Previous Component
Previous Part
Redo
Remove Component
Remove Component Name
Remove Duplicates
Remove Part
Rename Component
Report Component
Report Library



Run CSV Editor
Run Calculator
Run Clock
Run Control Panel
Run File Manager
Run Notepad
Run Picture Editor
Run Schematic Capture
Run Text Editor
Run User Program 1
Run User Program 2
Run User Program 3
Run User Program 4
Run Windows Setup
Save Environment Configuration File
Screen Redraw
Select All
Select Inside Area
Select Outside Area
Send To Back
Send To Back Of
Setup Autopan
Setup Printer
Setup User Programs
Shift Cursor Down
Shift Cursor Left
Shift Cursor Right
Shift Cursor Up
Show De-Morgan
Show IEEE
Show Normal
Toggle Command Status Bar
Toggle Drawing Toolbar
Toggle Hidden Pins
Toggle IEEE Toolbar
Toggle Main Panel
Toggle Main Toolbar
Toggle Scroll Bars
Toggle Selection
Toggle Single Object
Toggle Snap Grid
Toggle Status line
Toggle Visible Grid
Undo
Update Schematic Editor
Using Help
Window Arrange Icons
Window Cascade
Window Close All
Window Tile
Workspace Options
Zoom 100%
Zoom 200%
Zoom 400%
Zoom 50%
Zoom All



Zoom In
Zoom Out
Zoom Pan
Zoom Point
Zoom Window
Zoom Workspace



File Open

Summary Open and load a component library file.

To Launch  F O    -    

Purpose The file open command is used to load and display the contents of a component 
library file into a new document window, ready to visually browse or edit.

Outcome Once the library file has been selected it will load into a new document window 
and all the workspace preferences will be restored. This is because Schematic Library Editor stores the 
workspace options in the library file whenever you save the file.

Comments Schematic Library Editor can load any number of library files into separate windows 
using the Multiple Document Interface (MDI). Schematic Library editor will load Protel 
Schematic (Binary and ASCII) library files as well as OrCAD STD III and STD IV.

          When no document file is open, the Menu bar displays three options: File, Info and Help. 

          You can abort the drawing (or redraw) of the document window, at any time, by pressing 
the spacebar. This allows you to move directly to another menu command or Tool button 
without waiting for the entire screen redraw to be completed.

Procedure To open a previously created file:

          1. Choose Open from the File menu.

          2. Type the file name (include the full path, if different from the path listed after Directory)

          3. Click OK to open the file.

          You can also double-click on the desired file name in the Files window, if any. To change 
directories, click under any of the options listed in the Directories window.



File Merge

Summary Merge components from another library to current library file.

To Launch Alt F M

Purpose The File Merge command is used to copy the contents of another library file to the library 
in the current workspace. This command is used to create customized libraries.

Outcome Once the source library file has been selected, all of the components in this file will be 
copied to the current library in the workspace.

Comments Merging component libraries simply copies all of the contents of one library file to 
another file. Components are not deleted or renamed from any of the files. Duplicate 
components may be removed by using the Remove Duplicates command from the 
Component menu.

Procedure To merge components from another library file into the current library.

          1. Choose Merge from the File menu.

          2. Type the source file name (include the full path, if different from the path listed after 
Directory)

          3. Click OK to merge the contents of the chosen file to the current library.

          You can also double-click on the desired file name in the Files window, if any. To change 
directories, click under any of the options listed in the Directories window.

See also
Copy Component
Remove Duplicates



File New

Summary Create a new and empty component library file.

To Launch  F N

Purpose The File New command is used to create a new blank component library.

Outcome When you choose the File New command, an empty document window is displayed and 
becomes the current window with the title "LIB_#."

Comments You can change and define various workspace settings, such as workspace orientation, 
background color, border color and other settings by choosing Workspace from the 
Options menu.

Procedure To create a new component library:

          1. Choose New from the File menu.

See also
Workspace Options



Copy Component

Summary Copy component from current library to another library file.

To Launch Alt C C

Purpose The Copy Component command is used to copy a component from the current library 
file to another library file. This command is used to create customized libraries.

Procedure To copy the current component into another library.

          1. Choose Copy Component from the Component menu.

          2. Choose the destination library file.

          3. Click OK to copy the component in the current library document window to the chosen 
destination library file.

          You can also double-click on the desired destination library file name.

See also
File Merge
Move Component



Move Component

Summary Move component from current library to another library file.

To Launch Alt C M

Purpose The Move Component command is used to move a component from the current library 
file to another library file. This is similar to the Copy Component command, except that 
the component is physically removed from the current library and placed in the 
destination library. This command is used to create customized libraries.

Procedure To Move the current component into the another library.

          1. Choose Move Component from the Component menu.

          2. Choose the destination library file.

          3. Click OK to move the component in the current library document window to the chosen 
destination library file.

          You can also double-click on the desired destination library file name.

See also
Copy Component



File Save All

Summary Save all loaded component library files.

To Launch Alt F L

Purpose The File Save All command can be used to save all of the component library files in all 
currently opened document windows.

Outcome When you select the File Save All command, this will save the contents of all the library 
document windows to the Schematic Library Editor binary file format, using the existing 
paths and file names.

Procedure To save all library files which are currently opened:

          1. Choose Save All from the File menu.

See also
File Save
File Save As



Run Schematic Capture

Summary Launch and Switch to the Schematic Sheet Editor.

To Launch  T H    -    

Purpose The Run Schematic Capture command is used to launch and switch to the 
Advanced Schematic Editor application window.

Comments The Run Schematic command can also be activated by clicking Place in the Main 
Panel window.

Procedure To switch to the Schematic Editor:
          1. Choose Run Schematic from the File menu.

          If the Schematic Editor has been previously loaded then the focus will switch to the 
Schematic Editor application window, otherwise the Schematic Editor will be launched, 
loading previously opened schematic worksheet files.

See also
New Part
Update Schematic Editor



Update Schematic Editor

Summary Update components in all opened schematic worksheet files.

To Launch Alt F U

Purpose The Update Schematic Editor command is used to automatically update/replace 
matching parts in opened schematic worksheet files with the component in the current 
document window.

Procedure To automatically update modified schematic components:

          1. Choose Update Schematic from the File menu.

See also



File Exit

Summary Quit from Schematic Library Editor.

To Launch  F X

Purpose The File Exit command is used to close down all opened component library files, and 
end the current work session of the Library Editor.

Outcome When the File Exit command is selected, this quits the current session of Schematic 
Library Editor and prompts to save modified files.

Procedure To quit the current session of Schematic Library Editor:

          1. Choose Exit from the File menu.

          2. If any document window has been modified since last saving, a dialog box will be 
displayed that prompts to save the library file(s). Confirm to save the file(s) or select 
Cancel to ignore the File Exit command.



Hot Keys

Summary Setup Hot Key assignments.

To Launch  O H

Purpose The Options Hot Keys command is used to assign keyboard keys and mouse button 
clicks to the Library Editor command processors, such as "Place Pins," "Show De-
Morgan," "Toggle Snap Grid" or any other command.

Comments There are three other buttons in this dialog box; Load is used to open a previously saved 
hot key assignments file. Save is used to save the current hot key assignments to a file. 
Finally, Defaults is used to restore the current hot key assignments to the Library Editor 
default settings which are listed at the back of this reference.

Procedure To assign keyboard keys and mouse button clicks to command processes;

          1. Choose Hot Keys from the Options menu.

          2. Select a command from the Menu Commands window.

          3. Select a keyboard key or mouse click such as "Right Click" from the Keys window. 
You can also use a combination of CTRL and SHIFT.

          4. Click the Assign button to accept the hot key assignment.

          5. Assign more commands to hot keys or click OK to close the Hot Keys dialog box.

See also



Preferences

Summary Setup System Preferences.

To Launch  O P

Purpose The Options Preferences command is used to define various system settings, such as 
auto backup time intervals, cursor shape, auto pan, delete confirmation, and other 
options that apply to all document windows.

Outcome The following are options that can be set within the preferences dialog box.

          Selections - The default color for selected objects can be changed by clicking in the 
color box and choosing another color from the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

          Grid Color - The visible can be assigned a default color. To assign new color to the 
visible grid, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

          Cursor Type - Three options are available for the physical (or workspace) cursor, a large 
90 degree cross, small 90 degree cross or a 45 degree cross. The workspace cursor is 
displayed when making selections, moving or placing objects. The workspace cursor 
snaps to each grid point if the snap grid is turned on, making it easier to control objects 
being placed or moved. The system 'arrow' is able to select objects independently of the 
snap grid being on or off, which makes selection easier when zoomed-out or when 
dealing with off-grid objects. The default cursor type is the small 90 degree cross.

          Visible Grid - The visible grid can be displayed as lines or dots.

          Undo Limit - This option allows the user to set the number of Undo/Redo levels. The 
default is 50. This allows the user to backtrack through (and restore) 50 individual 
operations. The legal range is 0-16000. Because each operation must be stored in 
memory to enable Undo/Redo, setting a higher number may result in performance 
deterioration, while editing. If you notice Advanced Schematic slowing down after using 
the application for a while, try selecting a lower number. The more memory you have 
installed in your machine, the higher the limit you can set without hurting the 
performance of your system. Setting this option to 0 will clear the Undo/Redo memory 
stack and disable the Undo/Redo command. 

          Dialog Text Font - The default font that is used for all dialog boxes can be changed with 
this command. The Library Editor must be closed and re-opended in order for this new 
font to change. 

          Snap To Center - If the Snap to Center option is enabled the cursor will jump to the 
center of an object when it is moved.

          Save Defaults - When this option is enabled, user settings, preferences and defaults are 
saved in an initialization file when exiting Schematic Library Editor. Save Defaults is 
enabled by default.

          Auto Backup Time - Sets the interval (in minutes) for generating an automatic backup 



of the active library file. To disable this feature, type 0. The default interval is 30 minutes.

          Clipboard Reference - When this option is enabled, you will be prompted to select a 
reference point when copying and cutting selected objects to the clipboard.

          Use Printer Fonts on Screen - When this option is enabled the fonts that have been 
used on the screen will be substituted for the closest matching fonts that the current 
selected printer supports. For example, if a vector plotter is selected and true type fonts 
are used on the schematic sheet, all the true type fonts on the screen will be displayed 
with the closest matching font that the plotter supports. This option is disabled by default.

          Auto Zoom - When enabled, redraws the workspace with the object centered in the 
window (not active when using Find command or Jump from the Browser). For example, 
when using the Window-Tile command this option re-draws the whole sheet centered in 
the window. 

          Convert Special Strings - When this option is enabled, the special strings that have 
been placed onto the worksheet, for example, ".DATE", are converted to show their true 
representations, in this case the current system date would be displayed. The following 
special strings may be placed on the schematic 
worksheet, .DATE, .TIME, .DOC_FILE_NAME, .organization, .address1, .address2, .add
ress3, .address4, .sheetnumber, .sheettotal, .title, documentnumber and .revision.

Procedure To setup the system preferences:

          1. Choose Preferences from the Options menu.

          2. Type in new system settings.

          3. Click OK to accept the new settings.

See also
Preferences



Toggle Main Panel

Summary Turn Main Panel on or off.

To Launch  O A    -    

Purpose The Toggle Main Panel command displays or hides the main panel, depending 
upon its current state.

Comments If the Main Panel is currently displayed, a check mark will be visible to the left of 
Main    Panel on the Options menu.

Procedure To turn the Main Panel on or off:
          1. Choose Main Panel from the Options menu.



Toggle Main Toolbar

Summary Turn the Main Toolbar on or off.

To Launch  O M

Purpose The Toggle Main Toolbar command is used to turn the Main Toolbar on or off.

Comments A listing of all the Main Toolbar buttons and commands can be found in the Tool Bars 
section, at the back of this reference manual.

Procedure To turn the Main Toolbar on or off:

          1. Choose Main Toolbar from the Options menu.

See also
Toggle IEEE Toolbar
Toggle Drawing Toolbar
Toggle Main Panel



Toggle IEEE Toolbar

Summary Turn the IEEE Toolbar on or off.

To Launch  O I    -    

Purpose The Toggle IEEE Toolbar command is used to turn the IEEE Toolbar on or off.
Procedure To turn the IEEE toolbar on or off:
          1. Choose IEEE Toolbar from the Options menu.

See also
Toggle Main Toolbar
Toggle Drawing Toolbar
Toggle Main Panel



Toggle Drawing Toolbar

Summary Turn the Drawing Toolbar on or off.

To Launch  O R    -    

Purpose The Toggle Drawing Toolbar command is used to turn the Drawing Toolbar on or 
off.

Comments A listing of all the Drawing Toolbar buttons and commands can be found in the 
Tool Bars section, at the back of this reference manual.

Procedure To turn the Drawing Toolbar on or off:
          1. Choose Drawing Toolbar from the Options menu.

See also
Toggle Main Toolbar
Toggle IEEE Toolbar
Toggle Main Panel



Toggle Status line

Summary Turn the Status Line on or off.

To Launch  O T

Purpose The Toggle Status line command is used to turn the Status line on or off at the bottom of 
the Schematic Library Editor window. Turning off the Status line shows more screen 
region.

Comments The status line displays information about the current activity or mode. When a 
command is selected, the left side of the status line briefly describes the chosen 
command. The left side of the status line also indicates the current cursor position.

Procedure To turn the Status line on or off:

          1. Choose Status line from the Options menu.



Popup Edit Menu

Summary Popup the Edit menu.

Purpose The Popup Edit Menu command is used to directly access the Edit menu at the current 
cursor position.

Procedure To popup the Edit menu at the current cursor position.

          1. By default, press E.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Place Menu

Summary Popup the Place menu.

Purpose The Popup Place Menu command is used to directly access the Place menu at the 
current cursor position.

Procedure To popup the Place menu at the current cursor position.

          1. By default, press P.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Select Menu

Summary Popup the Edit Select menu.

Purpose The Popup Select Menu command is used to directly access the Edit Select menu at the 
current cursor position.

Procedure To popup the Edit Select menu at the current cursor position.

          1. By default, press S.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup De-Select Menu

Summary Popup the Edit De-Select menu.

Purpose The Popup De-Select Menu command is used to directly access the Edit De-Select 
menu at the current cursor position.

Procedure To popup the Edit De-Select menu at the current cursor position.

          1. By default, press X.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Zoom Menu

Summary Popup the Zoom menu.

Purpose The Popup Zoom Menu command is used to directly access the Zoom menu at the 
current cursor position.

Procedure To popup the Zoom menu at the current cursor position.

          1. By default, press Z.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Options Menu

Summary Popup the Options menu.

Purpose The Popup Options Menu command is used to directly access the Options menu at the 
current cursor position.

Procedure To popup the Options menu at the current cursor position.

          1. By default, press O.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Help Menu

Summary Popup the Help menu.

Purpose The Popup Help Menu command is used to directly access the Help menu at the current 
cursor position.

Procedure To popup the Help menu at the current cursor position.

          1. By default, press H.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup File Menu

Summary Popup the File menu.

Purpose The Popup File Menu command is used to directly access the File menu at the current 
cursor position.

Procedure To popup the File menu at the current cursor position.

          1. By default, press F.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Info Menu

Summary Popup the Info menu.

Purpose The Popup Info Menu command is used to directly access the Info menu at the current 
cursor position.

Procedure To popup the Info menu at the current cursor position.

          1. By default, press I.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Popup Window Menu

Summary Popup the Window menu.

Purpose The Popup Window Menu command is used to directly access the Window menu at the 
current cursor position.

Procedure To popup the Window menu at the current cursor position.

          1. By default, press W.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Information System Status

Summary Display system information.

To Launch  I S

Purpose The Information System Status command is used to display system information, such as 
available disk space, free memory, date and time settings.

Comments Free memory - Amount of memory (in kilobytes) your system currently has free. If your 
computer is running under 386 enhanced mode, this will also include the amount of 
virtual memory available. This is the sum of your physical memory left and your disk 
space available on the drive where your swap file is set-up.

          Total Disk Space - Total storage space of your hard disk in kilobytes.

          Free Disk Space - Amount of disk storage space (in kilobytes) available on your hard 
disk.

          System Date - The current date of your system. Use the Control Panel to change the 
system date.

          System Time - The current time of your system. Use the Control Panel to change the 
system time.

          System Resources - Resources currently available on your system, displayed in 
percentage.

Procedure To display the current system settings:

          1. Choose System Status from the Info menu.

          A dialog box will open displaying the current system settings.



Help About

Summary Display the version number and copyright of Schematic Library Editor.

To Launch  H A

Purpose The Help About command is used to display the application name, version number and 
copyright information of Schematic Library Editor.

Outcome When you choose the Help About command a dialog box will open displaying the current 
version number and copyright information for Schematic Library Editor.

Comments This command could be used to find the current version number of Schematic Library 
Editor before calling technical support.

Procedure To display the version number of Schematic Library Editor:

          1. Choose About from the Help menu.

See also



Help Basic Concepts

Summary Basic information about Schematic Library Editor.

To Launch  H B

Purpose The Help Basic Concepts menu option displays an index of basic operational topics of 
Schematic Library Editor.

Outcome Once the Help Basic Concepts command is selected the Schematic Library Editor on-
line help system is loaded and displays an index of basic operational topics.

Procedure To display the index of basic operational topics:

          1. Choose Basic Concepts from the Help menu.

          2. Then choose the specific topic from the help index list.

See also
Help Index



Help Commands

Summary Help information organized by menu structure.

To Launch  H C

Purpose The Help Commands menu option displays the Schematic Library Editor index of menu 
commands, the topics offer access to detailed information about each command.

Outcome Once the Help Command option is selected the Schematic Library Editor on-line help 
system is loaded and displays an index of the menu commands available in Schematic 
Library Editor.

Procedure To display the index of menu commands:

          1. Choose Commands from the Help menu.

          2. Then choose the specific topic from the help index list.

See also
Help Index



Using Help

Summary Information about the Windows Help System.

To Launch  H H

Purpose The Using Help command displays the introductory topic about how to access and use 
the on-line help system.

Outcome Once the Using Help command is selected the Schematic Library Editor on-line help 
system is loaded and displays instructions on how to use help.

Procedure To display the information on how to use the help system:

          1. Choose Using Help from the Help menu.

          2. Then choose the specific topic from the help index list.

See also
Help Index



Help Index

Summary Help system topic index.

To Launch  F1    -      H I    -    

Purpose The Help Index menu option displays the cross-referenced topics available under 
the help system.

Outcome Once the Help Index command is selected the Schematic Library Editor on-line 
help system is loaded and displays the index of contents.

Procedure To display the Help index:
          1. Choose Index from the Help menu.

          2. Then choose the specific topic from the help index list.



Help Printing

Summary Information about generating hard copy output.

To Launch  H P

Purpose The Help Printing menu option displays an index of printing and plotting topics.

Outcome Once the Help Printing command is selected the Schematic Library Editor on-line help 
system is loaded and displays an index of printing output topics.

Procedure To display the index of printing topics:

          1. Choose Printing from the Help menu.

          2. Then choose the specific topic from the help index list.

See also
File Print
Setup Printer
Help Index



Help Reference

Summary Schematic Library Editor Reference.

To Launch  H R

Purpose The Help Reference menu option displays an index of additional topics covering some of 
the automation features of Schematic Library Editor.

Outcome Once the Help Reference command is selected the Schematic Library Editor on-line help 
system is loaded and displays an index of reference topics.

Procedure To display the index of Reference topics:

          1. Choose Reference from the Help menu.

          2. Then choose the specific topic from the help index list.

See also
Help Index



Window Tile

Summary Tile all open schematic windows.

To Launch  Shift F4    -    Alt W T

Purpose The Window Tile command is used to arrange all open library document windows so that 
they are all visible and do not overlap.

Outcome Once the Tile command has been chosen all the open and non-minimized library 
document windows will be re-sized and arranged so that they are all visible and do not 
overlap.

Procedure To Tile all the non-minimized library document windows:

          1. Choose Tile from the Window menu.

See also
Window Cascade



Window Cascade

Summary Cascade all open schematic windows.

To Launch  Shift F5    -    Alt W C

Purpose The Window Cascade command is used to arrange all open library document windows 
so that they all overlap and each document title bar is visible.

Outcome Once the Cascade command has been chosen all the open and non-minimized library 
document windows will be re-sized and arranged so that they all overlap and each 
document title bar is visible.

Procedure To Cascade all the non-minimized library document windows:

          1. Choose Cascade from the Window menu.

See also
Window Tile



Window Arrange Icons

Summary Arrange all minimized open library document windows.

To Launch Alt W I

Purpose The Window Arrange Icons command is used to arrange the icons of all minimized 
library documents across the bottom of the Library Editor main window.

Procedure To Arrange all the minimized library document icons:

          1. Choose Arrange Icons from the Window menu.

See also
Window Cascade



Window Close All

Summary Close all open schematic windows.

To Launch Alt W L

Purpose The Window Close All command is used to close all library document windows and 
icons.

Procedure To close all the opened library document windows and icons:

          1. Choose Close All from the Window menu.

          2. If any library has been modified since last saving, a dialog box will be displayed that 
prompts to save the file(s). Confirm to save the file(s) or press Cancel to ignore the 
Close All command.

See also
File Close



File Print

Summary Print the current document with the last set printer options.

To Launch Alt F P

Purpose The File Print command is used to print or plot the active document window, using the 
current printer/plotter settings defined in the Printer Setup dialog box.

Outcome The library will be sent to the printer or plotter. A small dialog box is displayed showing 
the output device and page count. The status line shows the percentage complete.

Comments If you have selected a file as the output port, then you will be asked for an output file 
name.

Procedure To print the current document window:

          1. Choose Print from the File menu.

See also
Setup Printer



Setup Printer

Summary Printer and page setup.

To Launch Alt F I    -    

Purpose The Setup Printer command is used to change printers and to control printing 
options on the selected printer. This command is also used to setup the scale, color mode and margins of 
your workspace.

Outcome The following are options that can be set within the Printer Setup dialog box.
          Select Printer - The available output device options will include those that have been 

installed using the Windows Control Panel, (see your Microsoft Windows User's Guide for details).
          Batch Type - Allows you to choose between Single Component or All Components in the 

library.

          Color Mode - Allows you to choose between Color or Monochrome modes. Color mode 
allows you to print the workspace in color, if you are using a color-capable output device 
supported by a Windows 3 driver. Monochrome will print the workspace in a single color, 
regardless of the color capabilities of the output device.

          Margins - Allows you to define the Top, Bottom, Left and Right margins.

          Scale - Allows you to enlarge or reduce the size of your workspace by specifying a scale 
factor. If you wish to enlarge the workspace by 200% set the Scale to 2.000. The default 
value is 1.000.

          Scale to Fit Page - The workspace will be expanded/contracted to fit    within the defined 
margins for the current printer page size.

Comments Schematic Library Editor printing and pen-plotting are handled similarly to other 
Windows 3 applications. Windows manages the printing (or plotting) process and 
provides a range of raster and Postscript printer drivers and vector plotter drivers. These 
range from 9 pin dot matrix printers and multi-pen plotters, to high-resolution, color 
Linotronic imagesetters.

Procedure To setup your printer or plotter configuration:

          1. Choose Setup Printer from the File menu.

          2. Setup the output options in the Printer Setup dialog box.

          3. Press the OK button to accept the printer settings and return to the editor without 
printing the document or;

          4. Press the Print button to execute the File Print command. 

          The Preview button is used to visually check the orientation, positioning, margins and 
number of pages, before sending the file to the printer.

See also
File Print



File Close

Summary Close the current window.

To Launch Alt F C

Purpose The File Close command is used to close the current library document window.

Procedure To close the current library document window:

          1. Choose Close from the File menu.

          2. If the library document window has been modified since last saving, a dialog box will 
be displayed that prompts to save the library file. Confirm to save the file or select 
Cancel to ignore the Close command.

See also
Window Close All



File Save

Summary Save current library with same file name.

To Launch Alt F S    -    

Purpose The File Save command is used to save the current library document window.
Outcome When you select the File Save command, this will save the contents of the 

current library document window to the Schematic Library Editor binary file format using the existing paths 
and file names.

Comments If the schematic library has been created with the File New command and has 
not been previously saved, the Save File As dialog box will open. You can save the file to a new path, 
new name or format. A backup file of the original file with an extension ".bak" is made before the new file 
is saved.

Procedure To save the current library:

          1. Choose Save from the File menu.

See also
File Save All
File Save As



File Save As

Summary Save current component library with new file name.

To Launch Alt F A

Purpose The File Save As command can be used to save the active library file to a new path, new 
name or format.

Outcome When you select the File Save As command, this will open the Save File As dialog box, 
once you click OK the file will be saved to the new file name and/or directory that you 
specified.

Comments There are two file format options:

          Protel Binary This is the default setting - an efficient format that enables Schematic 
Library Editor to open or save files more quickly than the OrCAD or text version.

          Protel Text Protel's published (ASCII) text format for library files. The format of this file is 
described in the on-line help. ASCII files are less efficient than the binary version, but 
allow the user direct access to the design database for translation into other formats or 
other manipulation. If you open a Protel Text format file in Schematic Library Editor, it will 
be automatically saved in the default binary format when you choose File Save.

Procedure To save the current library document window to a new path, file name or format.

          1. Choose Save As from the File menu.

          2. Type a new file name for the component library. To change the output format of the 
file, choose one of the options listed in the File Types list.

          3. Click OK to save the file.

          To change directories, click under any of the options listed in the Directories window.

See also
File Save
File Save All



Undo

Summary Undo previous command.

To Launch  Alt BackSpace    -    Alt E U    -    

Purpose The Undo command is used to restore a library component to its state previous 
to the last operation. Multiple levels of undo are supported.

Outcome Reverses the effect of the previous edit(s), step-by-step, back to the number of 
operations specified under the Undo Limit option (Options-Preferences command).

Comments Schematic Library Editor stores operations as a stack in memory. Depending on 
the amount of memory available, you will eventually experience a noticeable decline in performance as 
the Undo/redo stack fills with large scale changes, such as global edits.

Procedure To undo the last operation:

          1. Choose Undo from the Edit menu.

See also
Redo



Redo

Summary Redo previous undo command.

To Launch  Ctrl BackSpace    -    Alt E R    -    

Purpose The Redo command is used to restore changes made by the last Undo 
command. Multiple levels of Redo are supported.

Procedure To redo the last operation:
          1. Choose Redo from the Edit menu.

See also
Undo



Cut

Summary Copy selected objects to clipboard and remove from workspace.

To Launch  Shift Delete    -    Alt E T    -    

Purpose The Edit Cut command is used to clear the objects that are currently selected in 
the workspace and copies it to the (internal) Schematic Library Editor clipboard (not the standard 
Windows clipboard). The Edit Paste command can be used to place the selection back into any open 
component library document window.

Outcome Removes the selected item(s) from the workspace and keeps a copy of the selection in 
the clipboard. The clipboard holds the last selection only, each time you use the Cut or 
Copy command, you overwrite the previous selection, stored in the clipboard.

Comments The Clipboard can be used to paste the selection to other Windows applications that 
support .WMF (Windows MetaFile) format.

Procedure To cut the current selection from the active window:

          1. Make sure that the current selection includes only those objects you wish to cut;

          You can use Edit De-Select to de-select objects that are not to be removed and then use 
Edit Select to select the objects that will be removed. You can also use the shortcut 
SHIFT+LEFT MOUSE to add objects to the current selection or to de-select any selected 
objects.

          2. Choose Cut from the Edit menu. (shortcut: SHIFT+DELETE);

          You will be prompted to select a reference point if the Clipboard Reference option is 
enabled in the Preferences dialog box. A reference point is a coordinate relative to the 
selected object(s). If the clipboard reference option is off then the current cursor position 
is used as the reference point.

See also
Copy
Paste



Copy

Summary Copy all selected objects to the clipboard.

To Launch  Ctrl Insert    -    Alt E C

Purpose The Edit Copy command is used to copy the objects that are currently selected in the 
workspace to the (internal) Schematic Library Editor clipboard (not the standard 
Windows clipboard). The Edit Paste command can be used to place a copy of the 
selection back into any open component library document window.

Outcome Makes a copy of the selection in the clipboard. The clipboard holds the last selection 
only, each time you use the Copy or Cut command, you overwrite the previous selection.

Comments The Clipboard can be used to paste the selection to other Windows applications that 
support .WMF (Windows MetaFile) format.

Procedure To copy the current selection from the active window:

          1. Make sure that the current selection includes only those objects you wish to copy;

          You can use Edit De-Select to de-select objects that are not to be copied and then use 
Edit Select to select the objects that will be copied. You can also use the shortcut 
SHIFT+LEFT MOUSE to add objects to the current selection or to de-select any selected 
objects.

          2. Choose Copy from the Edit menu. (shortcut: CTRL+INSERT);

          You will be prompted to select a reference point if the Clipboard Reference option is 
enabled in the Preferences dialog box. A reference point is a coordinate relative to the 
selected object(s). If the clipboard reference option is off then the current cursor position 
is used as the reference point. When you paste the selection, the reference point will 
locate the cursor at this same relative position, allowing you to accurately position the 
selection.

See also
Paste
Cut



Paste

Summary Place clipboard contents onto current library workspace.

To Launch  Shift Insert    -    Alt E P    -    

Purpose The Paste command is used to place the current clipboard contents into any 
open component library document window. Schematic Library Editor has its own clipboard format. The 
standard Windows clipboard is not used.

Comments You can repeat the Paste command to duplicate the selection.
Procedure To Paste selected objects from the clipboard to an open document:

          1. Choose Paste from the Edit menu. (shortcut: SHIFT+INSERT);

          You will be prompted to place the selection and a highlighted outline of the selected 
objects will be displayed. The cursor position relative to the selection is determined by 
the Reference Point designated when Cut or Copy was used to add the selection to the 
clipboard.

          2. Position the selection in the library workspace and click LEFT MOUSE or press ENTER.

See also
Cut
Copy



Clear

Summary Delete all selected objects from the current library workspace.

To Launch  Ctrl Delete    -    Alt E L

Purpose The Clear command is used to remove selected objects from the library workspace 
without copying it to the clipboard.

Outcome The selection will be cleared from the display.

Comments You can use the Edit Undo command (shortcut: ALT+BACKSPACE) to restore the cleared 
selection.

Procedure To clear the current selection from the active window:

          1. Make sure that the current selection includes only those objects you wish to clear.

          You can use Edit De-Select to de-select objects that are not to be deleted and then use 
Edit Select to select the objects that will be deleted. You can also use the shortcut 
SHIFT+LEFT MOUSE to add objects to the current selection or to de-select any selected 
objects.

          2. Choose Clear from the Edit menu. (shortcut: CTRL+DELETE).

          The selection will be cleared from the display.

See also
Undo
Cut
Delete
Delete Single Object



Move Selection

Summary Move selected objects to another area of the library workspace.

To Launch Alt E M S    -    

Purpose The Move Selection command is used to reposition an individual selected object 
or a complex selection containing many objects as a single entity.

Comments While moving a selection, you can rotate it around the cursor and flip it along its x 
or y axis using the following hot key shortcuts.

          spacebar: each press rotates the selection 90 degrees clockwise.

          x: flips the selection along its X axis.

          y: flips the selection along its Y axis.

Procedure To move selected objects in an open library window:

          1. Make sure that the current selection includes only those objects you wish to move.

          You can use Edit De-Select to de-select objects that are not to be moved and then use 
Edit Select to select the objects that will be moved. You can also use the shortcut 
SHIFT+LEFT MOUSE to add objects to the current selection or to de-select any selected 
objects.

          2. Choose Move and then Move Selection from the Edit menu.

          You will be prompted to select a reference point if the Clipboard Reference option is 
enabled in the Preferences dialog box. A reference point is a coordinate relative to the 
selected object(s). If the clipboard reference option is off then the current cursor position 
is used as the reference point. When you move the selection, the reference point will 
locate the cursor at this same relative position, allowing you to accurately position the 
selection.

          4. Position the selection in the library workspace and click LEFT MOUSE or press ENTER.

See also
Move



Select Inside Area

Summary Select all objects inside an area.

To Launch Alt E S I    -    

Purpose The Select Inside Area command is used to select all objects that lie completely 
within a user-defined rectangle in an open library document window.

Outcome The newly selected objects will be highlighted using the selection color defined in 
the Options Preferences dialog box. Any previously selected objects will remain selected.

Procedure To select objects within an area:

          1. Choose Select and then Inside Area from the Edit menu.

          You will be prompted: "Select First Corner."

          2. Move the cursor and then press ENTER or LEFT MOUSE to define the first corner of the 
selection rectangle.

          The prompt changes to: "Select Second Corner."

          3. Move the cursor to enclose the area to be selected in the highlighted rectangle.

          4. Press ENTER or LEFT MOUSE to complete the selection.

See also
Select Outside Area
Select All



Select Outside Area

Summary Select all objects outside an area.

To Launch Alt E S O

Purpose The Select Outside Area command is used to select all objects that lie completely 
outside a user-defined rectangle in an open library document window.

Outcome The newly selected objects will be highlighted using the selection color defined in the 
Options Preferences dialog box. Any previously selected objects will remain selected.

Procedure To select objects outside an area:

          1. Choose Select and then Outside Area from the Edit menu.

          You will be prompted: "Select First Corner."

          2. Move the cursor and then press ENTER or LEFT MOUSE to define the first corner of the 
selection rectangle.

          You will then be prompted: "Select Second Corner."

          3. Move the cursor to enclose the area to remain de-selected with the highlighted 
rectangle.

          4. Press ENTER or s LEFT MOUSE to complete the selection.

See also
Select Inside Area
Select All



Select All

Summary Select everything on the current library workspace.

To Launch Alt E S A

Purpose The Select All command is used to select all of the objects on the current library 
workspace.

Comments The selected objects will be highlighted using the selection color defined in the Options 
Preferences dialog box.

Procedure To select all objects from an open document:

          1. Choose Select and then All from the Edit menu.

See also
Select Inside Area
Select Outside Area



De-Select Inside Area

Summary De-Select all objects inside an area.

To Launch Alt E E I

Purpose The De-Select All command is used to de-select all of the objects on the current library 
workspace.

Procedure To de-select all objects from an open document:

          1. Choose De-Select and then All from the Edit menu.

See also
De-Select Outside Area
De-Select All



De-Select Outside Area

Summary De-Select all objects outside an area.

To Launch Alt E E O

Purpose The De-Select Outside Area command is used to de-select all objects that lie completely 
outside a user-defined rectangle in an open library document window.

Procedure To de-select objects outside an area:

          1. Choose De-Select and then Outside Area from the Edit menu.

          You will be prompted: "Select First Corner."

          2. Move the cursor and then press ENTER or LEFT MOUSE to define the first corner of the 
selection rectangle.

          You will then be prompted: "Select Second Corner."

          3. Move the cursor to enclose the area to remain selected with the highlighted rectangle.

          4. Press s ENTER or LEFT MOUSE to complete the selection.

See also
Select Outside Area
De-Select Inside Area



De-Select All

Summary De-Select all selected objects.

To Launch Alt E E A    -    

Purpose The De-Select All command is used to de-select all of the objects that are 
currently selected in the library document window.

Procedure To de-select all objects from an open library document window:
          1. Choose De-Select and then All from the Edit menu.

See also
De-Select Inside Area
De-Select Outside Area



Toggle Selection

Summary Toggle selection-state of objects.

To Launch Alt E N

Purpose The Toggle Selection command is used to select and de-select objects on a library 
workspace by moving the cursor over the object and clicking LEFT MOUSE or ENTER.

Outcome Objects that are selected will be outlined in the selection color defined in the Options 
Preferences dialog box.

Comments The Toggle Selection command is especially useful when working on a densely 
populated area of a workspace or when you wish to quickly add and remove a number of 
objects.

Procedure To toggle the selection of any object in an open library document window:

          1. Choose Toggle Selection from the Edit menu.

          2. Select or de-select the objects in the library document window by moving the cursor 
over the object and pressing ENTER or LEFT MOUSE.

          3. Press ESC or RIGHT MOUSE to leave this command.

See also
Toggle Single Object



Toggle Single Object

Summary Toggle selection-state of objects.

Purpose The Toggle Single object command is used to select and de-select objects in the library 
document window by moving the cursor over the object and clicking SHIFT + LEFT MOUSE.

Outcome Objects that are selected will be outlined in the selection color.

Procedure To toggle the selection of a single object in an open library document window:

          1. Move the cursor over the object to be selected.

          2. Press SHIFT + LEFT MOUSE to select or de-select the object.

See also
Toggle Selection



Delete

Summary Select and delete objects on library workspace.

To Launch Alt E D

Purpose The Delete command is used to delete objects in the library document window.

Comments All deletions can be restored by using the Edit Undo command (ALT+BACKSPACE). If you 
have deleted a series of objects, they will be restored individually, starting with the last 
object deleted.

          Accidental deletion of objects may be further safe-guarded by enabling the Question 
Delete option. If this option is enabled a Confirm Delete dialog box will be displayed as 
you select an object. You can enable or disable this message from the Preferences 
dialog box in the Options menu.

Procedure To Delete objects in an open library document window:

          1. Choose Delete from the Edit menu.

          2. Delete the objects from the workspace by moving the cursor over an object and 
pressing ENTER or LEFT MOUSE.

          As you delete an object, it will be cleared from the workspace and the status line will 
continue to prompt you to choose another object.

          4. Press ESC or RIGHT MOUSE to leave this command.

See also
Undo
Delete Single Object



Delete Single Object

Summary Delete object that currently has the focus.

Purpose The Delete Single object command is used to delete an object that currently has the 
focus.

Comments All deletions can be restored by using the Edit Undo command (ALT+BACKSPACE). If you 
have deleted a series of objects, they will be restored individually, starting with the last 
object deleted.

          Accidental deletion of objects may be further safe-guarded by enabling the Question 
Delete option. If this option is enabled a Confirm Delete dialog box will be displayed as 
you select an object. You can enable or disable this message from the Preferences 
dialog box in the Options menu.

Procedure To delete an object that currently has the focus;

          1. Move the cursor over the object to be deleted and click LEFT MOUSE. The object will be 
displayed with graphical editing handles.

          2. Press the DELETE key.

          When you press DELETE, the object will be cleared from the library workspace.

See also
Undo
Delete
Clear



Change

Summary Select and use dialog to change objects.

To Launch Alt E H

Purpose The Change command is used to modify specific attributes of placed objects on the 
library workspace. Each object or object has its own range of editable attributes. You can 
change one object or extend changes across your entire objects in the workspace using 
powerful global editing options.

Procedure To change any placed object:

          1. Choose Change from the Edit menu. 

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          A dialog box opens, displaying the editable attributes for the object. It is possible to 
change any or all attributes of the edited object.

          3. Press ENTER or click OK to accept your changes. To cancel the change and close the 
dialog box press ESC or click CANCEL.

          4. Choose another object or press ESC or LEFT MOUSE to leave the Change command.

See also
Change Single Object



Change Single Object

Summary Use dialog to change object under the cursor.

Purpose The Change Single Object command is used to modify specific attributes of placed 
objects on the library workspace. This command is similar to the Change Command, 
except that when an object has been edited you will not be prompted to select another 
object. This command is activated by using the shortcut of double clicking the LEFT 

MOUSE on the object to be changed.

Procedure To change any placed object:

          1. Position the cursor over the target object and Double Click the LEFT MOUSE.

          A dialog box opens displaying the editable attributes for the object. It is    possible to 
change any or all attributes of the edited object.

          2. Press ENTER or click OK to accept your changes. To cancel the changes and close the 
dialog box press ESC or click CANCEL.

See also
Change



Move

Summary Select and move objects on the library workspace.

To Launch Alt E M M

Purpose The Move command is used to interactively change the location of placed objects on the 
library workspace.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you move and place an object it 
retains its original order in the stack.

          You can also move objects by pressing TAB and typing new coordinates directly into the 
Change dialog box.

Procedure To move any placed object:

          1. Choose Move, and then Move from the Edit menu. 

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          If the object does not move with the cursor you may not be exactly over the object when 
you tried to move it. Use the Zoom options (or press PGUP) to enlarge your view of the 
workspace and try again.

          3. Move the object to the desired location and press ENTER or LEFT MOUSE. To cancel the 
move press ESC or click RIGHT MOUSE.

          4. Move another object or press ESC or LEFT MOUSE to leave the move command.

See also
Move Single Object



Move Single Object

Summary Select and move objects on the library workspace.

Purpose The Move Single Object command is used to interactively change the location of placed 
objects on the library workspace. This command is similar to the Move command, except 
that when an object has been moved you will not be prompted to move another object. 
This command is activated by using the default shortcut: CTRL + LEFT MOUSE.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you move an object by using the 
default shortcut of CTRL + LEFT MOUSE and then place the object, it retains its original 
order in the stack.

          While moving the object, you can rotate it 90 degrees around the cursor by pressing the 
SPACEBAR and flip it along its x or y axis by using the X and Y keys. Press TAB to manually 
change the location of the object by typing new coordinates directly into a dialog box.

          The Move Single Object command can only be accessed using the mouse,    unless its 
hot key is changed in the Assign Hot Keys dialog box.

Procedure To move any placed object:

          1. Position the cursor over the target object and press CTRL + LEFT MOUSE.

          2. Move the object to the desired location and press ENTER or LEFT MOUSE.

          If the object does not move with the cursor you may not be exactly over the object when 
you tried to move it. Use the Zoom options (or press PGUP) to enlarge your view of the 
workspace and try again.

          3. To cancel the move press ESC or click RIGHT MOUSE.

See also
Move



Move To Front

Summary Move and place an object in the front of all other objects.

To Launch Alt E M V

Purpose The Move To Front command is used to interactively change the location of placed 
objects on the library workspace. This command is similar to the Move command, except 
that when an object has been moved and placed on the workspace it will be positioned 
in front of all the other objects on the workspace.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you use the Move To Front command 
and place an object it will be positioned at the top of the stack in front of all the other 
objects on the workspace.

          While moving the object, you can rotate it 90 degrees around the cursor by pressing the 
SPACEBAR and flip it along its x or y axis by using the X and Y keys. Press TAB to manually 
change the location of the object by typing new coordinates directly into a dialog box.

Procedure To move any placed object to the front of all other objects on the workspace:

          1. Choose Move and then Move To Front from the Edit menu. 

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          If the object does not move with the cursor you may not be exactly over the object when 
you tried to move it. Use the Zoom options (or press PGUP) to enlarge your view of the 
workspace and try again.

          3. Move the object to the desired location and press ENTER or LEFT MOUSE. To cancel the 
move press ESC or click RIGHT MOUSE.

          4. Move another object or press ESC or RIGHT MOUSE to leave the Move To Front 
command.

See also
Bring To Front



Bring To Front

Summary Bring an object graphically to the front of all other objects.

To Launch Alt E M F

Purpose The Bring To Front command is used to move objects on the library workspace to the 
front of all other objects.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you use the Bring To Front command 
and click on an object it will be positioned at the top of the stack in front of all the other 
objects on the workspace.

Procedure To move any placed objects to the front of all other objects on the workspace:

          1. Choose Move and then Bring To Front from the Edit menu.

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          When the object has been chosen it will be positioned in front of all the other objects on 
the workspace.

          3. Click on another object or press ESC or RIGHT MOUSE to leave the Bring To Front 
command.

See also
Move To Front



Send To Back

Summary Send an object to the back of all other objects.

To Launch Alt E M B

Purpose The Send To Back command is used to send objects on the library workspace to the 
back of all other objects.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you use the Send To Back command 
and click on an object it will be positioned at the bottom of the stack, behind all the other 
objects on the workspace.

Procedure To send an object to the back of all other objects on the workspace:

          1. Choose Move and then Send To Back from the Edit menu. 

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          When the object has been chosen it will be positioned at the back of all the other objects 
on the workspace.

          3. Click on another object or press ESC or RIGHT MOUSE to leave the Send To Back 
command.

See also
Send To Back Of



Bring To Front Of

Summary Bring an object to the front of another object.

To Launch Alt E M O

Purpose The Bring To Front Of command is used to move an object on the library workspace to 
the front of another object. This command is similar to the Bring To Front command, 
except that you will be prompted to choose the object that the original object will be 
placed in front of.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you use the Bring To Front Of 
command the original object will be placed in front of the target object.

Procedure To move a placed object to the front of another object on the workspace:

          1. Choose Move and then Bring To Front Of from the Edit menu.

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          The object will temporarily disappear from the workspace exposing any objects behind it.

          3. Click on the object that the original object will be placed in front of.

          4. Click on another object or press ESC or RIGHT MOUSE to leave the Bring To Front Of 
command.

See also
Bring To Front



Send To Back Of

Summary Send an object to the back of another object.

To Launch Alt E M T

Purpose The Send To Back Of command is used to move an object on the library workspace 
behind another object. This command is similar to the Send To Back command, except 
that you will be prompted to select the object that the original object will be placed 
behind.

Comments Schematic Library Editor automatically stacks layers of objects, text and graphics. Each 
object is on a different layer depending on the creation order. The objects created or 
added recently are always on the top layer. When you use the Send To Back Of 
command the original object will be placed behind the target object.

Procedure To move a placed object behind another object on the workspace:

          1. Choose Move and then Send To Back Of from the Edit menu. 

          2. Position the cursor over the target object and press ENTER or LEFT MOUSE.

          The object will temporarily disappear from the workspace exposing any objects behind it.

          3. Click on the object that the original object will be placed behind.

          Press ESC or RIGHT MOUSE to leave the Send To Back Of command.

See also
Send To Back



Place Arc

Summary Place graphical arcs on the library workspace.

To Launch Alt P A

Purpose The Place Arc command is used to place an arc on the library workspace using the 
center of the arc as the starting point. Arcs are used for building library components, 
such as defining component outlines or adding graphical symbols.

Comments When using the Place Arc command the default placement field values are determined 
by the last placed arc. Press TAB to change the default arc line width and color during 
placement.

Procedure To place an arc on the library workspace:

          1. Choose Arcs from the Place menu.

          While moving the arc, you can rotate it 90 degrees around the cursor and flip it along its 
x or y axis by using SPACEBAR, x and y keys. Press TAB to manually change the default 
values of the arc by typing new values directly into a dialog box.

          2. Position the cursor where the center of the arc is to be placed and press ENTER or 
LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted arc will be displayed.

          3. Position the cursor to establish the desired radius then press ENTER or LEFT MOUSE.

          4. Position the cursor to define the start angle of the arc, then press ENTER or LEFT MOUSE 

again.

          5. Position the cursor to define the end angle of the arc, then press ENTER or LEFT MOUSE.

          Start a new arc by selecting a center point or press ESC or RIGHT MOUSE to exit this 
command.

See also
Arc
Place Elliptical Arc



Place Polygon

Summary Place graphical polygon shapes on the library workspace.

To Launch Alt P Y    -    

Purpose The Place Polygon command is used to place graphical polygon objects on the 
current library workspace. Polygons are used for building library components, such as defining the 
component body or adding graphical symbols.

Comments When using the Place Polygon command the default placement field values are 
determined by the last placed polygon. Press TAB to change the default polygon border width, border 
color and fill color during placement.

Procedure To place a polygon in the library workspace:

          1. Choose Polygons from the Place menu.

          Press TAB to manually change the default values of the polygon by typing new values 
directly into a dialog box.

          2. Position the cursor where the first polygon segment is to be placed and press ENTER 
or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted polygon outline will be 
displayed.

          You may continue to add polygon line segments as desired by clicking the LEFT MOUSE or 
pressing the INSERT key. If you make a mistake, you can press DELETE to remove the last 
line segment. You can also press ESC or RIGHT MOUSE to cancel the current segment.

          5. To exit this command press ESC or RIGHT MOUSE a second time.

See also
Polygon



Place Line

Summary Place graphical lines on the library workspace.

To Launch Alt P L    -    

Purpose The Place Polyline command is used to place graphical lines on the current 
library workspace. Polylines are used for building library components, such as defining component 
outlines or adding graphical symbols.

Comments When using the Place Line command the default placement field values are 
determined by the last placed line. Press TAB to change the default line line width, line style and color 
during placement.

Procedure To place a line on the library workspace:

          1. Choose line from the Place menu.

          Press TAB to manually change the default values of the polyline by typing new values 
directly into a dialog box.

          2. Position the cursor where the first polyline segment is to be placed and press ENTER or 
LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted polyline segment will be 
displayed.

          3. Position the cursor to establish the length and angle of the polyline segment, then 
press ENTER or LEFT MOUSE to end this first segment of the line.

          You may continue to add line segments as desired by clicking the LEFT MOUSE or 
pressing the INSERT key. If you make a mistake, you can press DELETE to remove the last 
line segment. You can also press ESC or RIGHT MOUSE to cancel the current segment.

          5. To exit this command press ESC or s RIGHT MOUSE a second time.

See also
Line



Place Bezier

Summary Place curved lines on the library workspace.

To Launch Alt P B    -    

Purpose The Place Bezier command is used to place curved line segments on the current 
library workspace. Beziers are used for building library components, such as defining component outlines 
or adding graphical symbols.

Comments When using the Place Bezier command the default placement field values are 
determined by the last placed Bezier. Press TAB to change the default Bezier curve width and color during 
placement.

Procedure To place a Bezier on the library workspace:

          1. Choose Beziers from the Place menu.

          Press TAB to manually change the default values of the Bezier by typing new values 
directly into a dialog box.

          2. Position the cursor where the first Bezier vertex is to be placed and press ENTER or 
LEFT MOUSE once. A Bezier must have at least four vertices to form a curve. The 
maximum number of vertices supported by a single Bezier object is fifty.

          As you move the mouse or press the arrow keys, a highlighted Bezier will be displayed.

          You may continue to add Bezier vertices as desired by clicking the LEFT MOUSE or 
pressing the INSERT key. If you make a mistake, you can press DELETE to remove the last 
line segment. You can also press ESC or RIGHT MOUSE to cancel the current segment.

          5. To exit this command press ESC or RIGHT MOUSE a second time.

See also
Bezier



Place Ellipse

Summary Place elliptical shapes on the library workspace.

To Launch Alt P E    -    

Purpose The Place Ellipse command is used to place elliptical shapes on the library 
workspace using the center of the ellipse as the starting point. Ellipses are used for building library 
components, such as defining the component body or adding graphical symbols.

Comments When using the Place Ellipse command the default placement field values are 
determined by the last placed ellipse. Press TAB to change the default ellipse border width, border color 
and fill color during placement.

Procedure To place an ellipse on the library workspace:

          1. Choose Ellipses from the Place menu.

          While moving the ellipse, you can rotate it 90 degrees around the cursor and flip it along 
its x or y axis by using the spacebar, x and y keys. Press TAB to manually change the 
default values of the ellipse by typing new values directly into a dialog box.

          2. Position the cursor where the center of the ellipse is to be placed and press ENTER or 
LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted ellipse will be displayed.

          3. Position the cursor to establish the desired x-radius then press ENTER or LEFT MOUSE.

          4. Position the cursor to establish the desired y-radius then press ENTER or LEFT MOUSE.

          Start a new ellipse by selecting a center point or press ESC or RIGHT MOUSE to exit this 
command.

See also
Ellipse
Place Elliptical Arc



Place Text

Summary Place single line text on the library workspace.

To Launch Alt P T    -    

Purpose The Place Text command is used to place single line notes or descriptive text 
around a library component.

Comments When using the Place Text command the default placement field values are 
determined by the last placed text string. Press TAB to change the default text, font style, color and 
orientation during placement.

Procedure To place single line text on the library workspace:

          1. Choose Text from the Place menu.

          While moving the text, you can rotate it 90 degrees around the cursor and flip it along its 
x or y axis by using the spacebar, x and y keys. Press TAB to manually change the 
default values of the text by typing new values directly into a dialog box.

          2. Position the cursor where the text is to be placed and press ENTER or LEFT MOUSE 
once.

          Place another text string or press ESC or RIGHT MOUSE to exit this command.

See also
Text



Place Pie Charts

Summary Place pie charts on the library workspace.

To Launch Alt P C

Purpose The Place Pie command is used to place circular graphical objects on the workspace. 
Pie charts are used for building library components, such as defining the component 
body or adding graphical symbols.

Comments When using the Place Pie command the default placement field values are determined 
by the last placed pie chart. Press TAB to change the default pie chart border width, 
border color and fill color during placement.

Procedure To place a pie chart on the library workspace:

          1. Choose Pie Charts from the Place menu.

          While moving the pie chart, you can rotate it 90 degrees around the cursor and flip it 
along its x or y axis by using the spacebar, x and y keys. Press TAB to manually change 
the default values of the pie chart by typing new values directly into a dialog box.

          2. Position the cursor where the center of the pie chart is to be placed and press ENTER 
or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted pie chart will be 
displayed.

          3. Position the cursor to establish the desired radius then press ENTER or LEFT MOUSE.

          4. Position the cursor to define the start angle of the pie chart, then press ENTER or LEFT 

MOUSE again.

          5. Position the cursor to define the end angle of the pie chart, then press ENTER or LEFT 

MOUSE.

          Place another pie chart or press ESC or RIGHT MOUSE to exit this command.

See also
Pie Chart



Place Pin

Summary Place electrical pin on the library workspace.

To Launch Alt P P    -    

Purpose The Place Pin command is used to place Part pins on the workspace. Pins are 
used to direct signals into and out of Parts. Pins have a user defined name and number, electrical type, 
length, color, orientation and other display options.

Comments While placing pins on the workspace the pin number will automatically increment 
if the first or last characters are numbers. For example, an initial pin number of 1 will automatically 
increment to 2, 3, 4... and so on. A number of 2A will increment 3A, 4A, 5A, and a number of A10 will 
increment A11, A12, A13.

          When using the Place Pin command the default placement field values are determined 
by the last placed Pin. Press TAB to change the default symbol type and color during 
placement.

Procedure To place pins on the library workspace:

          1. Choose Pins from the Place menu.

          While moving the Pin, you can rotate it 90 degrees around the cursor by pressing the 
spacebar. Press TAB to manually change the default values of the pin by typing new 
values directly into a dialog box.

          As you move the mouse or press the arrow keys, a highlighted pin will be displayed.

          2. Position the cursor where the pin is to be placed and press ENTER or LEFT MOUSE once.

          Place another pin or press ESC or RIGHT MOUSE to exit this command.

See also
Pin



Place Round Rectangle

Summary Place round rectangles on the library workspace.

To Launch Alt P O    -    

Purpose The Place Round Rectangle command is used to place a rounded rectangle on 
the library workspace using the center of the rounded rectangle as the starting point. Rounded rectangles 
are used for building library components, such as defining the component body or adding graphical 
symbols.

Comments When using the Place Round Rectangle command the default placement field 
values are determined by the last placed round rectangle. Press TAB to change the default round 
rectangle border width, border color and fill color during placement.

Procedure To place a rounded rectangle on the library workspace:

          1. Choose Round Rectangle from the Place menu.

          While moving the rounded rectangle, you can rotate it 90 degrees around the cursor and 
flip it along its x or y axis by using the spacebar, x and y keys. Press TAB to manually 
change the default values of the rounded rectangle by typing new values directly into a 
dialog box.

          2. Position the cursor where the center of the rounded rectangle is to be placed and 
press ENTER or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted rounded rectangle will be 
displayed.

          3. Position the cursor to establish the desired shape, then press ENTER or LEFT MOUSE.

          Place another rounded rectangle or press ESC or RIGHT MOUSE to exit this command.

See also
Round Rectangle
Place Rectangle



Place Elliptical Arc

Summary Place elliptical arcs on the library workspace.

To Launch Alt P I    -    

Purpose The Place Elliptical Arc command is used to place an elliptical arc on the library 
workspace using the center of the elliptical arc as the starting point. Elliptical arcs are used for building 
library components, such as defining component outlines or adding graphical symbols.

Comments When using the Place Elliptical Arc command the default placement field values 
are determined by the last placed elliptical arc. Press TAB to change the default arc line width and color 
during placement.

Procedure To place an elliptical arc on the library workspace:

          1. Choose Elliptical Arcs from the Place menu.

          While moving the elliptical arc, you can rotate it 90 degrees around the cursor and flip it 
along its x or y axis by using the spacebar, x and y keys. Press TAB to manually change 
the default values of the elliptical arc by typing new values directly into a dialog box.

          2. Position the cursor where the center of the elliptical arc is to be placed and press 
ENTER or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted arc will be displayed.

          3. Position the cursor to establish the desired x-radius then press ENTER or LEFT MOUSE.

          4. Position the cursor to establish the desired y-radius then press ENTER or s LEFT MOUSE.

          5. Position the cursor to define the start angle of the elliptical arc, then press ENTER or 
LEFT MOUSE again.

          6. Position the cursor to define the end angle of the elliptical arc, then press ENTER or 
LEFT MOUSE.

          Start a new elliptical arc by selecting a center point or press ESC or RIGHT MOUSE to exit 
this command.

See also
Elliptical Arc
Place Arc



Place Rectangle

Summary Place rectangles on the library workspace.

To Launch Alt P R    -    

Purpose The Place Rectangle command is used to place a graphical rectangle on the 
library workspace. Rectangles are used for building library components, such as defining the component 
body or adding graphical symbols.

Comments When using the Place Rectangle command the default placement field values 
are determined by the last placed rectangle. Press TAB to change the default rectangle border width, 
border color and fill color during placement.

Procedure To place a rectangle on the library workspace:

          1. Choose Rectangle from the Place menu.

          While moving the rectangle, you can rotate it 90 degrees around the cursor and flip it 
along its x or y axis by using the spacebar, x and y keys. Press TAB to manually change 
the default values of the rectangle by typing new values directly into a dialog box.

          2. Position the cursor where the center of the rectangle is to be placed and press ENTER 
or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted rectangle will be 
displayed.

          3. Position the cursor to establish the desired shape, then press ENTER or LEFT MOUSE.

          Place another rectangle or press ESC or RIGHT MOUSE to exit this command.

See also
Rectangle
Place Round Rectangle



Place IEEE Symbol

Summary Place IEEE Symbols on the library workspace.

Purpose The Place IEEE Symbol command is used to place graphical qualifying symbols on the 
workspace. IEEE symbols are used for representing logic functions or devices. These 
symbols enable users to understand the logic characteristics of these functions or 
devices without requiring specific knowledge of their internal characteristics.

Comments When using the Place IEEE Symbol command the default placement field values are 
determined by the last placed IEEE symbol. Press TAB to change the default symbol type 
and color during placement.

Procedure To place an IEEE symbol on the library workspace:

          1. Choose IEEE Symbols from the Place menu.

          While moving the IEEE symbol, you can rotate it 90 degrees around the cursor and flip it 
along its x or y axis by using the spacebar, x and y keys. Press TAB to manually change 
the default values of the IEEE symbol by typing new values directly into a dialog box.

          2. Position the cursor where the center of the IEEE symbol is to be placed and press 
ENTER or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted IEEE symbol will be 
displayed.

          3. Position the cursor where the IEEE symbol is to be placed and press ENTER or LEFT 

MOUSE once.

          Place another IEEE symbol or press ESC or RIGHT MOUSE to exit this command.

See also
IEEE Symbol



Place Junction Symbol

Summary Place a Junction symbol on the library workspace.

To Launch Alt P J    -    

Purpose The Place Junction Symbol command is used to place a graphical circular object 
on the library workspace. Junction symbols are used for building library components.

Comments Junction symbols are graphical only and have no logical connectivity.
Procedure To place a junction symbol on the library workspace:

          1. Choose Junction Symbol from the Edit menu.

          Press TAB to manually change the default values of the junction by typing new values 
directly into a dialog box.

          2. Position the cursor where the center of the junction is to be placed and press ENTER or 
LEFT MOUSE once.

          Place another Junction or press ESC or RIGHT MOUSE to exit this command.

See also
Junction Symbol



Place Graphic

Summary Place PCX/BMP/GIF/TIFF/WMF/EPS graphical images on the library workspace.

To Launch Alt P G    -    

Purpose The Place Graphic command is used for adding reference information to a library 
component, such as mechanical and electrical symbols or customized    component images.

Comments Images are linked during loading, they are not stored in the library. Only the 
image file path is stored in the library.

          Schematic Library Editor supports the import of the following image formats;

          BMP - All uncompressed Bitmap images. Windows device-independent bitmap format, 
introduced with Windows 3.0 and increasingly supported by Windows applications.

          PCX - Paintbrush format, used in Windows Paintbrush and other paint programs and 
supported by many desktop publishing and graphics programs. Supported colors 
include, monochrome, 16 color, 256 color, 24-bit color.

          TIFF - Tag Image File Format, supported by many desktop publishing programs. 
Supported compression types, uncompressed, LZW, Packbits, Modified Huffman 
encoding, CCITT Group 3 1D, CCITT Group 3 2D, CCITT Group 4. Supported colors 
include, monochrome, 16 color, 256 color, 24-bit color

          GIF - All non-interlaced Graphic Image files.

          EPSF - Encapsulated postscript files with and without display images. If the EPS file 
does not contain a TIFF or Windows Metafile display image then the file name of the 
EPS image will be displayed.

          WMF - Only Windows Metafiles which conform to the Aldus Placeable Metafile Format 
are supported. Most applications which export or import Metafiles support this format.

Procedure To place graphical objects on the library workspace;

          1. Choose Graphic from the Place menu.

          2. Type the image file name (include the full path, if different from the path listed after 
Directory) and click OK or press ENTER.

          You can also double-click on the desired file name in the Files window, if any. To change 
directories, click under any of the options listed in the Directories window.

          Press TAB to manually change the default values of the graphic image by typing new 
values directly into a dialog box.

          3. Position the cursor where the center of the graphic image is to be placed and press 
ENTER or LEFT MOUSE once.

          As you move the mouse or press the arrow keys, a highlighted rectangle will be 
displayed.

          4. Position the cursor to establish the desired size of the image, then press ENTER or 



LEFT MOUSE.

          5. The Image file dialog box will be displayed again, choose another graphic image or 
press ESC or click Cancel to exit this command.

See also
Graphic



Paste Array

Summary Define an array placement of clipboard contents.

To Launch Alt E Y    -    

Purpose The Paste Array command is used to define a multiple placement of    the 
clipboard contents.

Outcome The following are options that can be set within the Setup Array Placement dialog 
box.

          Item Count - The number of repeat placements to be performed. For example, typing 5 
will place 5 of the current selection, contained in the clipboard.

          Text Increment - This option is used for pin names and annotations. Setting this to 1 will 
automatically increment. For example, an initial Pin number of A1 will automatically 
increment to A2, A3, A4 and so on, and a Pin number of 1A will increment 2A, 3A, 4A.

          Incrementing can be numeric (1,2,3) or alphabetic (A, B, C) or a combination of alpha 
and numeric (A1, A2, or 1A, 1B or 1A, 2A, etc.).

          Horizontal - Specifies the distance along the x-axis between each clipboard selection as 
it is placed. Positive and negative values are supported.

          Vertical - Specifies the distance along the y-axis between each clipboard selection as it 
is placed. Positive and negative values are supported.

Comments The clipboard holds the last selection only, each time you use the Cut or Copy 
command, you overwrite the previous selection.

Procedure To setup an array placement:

          1. Choose Paste Array from the Edit menu.

          The Setup Array Placement dialog box appears.

          2. Type in new array placement settings.

          3. Press the OK button to accept the array definition and return to the editor without 
executing the placement or;

          4. Press the Place button to execute the array placement with the current clipboard 
contents. Position the cursor at the desired reference point for the array placement and 
click ENTER or LEFT MOUSE.

See also
Cut
Copy
Execute Paste Array



Execute Paste Array

Summary Place array with the last set array placement options.

Purpose The Execute Paste Array command is used to paste an array using the current clipboard 
contents and the last array setup options. This command is accessed using the Place 
button on the Setup Array Placement dialog box.

Outcome The clipboard contents will be placed according to the array setup you have defined, 
starting at the reference point you indicated.

Comments The Execute Paste Array command may be assigned a hot key in the Assign Hot Keys 
dialog box to allow quick array placements.

Procedure To execute an array placement using the current clipboard contents

          1. Choose Paste Array from the Place menu.

          The Setup Array Placement dialog box appears.

          2. Press the Place button to execute the array placement with the current clipboard 
contents.

          3. Position the cursor at the desired reference point for the array placement and click 
ENTER or LEFT MOUSE.

See also
Paste Array
Hot Keys



Jump To Origin

Summary Jump to the origin of the library workspace (lower left).

To Launch Alt E J O

Purpose The Jump Origin command is used to move the cursor to the center of the library 
workspace. This can save you from having to constantly zoom in and out to navigate 
around your design and is particularly useful for large or complex components.

Outcome Once the Jump To Origin command has been selected the cursor will jump to the lower 
left corner (0,0 coordinate) of the library workspace.

Procedure To move the cursor to the origin of the library workspace:

          1. Choose Jump To Origin from the Edit menu.



Zoom Window

Summary Select a rectangular area of the workspace and fit that area in the window.

To Launch Alt Z W

Purpose The Zoom Window command is used to re-set the magnification of a selected area in the 
current document window.

Procedure To magnify a selected area in an open document:

          1. Choose Window from the Zoom menu. 

          2. Move the cursor and then press ENTER or LEFT MOUSE to define the first corner of the 
zoom rectangle.

          3. Move the cursor to enclose the area to be magnified with the highlighted rectangle.

          4. Press ENTER or LEFT MOUSE to complete zoom window.

See also
Zoom Point
Zoom In
Zoom Out



Zoom Point

Summary Select a rectangular area of the workspace and fit that area in the window.

To Launch Alt Z P

Purpose The Zoom Point command is used to re-set the magnification from a selected point and 
defined area in the current document window.

Procedure To magnify a selected area in an open document:

          1. Choose Point from the Zoom menu.

          You will be prompted: "Select First Corner."

          2. Move the cursor and then press ENTER or LEFT MOUSE to define the starting point the 
zoom rectangle.

          You will then be prompted: "Select Second Corner."

          3. Move the cursor to enclose the area to be magnified with the highlighted rectangle.

          4. Press ENTER or LEFT MOUSE to complete the zoom window.

See also
Zoom Window
Zoom In
Zoom Out



Zoom Workspace

Summary Show the entire workspace.

To Launch Alt Z S

Purpose The Zoom Workspace command is used to view the entire area of the current 
workspace.

Procedure To view all of the current workspace:

          1. Choose Workspace from the Zoom menu.

See also
Zoom All



Zoom All

Summary Fit all objects on the current workspace in the window.

To Launch  Ctrl PgDn    -    Alt Z A

Purpose The Zoom All command is used to fit all of the objects on the current library workspace 
into the current document window.

Comments The zoom window region is defined by objects at the highest and lowest coordinate 
points.

Procedure To fit all objects on the current workspace into the current document window:

          1. Choose All from the Zoom menu.

See also
Zoom Workspace



Zoom In

Summary Show less of the current workspace (higher magnification).

To Launch  PgUp    -    Alt Z I    -    

Purpose The Zoom In command is used to increase the magnification of the current 
workspace.

Comments The Zoom In command is most effective when initiated with its shortcut: PGUP or 
Z, I.

Procedure To increase the magnification of the current workspace:
          1. Press PGUP or Z, I.

See also
Zoom Out
Zoom All



Zoom Out

Summary Show more of the current workspace (lower magnification).

To Launch  PgDn    -    Alt Z O    -    

Purpose The Zoom Out command is used to decrease the magnification of the current 
workspace.

Comments The Zoom Out command is most effective when initiated with its shortcut: PGDN 
or Z, O.

Procedure To decrease the magnification of the current workspace:
          1. Press PGDN or Z, O.

See also
Zoom In
Zoom All



Zoom Pan

Summary Re-Center the screen around the cursor.

To Launch  Home    -    Alt Z N

Purpose The Zoom Pan command is used to redraw the current document window with the 
previous cursor location at the center of the window.

Comments The Zoom Pan command is most effective when initiated with its shortcut HOME or Z, N.

Procedure To center the workspace view around the current cursor location:

          1. Move the cursor to the area or object you wish to position at the center of the current 
document window.

          2. Press HOME or Z, N.



Screen Redraw

Summary Update the screen display.

To Launch  End    -    Alt Z R

Purpose The Zoom Redraw command is used to update or refresh all objects on the current 
workspace.

Procedure To re-draw the objects on the current workspace:

          1. Choose Redraw from the Zoom menu.



Zoom 400%

Summary Set zoom scale to 4x (highest magnification).

To Launch  Ctrl 4    -    Alt Z 4

Purpose The Zoom 400% command is used to set the magnification of the current workspace to a 
factor of 4 times the normal scale. This is the highest zoom magnification.

Outcome The view of the current workspace will be re-set to a magnification of 400%, centered 
around the current cursor location.

Comments The Zoom 400% command is most effective when initiated with its shortcut Z, 4.

Procedure To set the magnification of the current workspace to 400%:

          1. Position the cursor on the area to be magnified.

          2. Choose 400% from the Zoom menu or press Z, 4.

See also
Zoom All



Zoom 200%

Summary Set zoom scale to 2x.

To Launch  Ctrl 2    -    Alt Z 2

Purpose The Zoom 200% command is used to set the magnification of the current workspace to a 
factor of 2 times the normal scale.

Outcome The view of the current workspace will be re-set to a magnification of 200%, centered 
around the current cursor location.

Comments The Zoom 200% command is most effective when initiated with its shortcut Z, 2.

Procedure To set the magnification of the current workspace to 200%:

          1. Position the cursor on the area to be magnified.

          2. Choose 200% from the Zoom menu or press Z, 2.

See also
Zoom All



Zoom 100%

Summary Set zoom scale to 1x (normal magnification).

To Launch  Ctrl 1    -    Alt Z 1

Purpose The Zoom 100% command is used to set the magnification of the current workspace to 
its normal scale.

Outcome The view of the current workspace will be re-set to a magnification of 100%, centered 
around the current cursor location.

Comments The Zoom 100% command is most effective when initiated with its shortcut Z, 1.

Procedure To set the magnification of the current workspace to 100%:

          1. Position the cursor on the area to be magnified.

          2. Choose 100% from the Zoom menu or press Z, 1.

See also
Zoom All



Zoom 50%

Summary Set zoom scale to 0.5x.

To Launch  Ctrl 5    -    Alt Z 5

Purpose The Zoom 50% command is used to set the magnification of the current workspace to a 
factor of half the normal scale.

Outcome The view of the current workspace will be re-set to a magnification of 50%, centered 
around the current cursor location.

Comments The Zoom 50% command is most effective when initiated with its shortcut Z, 5.

Procedure To set the magnification of the current workspace to 50%:

          1. Position the cursor on the area to be magnified.

          2. Choose 50% from the Zoom menu or press Z, 5.

See also
Zoom All



Report Component

Summary Display component information.

To Launch Alt F R C

Purpose The Report Component command is used to retrieve general information about the 
current component.

Outcome Once this command is selected the report file is automatically loaded into a text editor 
and displayed on the screen. The text editor is specified in the Setup Run Options dialog 
box, (Tools-Setup). Windows Notepad is used by default.

Procedure To get information about the Component on the current workspace:

          1. Choose Report from the File menu then choose component.

See also



Report Library

Summary Display library statistics.

To Launch Alt F R L

Purpose The Information Library command is used to retrieve general information about the 
current library.

Outcome Once this command is selected the report file is automatically loaded into a text editor 
and displayed on the screen. The text editor is specified in the Setup Run Options dialog 
box, (Tools-Setup). Windows Notepad is used by default.

Procedure To get information about the current library;

          1. Choose Library from the Info menu.

See also



Workspace Options

Summary Setup options for current workspace.

To Launch Alt O W

Purpose The Workspace Options command is used to define various workspace settings that 
apply to a specific library file. This command is used to define various workspace 
settings, such as workspace orientation, background color, border color and an option to 
display or hide the workspace border.

Outcome The following are options that can be set within the Workspace Options dialog box.

          Size - Schematic Library Editor supports 10 standard imperial and metric sheet sizes. 
They include A, B, C, D, E (or metric sizes A4-A0).

          Orientation - Defines the orientation of the library workspace. The sheet can be 
displayed in landscape (default) mode or in portrait mode.

          Show Border - If this option is enabled, the sheet border will be displayed. If you want to 
design a custom border, turn this option off and use Schematic Library Editor's drawing 
tools.

          Custom Size - This is the flag that allows you to use Schematic Library Editor standard 
workspace sizes or to define your own custom workspace size.

          Border Color - The surrounding border of your library workspace can be assigned a 
default color. To assign a new color to the sheet border, click in the color box to open the 
Color Selector dialog box. Schematic Library Editor will display all the available colors 
that your graphics card and monitor supports. The border color only applies to the 
Schematic Library Editors default border. Customized borders will not be affected by this 
option.

          Workspace Color - A library workspace can be assigned a color. To assign a new color 
to the workspace, click in the color box to open the Color Selector dialog box.

          Snap Grid - If this option is enabled, the visible grid is displayed. The visible grid can be 
assigned any color and can be displayed as lines or dots.

          Visible Grid - If this option is enabled, the visible grid is displayed. The visible grid can 
be assigned any color and can be displayed as lines or dots.

Procedure To setup and define workspace settings;

          1. Choose Workspace from the Options menu

          2. Type in new workspace settings.

          3. Click OK to accept the new settings.

See also
Preferences



Toggle Scroll Bars

Summary Turn the scroll bars on or off.

To Launch Alt O C

Purpose The Toggle Scroll Bars command is used to turn the Scroll Bars on or off in the current 
document window. Turning the scroll bars off will display more of the library workspace.

Outcome Once the Scroll Bars command has been chosen the scroll bars at the edge of the 
current document window will toggle on or off depending on their previous state.

Procedure To toggle the scroll bars on or off:

          1. Choose Scroll Bars from the Options menu.



Toggle Visible Grid

Summary Turn the visible grid on or off.

To Launch Alt O V

Purpose The Toggle Visible Grid command is used to turn the visible grid on or off in the current 
document window. The visible grid provides visual reference as you move around the 
library workspace and can be displayed as dots or straight lines.

Outcome Once the Visible Grid command has been chosen the visible grid will toggle on or off 
depending on its previous state.

Comments The visible grid can also be toggled on or of in the Options Workspace dialog box.

Procedure To turn the visible grid on or off:

          1. Choose Visible Grid from the Options menu.

See also
Preferences
Workspace Options



Toggle Snap Grid

Summary Turn the snap grid on or off.

To Launch Alt O G

Purpose The Toggle Snap Grid command is used to turn the cursor snap grid on or off. The snap 
grid defines an array of points in the workspace which restrict cursor movement and the 
placement of primitives. Turning the snap grid off allows you to place primitives at any 
location on the workspace without any restrictions.

Outcome Once the Snap Grid command has been chosen the cursor snap grid will toggle on or off 
depending on its previous state.

Procedure To turn the snap grid on or off:

          1. Choose Snap Grid from the Options menu.



Shift Cursor Up

Summary Move the cursor up 10 snap grid points.

Purpose The Shift Cursor Up command is used to move the cursor up 10 grid points in the library 
workspace.

Outcome When the Shift and Up arrow keys are pressed the cursor will move up 10 grid points, 
along the X axis.

Procedure To move the cursor up 10 snap grid points:

          1. Press the up arrow on the keyboard while holding down the shift key.

See also
Cursor Up



Shift Cursor Down

Summary Move the cursor down 10 snap grid points.

Purpose The Shift Cursor Down command is used to move the cursor down 10 grid points in the 
library workspace.

Outcome When the Shift and Down arrow keys are pressed the cursor will move down 10 grid 
points, along the Y axis.

Procedure To move the cursor down 10 snap grid points:

          1. Press the down arrow on the keyboard while holding down the shift key.

See also
Cursor Down



Shift Cursor Left

Summary Move the cursor up 10 snap grid points.

Purpose The Shift Cursor Left command is used to move the cursor to the left 10 grid points in the 
library workspace.

Outcome When the Shift and Left arrow keys are pressed the cursor will move to the left 10 grid 
points, along the X axis.

Procedure To move the cursor left 10 snap grid points:

          1. Press the left arrow key on the keyboard while holding down the shift key.

See also
Cursor Left



Shift Cursor Right

Summary Move the cursor right 10 snap grid points.

Purpose The Shift Cursor Right command is used to move the cursor to the right 10 grid points in 
the library workspace.

Outcome When the Shift and Right arrow keys are pressed the cursor will move to the right 10 grid 
points, along the X axis.

Procedure To move the cursor right 10 snap grid points:

          1. Press the right arrow on the keyboard while holding down the shift key.

See also
Cursor Right



Cursor Up

Summary Move the cursor up one snap grid point.

Purpose The Cursor Up command is used to move the cursor up one snap grid point in the library 
workspace.

Outcome When the Up arrow key is pressed the cursor will move up one grid point, along the Y 
axis.

Procedure To move the cursor up one snap grid point:

          1. Press the up arrow on the keyboard.

See also
Shift Cursor Up



Cursor Down

Summary Move the cursor down one snap grid point.

Purpose The Cursor Down command is used to move the cursor down one snap grid point in the 
library workspace.

Outcome When the Down arrow key is pressed the cursor will move down one grid point, along 
the Y axis.

Procedure To move the cursor down one snap grid point:

          1. Press the down arrow on the keyboard.

See also
Shift Cursor Down



Cursor Left

Summary Move the cursor left one snap grid point.

Purpose The Cursor Left command is used to move the cursor left one snap grid point in the 
library workspace.

Outcome When the Left arrow key is pressed the cursor will move left one grid point, along the X 
axis.

Procedure To move the cursor left one snap grid point:

          1. Press the left arrow on the keyboard.

See also
Shift Cursor Left



Cursor Right

Summary Move the cursor right one snap grid point.

Purpose The Cursor Right command is used to move the cursor right one snap grid point in the 
library workspace.

Outcome When the Right arrow key is pressed the cursor will move right one grid point, along the 
X axis.

Procedure To move the cursor right one snap grid point:

          1. Press the up arrow on the keyboard.

See also
Shift Cursor Right



New Part

Summary Add a new part to the currently displayed component.

To Launch Alt C W    -    

Purpose The New Part command is used to create a new part within the current 
component.

Outcome When you choose the New Part command a new part with no primitives is added 
to the currently displayed component.

          The Document Title bar displays the component name and the number of the part, for 
example, Component_1 2/2.

Comments Use the Copy and Paste commands from the Edit menu to copy the contents of a 
previously created part into the current part. 

          Schematic Library Editor allows an unlimited number of parts per component.

Procedure To add a part to the component;

          1. Choose New Part from the Component menu.

See also
Remove Part



Remove Part

Summary Remove a part from the currently displayed component.

To Launch Alt C T

Purpose The Remove Part command is used to delete a part from a multiple part component.

Outcome The currently displayed part will be deleted from the component.

          For example, using this command with the 74LS00 component which is in the TTL 
library, would delete one of its four gates.

          If the component has only one part, then this command will remove the component from 
the library.

Comments You can use the Edit Undo command (shortcut: ALT+BACKSPACE) to restore the deleted 
part.

Procedure To remove a part from a multi part component;

          1. Choose Remove Part from the Component menu.

See also
New Part



Next Part

Summary Show the next part of the currently displayed component.

To Launch Alt C O P

Purpose The Next Part command is used to show the next part of a multiple part component.

Outcome The next part of the component will be displayed. For example, using this command with 
the 74LS00 component which has four parts, would display its next gate.

Comments The system will beep if you try to go beyond the number of defined parts of a 
component. Use the Prev Part command to move back through the list of parts.

          The Document Title bar displays the component name and the number of the currently 
displayed part, for example, 74LS00 1/4.

Procedure To view the next part in a multi part component;

          1. Choose Component and then Next Part from the Component menu or click on the 
forward arrow > in the Part section of the Main Panel.

See also
Previous Part



Previous Part

Summary Show the previous part of the currently displayed component.

To Launch Alt C O V

Purpose The Previous Part command is used to show the previous part of a multiple part 
component.

Outcome The previous part of the component will be displayed. For example, using this command 
with the 74LS00 component which has four parts, would display its previous gate.

Comments The Document Title bar displays the component name and the number of the currently 
displayed part, for example, 74LS00 3/4.

Procedure To view the previous part in a multi part component;

          1. Choose Component and then Prev Part from the Component menu or click on the 
back arrow < in the Part section of the Main Panel.

See also
Next Part



New Component

Summary Add a new component to library.

To Launch Alt C N    -    

Purpose The New Component command is used to create a new component within the 
current library.

Outcome When the New Component command is used an empty component is created 
with the name "Component_1." If this name already exists then the name will increment to 
"Component_2."

Comments Use the Rename Component command from the Component menu to change 
the name of the created component. Component library sizes are virtually unlimited and are only 
restricted by available memory.

Procedure To add a new component to the library;

          1. Choose New Component from the Component menu.

See also
Remove Component
Rename Component



Next Component

Summary Show the next component in the library.

To Launch Alt C O N

Purpose The Next Component command is used to show the next component in the library.

Comments The Document Title bar displays the component name and the number of the currently 
displayed part, for example, 74LS04 1/6.

Procedure To view the next component in the library;

          1. Choose Component and then Next Component from the Component menu or click on 
the forward arrow > in the Components section of the Main Panel.

          The next component in the library will be displayed.

See also
Previous Component



Remove Component Name

Summary Remove component name from group.

To Launch Alt C V

Purpose The Remove Component Name command is used to remove a name from a component 
group listing.

Outcome The selected name within the Group window of the Main Panel will be deleted from the 
list. If the component has only one name in its group then this command will remove the 
component from the library.

Comments You can use the Edit Undo command (shortcut: ALT+BACKSPACE) to restore the name to 
the component group listing.

Procedure To remove a name from the component group;

          1. Choose Remove Component Name from the Component menu or click the Del button 
in the Group section of the Main Panel.

See also
Remove Component



Add Component Name

Summary Add component name to group.

To Launch Alt C A

Purpose The Add Component Name command is used to add a name to a component group 
listing.

Outcome The component name will be added to the component group and will be listed within the 
Group window of the Main Panel.

Comments Component group is a set of components which share the same graphical model in a 
library.

          You can use the Remove Duplicates command from the Component menu to remove 
any duplicate components from the current library.

Procedure To add a name to the component group;

          1. Choose Add Component Name from the Component menu or click the "Add" button in 
the Group section of the Main Panel.

          2. Type the component name in the New Component Name dialog box and press ENTER 
or click OK.

See also
New Component



Previous Component

Summary Show the previous component in the library.

To Launch Alt C O P

Purpose The Previous Component command is used to show the previous component in the 
library.

Comments The Document Title bar displays the component name and the number of the currently 
displayed part, for example, 74LS04 1/6.

Procedure To view the previous component in the library;

          1. Choose Component and then Prev Component from the Component menu or click on 
the back arrow < in the Components section of the Main Panel.

          The previous component in the library will be displayed.

See also
Next Component



First Component

Summary Show the first component in the library.

To Launch Alt C O F

Purpose The First Component command is used to move the focus to the top of the component 
library listing and display the first component in the library.

Procedure To view the first component in the library;

          1. Choose Component and then First Component from the Component menu or click on 
the back arrows << in the Components section of the Main Panel.

          The selection bar within the Components window of the Main Panel will jump to the top 
of the library.

See also
Last Component



Last Component

Summary Show the last component in the library.

To Launch Alt C O L

Purpose The Last Component command is used to move the focus to the bottom of the 
component library listing and display the last component in the library.

Procedure To view the last component in the library;

          1. Choose Component and then Last Component from the Component menu or click on 
the forward arrows >> in the Components section of the Main Panel.

          The selection bar within the Components window of the Main Panel will jump to the 
bottom of the library.

See also
First Component



Show Normal

Summary Display component in standard ANSI notation.

To Launch Alt C H

Purpose The Show Normal command is used to switch the component display mode to standard 
ANSI schematic notation.

Comments Depending upon the part, components can be displayed using standard ANSI schematic 
notation, the De-Morgan equivalent (for gates) and IEEE standard notation.

          You may also press one of the buttons in the Mode field on the Main Panel to change the 
display notation. Refer to the User Guide for detailed descriptions about Component and 
Part management.

Procedure To switch the component display mode to normal:

          1. Choose Show Normal from the Component menu.

See also
Show De-Morgan
Show IEEE



Show De-Morgan

Summary Command Summary.

To Launch Alt C G

Purpose The Show De-Morgan command is used to switch the component display mode to De-
Morgan notation.

Comments Depending upon the part, components can be displayed using standard ANSI schematic 
notation, the De-Morgan equivalent (for gates) and IEEE standard notation.

          You may also press one of the buttons in the Mode field on the Main Panel to change the 
display notation. Refer to the User Guide for detailed descriptions about Component and 
Part management.

Procedure To switch the component display mode to De-Morgan:

          1. Choose Show De-Morgan from the Component menu.

See also
Show Normal
Show IEEE



Show IEEE

Summary Command Summary.

To Launch Alt C I

Purpose The Show IEEE command is used to switch the component display mode to IEEE 
notation.

Comments Depending upon the part, these can be displayed using standard ANSI schematic 
notation, the De-Morgan equivalent (for gates) and IEEE standard notation.

          You may also press one of the buttons in the Mode field on the Main Panel to change the 
display notation. Refer to the User Guide for detailed descriptions about Component and 
Part management.

Procedure To switch the component display mode to IEEE:

          1. Choose Show IEEE from the Component menu.

See also
Show Normal
Show De-Morgan



Toggle Hidden Pins

Summary Show/Hide hidden pins in component.

To Launch Alt O S

Purpose The Toggle Hidden Pins command is used to show or hide all the pins that have the 
attribute of Hidden.

Comments The Toggle Hidden Pins command does not change the Hidden attribute of pins. The 
Hidden attribute can be changed via the Pin dialog box. Use the Change command or 
simply double click on the pin with the mouse.

Procedure To show/hide the hidden pins in the currently displayed component;

          1. Choose Show Hidden Pins from the Options menu or click on the "Hidden Pins" check 
box in the Main Panel.

          If this option is enabled then all the hidden pins on the displayed component will be 
shown.

See also



Place Part

Summary Adds a new part to the current component.

Purpose The Place Part command is used to place the currently selected part into an active 
schematic workspace.

Outcome After the Part is placed, your focus will remain in the Schematic Library Editor main 
window.

Comments You can also place parts from the Component Browser in the schematic editor by 
clicking the Place button. The Component Browser allows browsing of component 
names, placement of parts onto the current workspace, renaming of part designators 
and jumping to a part that has been placed on a workspace in a project.

Procedure To place a part into the current open schematic sheet:

          Make sure the Advanced Schematic Editor application is running. 

          1. Select the part you wish to place by typing in the name of the    part in the Mask field of 
the Main Panel. You can also use the "<","<<", ">>" and ">"    buttons on the Main Panel 
to locate the part you want.

          Make sure the name of the part you wish to place is highlighted.

          2. Press the Place button on the Main Panel.

          Your focus will shift to the Advanced Schematic Editor. 

          While moving the part, you can rotate it 90 degrees around the cursor by pressing the 
spacebar and flip it along its x or y axis by pressing the x and y keys. Press TAB to 
manually change the default values of the Part by typing new values directly into a dialog 
box.

          4. Position the cursor where the Part is to be placed and press ENTER or LEFT MOUSE.

See also
Run Schematic Capture



Rename Component

Summary Change the name of the current component.

To Launch Alt C E

Purpose The Rename Component command is used to change the name of components in the 
current library.

Comments Schematic Library Editor allows you to have components in the library with the same 
name. However, when loading a file into the Schematic Editor the first component in the 
library will be used.

          You can use the Remove Duplicates command from the Component menu to remove 
any duplicate components from the current library.

Procedure To rename the current component;

          1. Choose Rename Component from the Component menu.

          2. Type a new component name in the New Component Name dialog box and press 
ENTER or click OK.

          The new component name will be listed within the Components window of the Main 
Panel.



Remove Component

Summary Remove component from the current library.

To Launch Alt C R

Purpose The Remove Component command is used to remove components from the current 
library.

Comments You can use the Edit Undo command (shortcut: ALT + BACKSPACE) to restore the deleted 
component.

Procedure To remove a component from the library;

          1. Choose Remove Component from the Component menu.

          The currently displayed component will be removed from the library.

See also
Remove Duplicates



Component Description

Summary Change component description fields.

To Launch Alt C P

Purpose The Component Description command is used to attach a description,    component 
footprint names and other information to a library component.

Outcome The information entered in the Component Text Fields dialog box will    be saved with the 
other library information about the current    component when the library is saved in 
Protel format.

Comments The information entered for the Text Field descriptions with a library component and 
cannot be altered in    Schematic Library Editor. However, the information can be 
accessed when generating a Bill of Materials in Advanced    Schematic Editor.

          Description This field is intended to provide a text description    of the component's 
function for reference purposes. Supports up to 255 characters, including spaces.

          Default Designator Defines the default designator for placement of the component in a 
schematic sheet. Letters numbers or a "?" may be used in this field. Supports up to 255 
characters, including spaces.

          Foot Prints These four fields may be used to indicate the names of    component 
footprints to be used in the Protel for Windows PCB    Design System. Supports up to 
255 characters, including spaces)

          Text Fields These eight fields may be used for notation of any    purpose. Supports up to 
255 characters, including spaces. They are in additional to the text fields that are 
editable within Schematic Library Editor and specific to each component.

Procedure To edit the description text for a component:

          Make sure the component you wish to attach descriptions to is highlighted    in the 
component list box on the Main Panel.

          1. Choose Description from the Component menu.

          The Component Text Fields dialog box will appear.

          2. Type information into the desired fields

          3. Press OK to return to the editor.

See also



Remove Duplicates

Summary Remove duplicate components from library.

To Launch Alt C D

Purpose The Remove Duplicates command is used to remove/delete duplicate components from 
the current library. The first component name in the library is saved and all other 
components with the same name are removed.

Comments This command is useful especially when using the file merge command, where all 
components from one library are copied into another library.

Procedure To remove duplicate components from the current library:

          1. Choose Remove Duplicates from the Component menu.

          Any duplicated components in the library will be removed.

See also
File Merge
Remove Component



Run Control Panel

Summary Run the Windows Control Panel Program.

To Launch  T W P

Purpose This command is used to launch Windows Control Panel utility directly from Advanced 
Schematic. Tools menu commands provide convenient ways to launch frequently used 
applications and utilities.

Outcome The Windows Control Panel utility will be launched.

Comments This is not a user-selectable Run command option.

Procedure Choose the Windows Tools command from the Tools menu then choose Control Panel.

See also
Setup User Programs



Run Windows Setup

Summary Run the Windows Setup Program.

To Launch  T W S

Purpose This command is used to launch the Windows Setup utility directly from Advanced 
Schematic. Tools menu commands provide convenient ways to launch frequently used 
applications and utilities.

Outcome The Windows Setup utility will be launched.

Comments This is not a user-selectable Run command option.

Procedure Choose the Windows Tools command from the Tools menu then choose Windows Setup.

See also
Setup User Programs



Run Text Editor

Summary Run the user specified text editor. (Defaults To Notepad.Exe).

To Launch  T W T

Purpose This command is used to launch a user-specified text editor directly from Advanced 
Schematic. Run menu options provide a convenient way to launch frequently used 
applications and utilities.

Outcome Launches the specified text editor application.

Comments User can specify the Text Editor application under the Tools-Setup command.

Procedure Choose the Windows Tools command from the Tools menu then choose Text Editor.

See also
Setup User Programs



Run Picture Editor

Summary Run the user specified Paint/Draw program (Default is Windows Paint).

To Launch  T W I

Purpose This command is used to launch a user-specified paint/draw application directly from 
Advanced Schematic. Tools menu commands provide convenient ways to launch 
frequently used applications and utilities.

Outcome Launches the specified Picture Editor application.

Comments User can specify the Picture Editor application under the Tools-Setup command.

Procedure Choose the Windows Tools command from the Tools menu then choose Picture Editor.

See also
Setup User Programs



Run File Manager

Summary Run the Windows File Manager Program.

To Launch  T W F

Purpose This command is used to launch the Windows File Manager utility directly from 
Advanced Schematic. Tools menu commands provide convenient ways to launch 
frequently used applications and utilities.

Outcome Launches the Windows File Manager utility.

Comments This is not a user-selectable Run command option.

Procedure Choose the Windows Tools command from the Tools menu then choose File Manager.

See also
Setup User Programs



Run Calculator

Summary Run the Windows Calculator Program.

To Launch  T W C

Purpose This command is used to launch the Windows Calculator utility directly from Advanced 
Schematic. Tools menu commands provide convenient ways to launch frequently used 
applications and utilities.

Outcome Launches the Windows Calculator utility.

Comments This is not a user-selectable Run command option.

Procedure Choose the Windows Tools command from the Tools menu then choose Calculator.

See also
Setup User Programs



Run Clock

Summary Run the Windows Clock Program.

To Launch  T W L

Purpose This command is used to launch the Windows Clock utility directly from Advanced 
Schematic. Tools menu commands provide convenient ways to launch frequently used 
applications and utilities.

Outcome Launches the Windows Clock utility.

Comments This is not a user-selectable Run command option.

Procedure Choose the Windows Tools command from the Tools menu then choose Clock.

See also
Setup User Programs



Run User Program 1

Summary Run user specified Program 1.

To Launch  T U 1

Purpose This command is used to launch an application directly from Advanced Schematic. Tools 
menu commands provide convenient ways to launch frequently used applications and 
utilities.

Outcome Launches the specified User Program (application/utility) #1.

Comments User can specify the User Program #1 application under the Tools-Setup command.

Procedure Choose the User Tools command from the Tools menu then choose User Program 1.

See also
Setup User Programs



Run User Program 2

Summary Run user specified Program 2.

To Launch  T U 2

Purpose This command is used to launch an application directly from Advanced Schematic. Tools 
menu commands provide convenient ways to launch frequently used applications and 
utilities.

Outcome Launches the specified User Program (application) #2.

Comments User can specify the User Program #2 application under the Tools-Setup command.

Procedure Choose the User Tools command from the Tools menu then choose User Program 2.

See also
Setup User Programs



Run User Program 3

Summary Run user specified Program 3.

To Launch  T U 3

Purpose This command is used to launch an application directly from Advanced Schematic. Tools 
menu commands provide convenient ways to launch frequently used applications and 
utilities.

Outcome Launches the specified User Program (application) #3.

Comments User can specify the User Program #3 application under the Tools-Setup command.

Procedure Choose the User Tools command from the Tools menu then choose User Program 3.

See also
Setup User Programs



Run User Program 4

Summary Run user specified Program 4.

To Launch  T U 4

Purpose This command is used to launch an application directly from Advanced Schematic. Tools 
menu commands provide convenient ways to launch frequently used applications and 
utilities.

Outcome Launches the specified User Program (application) #4.

Comments User can specify the User Program #4 application under the Tools-Setup command.

Procedure Choose the User Tools command from the Tools menu then choose User Program 4.

See also
Setup User Programs



Run CSV Editor

Summary Run the user specified program for editing CSV files.

To Launch  T W V

Purpose This command is used to launch an application directly from Advanced Schematic. Run 
menu options provide a convenient way to launch frequently used applications and 
utilities.

Outcome Launches the specified CSV Editor application.

Comments User can specify the CSV Editor application under the Tools-Setup command.

          Some DOS applications cannot be run from inside Windows. Attempting to launch 
incompatible DOS applications from the Tools menu could cause unexpected results, 
including system hangs.

Procedure Choose the Windows Tools command from the Tools menu then choose CSV Editor.is 
chosen.

See also
Setup User Programs



Setup User Programs

Summary Setup user specific Programs to use with Tools Menu.

To Launch  T S

Purpose This command is used to set-up applications to be launched directly from Advanced 
Schematic Library Editor. Tools menu options provide a convenient way to launch 
frequently used applications and utilities.

Outcome Opens the Setup Run Options dialog box.

Comments Some DOS applications cannot be run from inside Windows. Attempting to launch 
incompatible DOS applications from the Tools menu could cause unexpected results, 
including system hangs.

Procedure 1. Choose the Setup command from the Tools menu to open the Setup Run Options 
dialog box.

          2. Type the path (if necessary) and application name for each option in the appropriate 
box. Options include:

          Schematic Capture - Editor for schematic capture files. Default is SCH.EXE.

          Text editor - Editor for Reports (other than BOM CSV format). Default is NOTEPAD.EXE. 

          Picture editor - Editor for Image files. Default is PBRUSH.EXE. 

          CSV editor - Editor for BOM (CSV portion) reports. Default is NOTEPAD.EXE.

          User Program 1 to 4 - any user specified application or utility. None specified by default.

See also
Run File Manager
Run Control Panel
Run Calculator
Run Clock
Run Notepad
Run Text Editor
Run Picture Editor
Run CSV Editor
Run User Program 1
Run User Program 2
Run User Program 3
Run User Program 4



Run Notepad

Summary Run the Windows Notepad program.

To Launch  T W N

Purpose This command is used to launch the Windows Notepad program directly from Advanced 
Schematic. Tools menu commands provide convenient ways to launch frequently used 
applications and utilities.

Outcome Launches the Windows Notepad utility.

Comments This is not a user-selectable Run command option.

Procedure Choose the Windows Tools command from the Tools menu then choose Notepad.

See also
Setup User Programs



Popup Component Menu

Summary Popup the Component menu.

Purpose The Popup Component Menu command is used to directly access the Component menu 
at the current cursor position.

Procedure To popup the Component menu at the current cursor position.

          1. By default, press C.

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Component Rule Check

Summary Validate changes to current library.

To Launch Alt F R R

Purpose Screens the current active library for user-specified errors.

Outcome Generates a report file listing library (or component) errors for the current active library.

Comments When checking for duplicate pins, only the first instance will be reported for each 
component. If more than 1 duplicate exisits, this will not be reported separately.

Procedure When you choose this command, each component description in the current library is 
scanned. Errors and warnings are generated and displayed in a text file which is opened 
using Notepad or your designated text editing application (see Run command for 
details).

          Library errors include:

          Duplicate Component Names

          Duplicate Pins on a component

          Missing Component Description

          Missing Default Designators

          Missing Footprints (if all fields are empty)

          Missing Pin Names on a component

          Missing Pin Numbers on a component



Popup Move Menu

Summary Popup the Edit Move menu.

Purpose The Popup Move Menu command is used to directly access the Move menu at the 
current cursor position.

Procedure To popup the Move menu at the current cursor position.

          1. Press M. (Default hot key assignment)

          You can change the default hot key by using the Options Hot Keys command.

See also
Hot Keys



Toggle Command Status Bar

Summary Turn the Command Status Line on or off.

Purpose The Toggle Command Status Bar command is used to turn the lower half of the Status 
line (which displays the current command status) on or off at the bottom of the Advanced 
Schematic application window. Turning off the process status line shows more screen 
region.

Outcome Choosing Command Status Bar from the Options menu will turn the Command Status 
line on or off.    The Status line must be enabled for this command to be effective.

Comments The Command status line displays the name of the currently running command.

Procedure To turn the Command Status line on or off:

          1. Choose Command Status Bar from the Options menu.



Find and Replace Text

Summary Search for and replace text strings.

To Launch  Ctrl G    -    Alt E A

Purpose The Search for and replace text command allows you to conveniently locate and replace 
specific text that has been placed on any worksheet without having to zoom, pan or 
scroll through multiple screens.

Outcome Matching text will be replaced by the new replacement text.

Comments The wildcard character "*" can be used to extend the definition of 

          target strings. For example, S* will limit the fields to strings 

          beginning with S, etc. Wildcards are case in-sensitive. 

          Braces "" and "" can also be used used to define the rules for 

          text replacement. Defining the change follows this syntax: oldtext=newtext. This means 
change portion of the string "oldtext" to "newtext". You can use multiple sets of brackets 
to define complex replacements. In this case the leftmost replacement is made, then the 
next on, etc. Although this is very powerful, you must take care, because the first change 
can effect subsequent replacements, possibly generating an unexpected result. Any 
mistakes can be corrected with the Undo command, however.

          The find and replace text command can find and replace text 

          anywhere in a component or across a whole library. Extends across all objects with 
visible text, including Pins.

Procedure To search and replace text:

          1. Choose Replace Text from the Edit menu. The Text Find And Replace dialog box 
opens.

          2. Type the Text To Find string.

          3. In the New Text field, type the replacement text.

          4. Choose the Scope for the change. Sheet Scope - Current Document or All documents. 
Selection - Selected Objects, Deselected Objects, All Objects.

          5. Choose any other Options. Case Sensitive, Prompt On Replace. 

          6. Click OK to perform the text replacement.

See also



Find Next Text

Summary Search for and jump to the next matching text string.

To Launch  F3    -    Alt E X

Purpose The Find Next Text command allows you to conveniently locate specific text that has 
been placed on any worksheet without having to zoom, pan or scroll through multiple 
screens

Comments You can also Find and Replace text.

Procedure To find the next occurence of a string:

          1. Choose Find Next from the Edit menu.

See also



Find Text

Summary Search for and jump to a text string on the workspace..

To Launch  Ctrl F    -    Alt E F

Purpose The Find Text command allows you to conveniently locate specific text that has been 
placed on any workspace without having to zoom, pan or scroll through multiple screens.

Comments The wildcard character "*" can be used to extend the definition of 

          target strings. For example, S* will limit the fields to strings 

          beginning with S, etc. Wildcards are case in-sensitive. 

          The find text command can find text anywhere in a component or across a library. 
Extends across all objects with visible text, including Pins.

Procedure To search for text:

          1. Choose the Find Text from the Edit menu.

          2. Type the search text into the Text to find field in the Find Text Dialog box.

          3. Choose the Scope for the change.

          Changes can be applied to the Current Docuement Only or to All 

          Open Documents. Objects with text to be changed can be 

          restricted to selected or unselected items.

          4. Choose any other Options.



Jump New Location

Summary Type in and jump to a new location on the worksheet.

To Launch Alt E J L

Purpose The Jump Location command is used to move the cursor to a specified location by 
typing in X and Y coordinates. This can save you from having to constantly zoom in and 
out to navigate around your component design and is particularly useful for large or 
complex components.

Outcome The cursor is placed on the specified location.

Procedure To move the cursor to a specified location.

          1. Choose Jump Location from the Edit menu.

          2. Type an X coordinate (a distance from the horizontal center of the worksheet), the 
default is the current X position.

          3. Type a Y coordinate (a distance from the vertical center of the worksheet), the default 
is the current Y position.

          3. Click OK to jump to the specified location.

See also
Jump To Origin



Popup Jump Menu

Summary Popup the Edit Jump menu.

Purpose The Popup Jump Menu command is used to directly access the Edit Jump menu at the 
current cursor position.

Comments You can change the default hot key by using the Options Hot Keys command.

Procedure To popup the Edit Jump menu at the current cursor position.

          1. Press the J keyboard hot key. (Default hot key assignment.)

See also
Hot Keys



Change Object Graphically or Move

Summary Select and change objects on a library component.

Purpose This command is used to set the focus on an object. If the object already has the focus 
then this command interactively changes the object by physically moving the position of 
the objects handles.

Comments The Change Single Object Graphically or Move command can only be accessed using 
the mouse. This can be changed using setup hotkeys command. You can use the Edit 
Undo command (shortcut: ALT+BACKSPACE) to restore the edited objects.

Procedure To move an object;

          1. Move the cursor over the object to be graphically edited and click and hold LEFT 

MOUSE. 

          If the cursor is over a handle then the handle can be move, otherwise the whole object 
will be moved.

          2. Use the mouse to move the object.

See also
Change



Change Object Graphically or Set Focus

Summary Select and change objects on a library component.

Purpose This command is used to set the focus on an object. If the object already has the focus 
then this command interactively changes the object by physically moving the position of 
the objects handles.

Comments The Change Single Object Graphically command can only be accessed using the 
mouse. This can be changed using setup hotkeys command. You can use the Edit Undo 
command (shortcut: ALT+BACKSPACE) to restore the edited objects.

Procedure To set the focus on an object;

          1. Move the cursor over the object to be graphically edited and click LEFT MOUSE. The 
object will then be displayed with graphical editing handles.

          2. Use the mouse to graphically change the object.

See also
Change



Align Objects

Summary Align selected objects using alignment dialog box.

To Launch Alt E G A

Purpose The Align Objects command is used to align a group of selected objects on both x and y 
axis at the same time. Objects can be aligned by their left/right/top/bottom sides, center 
alignment, distributed horizontally or vertically or moved to the placement grid. You can 
align objects on one axis, by choosing the other Align menu commands.

Outcome The selection will be aligned according to the chosen options.

Procedure To align selected objects using the Align Objects dialog box:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Align command. 

          3. Select the desired horizontal and/or vertical alignment combination. You can also 
choose the Align To Grid option to constrain alignment to the nearest grid point.

          4. Click OK to close the dialog box and align the selection.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on bottom
Align objects on top
Align objects on right
Align objects on left



Align objects on left

Summary Align selected objects on the left side of their bounding rectangle.

To Launch  Ctrl L    -    Alt E G L

Purpose The Align objects on left command is used to align a group of selected objects along the 
left side of their bounding rectangle.

Outcome All selected objects will be aligned on the left edge of their bounding rectangle.

Procedure To align objects using the Align Left command:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Align Left command.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on bottom
Align objects on top
Align objects on right



Align objects on right

Summary Align selected objects on the right side of their bounding rectangle.

To Launch  Ctrl R    -    Alt E G R

Purpose The Align objects on right command is used to align a group of selected objects along 
the right side of their bounding rectangle.

Outcome All selected objects will be aligned on the right edge of their bounding rectangle.

Procedure To align objects using the Align Right command:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Align Right command.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on bottom
Align objects on top
Align objects on left



Center objects around horizontal axis

Summary Center objects around the vertical center line of the bounding rectangle.

To Launch  Ctrl H    -    Alt E G C

Purpose The Center objects around horizontal axis command is used to align a group of selected 
objects along their horizontal center l

Outcome All selected objects will be aligned along their horizontal center line.

Procedure To align objects using the Center Horizontal command:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Center Horizontal command.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around vertical axis
Align objects on bottom
Align objects on top
Align objects on right
Align objects on left



Distribute equally along horizontal axis

Summary Distribute equally the selected objects along the horizontal axis.

To Launch  Ctrl Shift H    -    Alt E G D

Purpose This command is used to space a group of selected objects equally along the horizontal 
axis.

Outcome All selected objects will be distributed equally along the horizontal axis.

Procedure To distribute objects equally along the horizontal axis:

          1. Add all items to be distributed to the current selection, making 

          sure that only items to be distributed horizontally are selected. You can use the Edit-
DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Distribute Horizontally 
command.

See also
Distribute equally along vertical axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on bottom
Align objects on top
Align objects on right
Align objects on left



Align objects on top

Summary Align selected objects on the top side of their bounding rectangle.

To Launch  Ctrl T    -    Alt E G T

Purpose The Align objects on top command is used to align a group of selected objects along the 
top edge of their bounding rectangle.

Outcome All selected objects will be aligned on the top edge of their bounding rectangle.

Procedure To align objects using the Align Top command:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Align Left command.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on bottom
Align objects on right
Align objects on left



Align objects on bottom

Summary Align selected objects on the bottom side of their bounding rectangle.

To Launch  Ctrl B    -    Alt E G B

Purpose The Align objects on bottom command is used to align a group of selected objects along 
the bottom edge of their bounding rectangle.

Outcome All selected objects will be aligned on the bottom edge of their bounding rectangle.

Procedure To align objects using the Align Bottom command:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Align Bottom command.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on top
Align objects on right
Align objects on left



Center objects around vertical axis

Summary Center objects around the vertical center line of the bounding rectangle.

To Launch  Ctrl V    -    Alt E G V

Purpose The Center objects around vertical axis command is used to align a group of selected 
objects along their vertical center line.

Outcome All selected objects will be aligned along their vertical center line.

Procedure To align objects using the Center Vertical command:

          1. Add all items to be aligned to the current selection, making 

          sure that only items to be aligned are selected. You can use 

          the Edit-DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Center Vertical command.

See also
Distribute equally along vertical axis
Distribute equally along horizontal axis
Center objects around horizontal axis
Align objects on bottom
Align objects on top
Align objects on right
Align objects on left



Distribute equally along vertical axis

Summary Distribute equally the selected objects along the vertical axis.

To Launch  Ctrl Shift V    -    Alt E G I

Purpose This command is used to space a group of selected objects equally along the vertical 
axis.

Outcome All selected objects will be distributed equally along the vertical axis.

Procedure To distribute objects equally along the vertical axis:

          1. Add all items to be distributed to the current selection, making 

          sure that only items to be distributed vertically are selected. You can use the Edit-
DeSelect-All command (shortcut: x, a) to clear the 

          current selection.

          2. Choose Align from the Edit menu and then choose the Distribute Verticallly command.

See also
Distribute equally along horizontal axis
Center objects around vertical axis
Center objects around horizontal axis
Align objects on bottom
Align objects on top
Align objects on right
Align objects on left



Open Environment Configuration File

Summary Open and load an environment configuration file.

To Launch  O O

Purpose This command is used to open and load an environment configuration file. This includes 
all options, preferences and the current set of open library files.

Outcome Once an environment configuration file has been selected, the current environment 
settings will be cleared and the new settings will be loaded, this includes all options, 
preferences and any files that were open when the original environment file was saved.

Comments All current settings will be lost and all files will be closed. Advanced Schematic Library 
Editor will prompt you to save any open files first.

Procedure To open a previously saved environment configuration file:

          1. Choose Open from the Options menu.

          2. Type the filename (include the full path, if different from the path listed after Directory)

          3. Click OK to open the file.

          You can also double-click on the desired filename in the Files window, if any. To change 
directories, click under any of the options listed in the Directories window.

See also
Save Environment Configuration File



Save Environment Configuration File

Summary Save current environment configuration to a file.

To Launch  O A

Purpose The File Save As command can be used to save the current environment configuration 
to a file. This includes all options, preferences and the list of all currently open files.

Outcome When you select the Options Save As command, the Save Environment File As dialog 
box will open. Once you click OK the file will be saved to the new file name and/or 
directory that you specified.

Procedure To save the current environment configuration to a new path, file name.

          1. Choose Save As from the Options menu.

          2. Type a new file name for the environment configuration. 

          3. Click OK to save the file.

          To change directories, click under any of the options listed in the Directories window.

See also
Open Environment Configuration File



Setup Autopan

Summary Setup Autopan options.

To Launch Alt O U

Purpose This command is used to configure the effect of Autopanning aroung the screen.

Outcome Opens the Setup Autopan dialog box, and allows customization of autopanning around 
the screen.

Comments When the Options Auto Pan feature is enabled, your 

          view of the current window will automatically pan up-down-left-

          right as you place, move or draw objects in the workspace. Panning 

          takes place when the cursor reaches the edge of the display when 

          placing, moving or re-sizing objects.

Procedure To change the autopan settings:

          1. Choose Auto-Pan from the Options menu

          2. The Setup Autopan dialog box will open.

          Three options can be set within this dialog box;

          Style - while autopanning the cursor can jump by a pre-defined step size, a full screen at 
a time with the cursor re-centering in the middle of the screen or can be disabled.

          Step Size - distance the cursor will jump while autopanning, the autopan Style must be 
set to Fixed Size Jump. 

          Shift Step Size - distance the cursor will jump while autopanning and holding down the 
SHIFT key, the autopan Style must be set to Fixed Size Jump.



Popup Alignment Menu

Summary Popup the Alignment menu.

Purpose The Popup Alignment Menu command is used to directly access the Align menu at the 
current cursor position.

Comments You can change the default hot key by using the Options Hot Keys command.

Procedure To popup the Alignment menu at the current cursor position.

          1. Press the A keyboard hot key. (Default hot key assignment)

See also
Hot Keys



Memory Monitor Setup

Summary Setup low memory/resources warning thresholds..

To Launch  O Y

Purpose This command is used to monitor the system memory and system resources.

          In the Memory Monitor dialog box the user can define minimum levels for system 
memory and system resources. These thresholds are used by the application to 
determine when a warning message is to be issued.

Outcome The following are options that can be set within the Memory Monitor dialog box.

          Frequency - specifies when memory is checked. By default it is checked after every 
16KB of memory is allocated.

          Memory Warning - enables/disables the warning and specifies the memory threshold. 
By default the warning threshold is 2000KB.

          System Resources Warning - enables/disables the warning and specifies the system 
resource threshold. By default the warning threshold is 30%.

Comments When either of these two options are enabled and the available memory or system 
resources fall below the defined thresholds a warning dialog box will open stating the 
problem and appropriate actions.

          Note: When the system resources fall below 10% Windows can behave unexpectedly, 
therefore it is not recommended to set the resource threshold warning lower than 10%.

Procedure To define the warning thresholds for system memory and system resources.

          1. Choose Memory Monitor from the Options menu.

          2. Choose or type in new memory monitor settings.

          3. Click OK to accept the new settings.

See also
Popup Info Menu



Data Primitives

Arc
Bezier
Ellipse
Elliptical Arc
Graphic
IEEE Symbol
Junction Symbol
Line
Pie Chart
Pin
Polygon
Rectangle
Round Rectangle
Text



Graphic

Overview Graphic images are special graphical objects, used for adding reference information to a 
library component, such as mechanical and electrical symbols or customized    
component images.

Fields
File Name The path and file name of the image file.
X1-Location The left hand edge reference point coordinate of the imported graphic image, 

along the x-axis.
Y1-Location The bottom edge reference point coordinate of the imported graphic image, along 

the y-axis.
X2-Location The right hand edge reference point coordinate of the imported graphic image, along the 

x-axis.



Y2-Location The top edge reference point coordinate of the imported graphic image, along the y-axis.

Border Width Specifies the border outline thickness of imported graphic images. There are four 
selectable border widths; smallest, small, medium and large.

Border Color The surrounding border of imported graphic images can be assigned a color. To assign a 
new color to the border, click in the color box to open the Color Selector dialog box. 
Schematic Library Editor will display all the available colors that your graphics card and 
monitor supports.

Selection Toggle the selection state of imported graphic images by turning this option on or off. If 
this option is on, the graphic image will be outlined in the selection color defined in the 
Options Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

Border On The surrounding border of imported graphic images can be toggled on or off. If this 
option is enabled, the border around the graphical image will be displayed in the border 
color. If this option is off, then only the graphic image will be shown.

X:Y Ratio 1:1 Graphical images may be re-sized by moving one of its handles, when this option is on, 
the image retains the original x and y aspect ratio.

Comments Schematic Library Editor supports the import of the following image formats;

          BMP - All uncompressed Bit Map images. Windows device-independent Bit Map format, 
introduced with Windows 3.0 and increasingly supported by Windows applications.

          PCX - Paintbrush format, used in Windows Paintbrush and other paint programs and 
supported by many desktop publishing and graphics programs. Supported colors 
include, monochrome, 16 color, 256 color, 24-bit color.

          TIFF - Tag Image File Format, supported by many desktop publishing programs. 
Supported compression types, uncompressed, LZW, Packbits, Modified Huffman 
encoding, CCITT Group 3 1D, CCITT Group 3 2D, CCITT Group 4. Supported colors 
include, monochrome, 16 color, 256 color, 24-bit color

          GIF - All non-interlaced Graphic Image files.

          EPS - Encapsulated postscript files with and without display images. If the EPS file does 
not contain a TIFF or Windows Metafile display image then the file name of the EPS 
image will be displayed.

          WMF - Only Windows Metafiles which conform to the Aldus Placeable Metafile Format 
are supported. Most applications which export or import Metafiles support this format.

See also
Place Graphic



Rectangle

Overview Rectangles are filled or unfilled graphic elements, used for building library components, 
such as defining the component body or adding graphical symbols.

Fields
X1-Location The left hand edge reference point coordinate of the rectangle, along the x-axis.
Y1-Location The bottom edge reference point coordinate of the rectangle, along the y-axis.
X2-Location The right hand edge reference point coordinate of the rectangle, along the x-axis.

Y2-Location The top edge reference point coordinate of the rectangle, along the y-axis.

Border Width Specifies the border outline thickness of rectangles. There are four selectable border 
widths; smallest, small, medium and large.

Border Color The surrounding border of Rectangles can be assigned a color. To assign a new color to 
the border, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

Fill Color The inside area of Rectangles can be assigned a color. To assign a new color to the 
inside area, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.



Selection Toggle the selection state of Rectangles by turning this option on or off. If this option is 
on, the Rectangle will be outlined in the selection color defined in the Options 
Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

Draw Solid Schematic Library Editor allows you to turn the inside area color of Rectangles on or off. 
If this option is on, the inside area of the Rectangle will be displayed in the fill color. If this 
option is off, then only the Rectangles border will be shown.

See also
Place Rectangle
Round Rectangle



Junction Symbol

Overview Junction symbols are small circular objects used for building library components on the 
library workspace. Junction symbols are graphical only they have no electrical 
significance.

Fields
X-Location The reference point coordinate of the junction symbol, along the x-axis.
Y-Location The reference point coordinate of the junction symbol, along the y-axis.
Size Specifies the size of junction symbols. There are four selectable junction sizes; smallest, 

small, medium and large.
Color Junction symbols can be assigned a color. To assign a new color to the Junction, click in 

the color box to open the Color Selector dialog box. Schematic Library Editor will display 
all the available colors that your graphics card and monitor supports.

Selection Toggle the selection state of Junction symbols by turning this option on or off. If this 
option is on, the Junction will be outlined in the selection color defined in the Options 
Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Junction Symbol



Arc

Overview Arcs are circular line segments, used for building library components, such as defining 
component outlines or adding graphical symbols.

Fields
X-Location The center point coordinate of an arc, along the x-axis.
Y-Location The center point coordinate of an arc, along the y-axis.
Radius Schematic Library Editor allows you to change the radius of Arcs. The radius can be any 

integer (whole number) value. A value of 1 = 10mil = .254mm.
Line Width Specifies the line thickness of Arc segments. There are four selectable Arc widths; 

smallest, small, medium and large.

Start Angle Schematic Library Editor allows you to change the start angle of an Arc. The start angle 
can be any degree from 1 to 360, (Real number).

End Angle Schematic Library Editor allows you to change the end angle of an Arc. The start angle 
can be any degree from 1 to 360, (Real number).

Color Arcs can be assigned a color. To assign a new color to the Arc, click in the color box to 
open the Color Selector dialog box. Schematic Library Editor will display all the available 
colors that your graphics card and monitor supports.

Selection Toggle the selection state of Arcs by turning this option on or off. If this option is on, the 



Arcs will be outlined in the selection color defined in the Options Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Arc
Elliptical Arc



Elliptical Arc

Overview Elliptical Arcs are graphical objects with a user-defined line width and start/end 
coordinates. Elliptical Arcs are used for building library components, such as defining 
component outlines or adding graphical symbols.

Fields
X-Location The reference point coordinate of the elliptical arc, along the x-axis.
Y-Location The reference point coordinate of the elliptical arc, along the y-axis.

X-Radius Schematic Library Editor allows you to change the horizontal width of Elliptical Arcs. The 
x-radius can be any integer (whole number) value. A value of 1 = 10mil = .254mm.

Y-Radius Schematic Library Editor allows you to change the vertical height of Elliptical Arcs. The y-
radius can be any integer (whole number) value. A value of 1 = 10mil = .254mm.

Line Width Specifies the line thickness of elliptical arc segments. There are four selectable elliptical 
arc widths; smallest, small, medium and large.

Start Angle Schematic Library Editor allows you to change the start angle of Elliptical Arcs. The start 
angle can be any degree from 1 to 360, (Real number).

End Angle Schematic Library Editor allows you to change the end angle of Elliptical Arcs. The start 
angle can be any degree from 1 to 360, (Real number).

Color Elliptical Arcs can be assigned a color. To assign a new color to the Elliptical Arc, click in 



the color box to open the Color Selector dialog box. Schematic Library Editor will display 
all the available colors that your graphics card and monitor supports.

Selection Toggle the selection state of Elliptical Arcs by turning this option on or off. If this option is 
on, the Elliptical Arc will be outlined in the selection color defined in the Options 
Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Elliptical Arc
Ellipse



Round Rectangle

Overview Rounded rectangles are graphical objects with a user-defined line width, start/end 
coordinates, and fill color. Rounded rectangles are used for building library components, 
such as defining the component body or adding graphical symbols.

Fields
X1-Location The left hand edge reference point coordinate of the rounded rectangle, along 

the x-axis.
Y1-Location The bottom edge reference point coordinate of the rounded rectangle, along the 

y-axis.
X2-Location The right hand edge reference point coordinate of the rounded rectangle, along the x-

axis.

Y2-Location The top edge reference point coordinate of the rounded rectangle, along the y-axis.

          Schematic Library Editor allows you to change the horizontal corner radius of rounded 
rectangles. The corner radius can be any integer (whole number) value. A value of 1 = 
10mil = .254mm.



          Schematic Library Editor allows you to change the vertical corner radius of rounded 
rectangles. The corner radius can be any integer (whole number) value. A value of 1 = 
10mil = .254mm.

Border Width Specifies the border outline thickness of Rounded Rectangles. There are four selectable 
border widths; smallest, small, medium and large.

Border Color The surrounding border of Rounded Rectangles can be assigned a color. To assign a 
new color to the border, click in the color box to open the Color Selector dialog box. 
Schematic Library Editor will display all the available colors that your graphics card and 
monitor supports.

Fill Color The inside area of Rounded Rectangles can be assigned a color. To assign a new color 
to the inside area, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

Selection Toggle the selection state of Rounded Rectangles by turning this option on or off. If this 
option is on, the Rounded Rectangle will be outlined in the selection color defined in the 
Options Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

Draw Solid Schematic Library Editor allows you to turn the inside area color of Round Rectangles on 
or off. If this option is on, the inside area of the Rounded Rectangle will be displayed in 
the fill color. If this option is off, then only the Rounded Rectangles border will be shown.

See also
Place Round Rectangle



Pie Chart

Overview Pie Charts are circular graphic objects with a user-defined line width, radius, starting 
angle and ending angle. Pie Charts are used for building library components, such as 
defining the component body or adding graphical symbols.

Fields
X-Location The reference point coordinate of the Pie object, along the x-axis.
Y-Location The reference point coordinate of the Pie object along the y-axis.
Radius Schematic Library Editor allows you to change the radius of Pie objects. The radius can 

be any integer (whole number) value. A value of 1 = 10mil = .254mm.

Start Angle Schematic Library Editor allows you to change the start angle of Pie objects. The start 
angle can be any degree from 1 to 360, (Real number).

End Angle Schematic Library Editor allows you to change the end angle of Pie symbols. The end 
angle can be any degree from 1 to 360, (Real number).

Border Color The surrounding border of Pie objects can be assigned a color. To assign a new color to 



the border, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

Fill Color The inside area of Pie objects can be assigned a color. To assign a new color to the 
inside area, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

Draw Solid Schematic Library Editor allows you to turn the inside area color of Pie objects on or off. 
If this option is on, the inside area of the Pie will be displayed in the fill color. If this option 
is off, then only the Pie objects border will be shown.

Selection Toggle the selection state of Pie objects by turning this option on or off. If this option is 
on, the Pie will be outlined in the selection color defined in the Options Preferences 
dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Pie Charts



Ellipse

Overview Ellipses are graphical objects with a user-defined line width, x and y radius, and fill color. 
Ellipses are used for building library components, such as defining the component body 
or adding graphical symbols.

Fields
X-Location The reference point coordinate of an ellipse, along the x-axis.
Y-Location The reference point coordinate of the ellipse, along the y-axis.
X-Radius Schematic Library Editor allows you to change the horizontal width of Ellipses. 

The x-radius can be any integer (whole number) value. A value of 1 = 10mil = .254mm.
Y-Radius Schematic Library Editor allows you to change the vertical height of ellipse objects. The 

y-radius can be any integer (whole number) value. A value of 1 = 10mil = .254mm.

Border Width Specifies the border outline thickness of Ellipses. There are four selectable border 
widths; smallest, small, medium and large.

Border Color The surrounding border of Ellipses can be assigned a color. To assign a new color to the 
border, click in the color box to open the Color Selector dialog box. Schematic Library 
Editor will display all the available colors that your graphics card and monitor supports.

Fill Color The inside area of Ellipses can be assigned a color. To assign a new color to the inside 
area, click in the color box to open the Color Selector dialog box. Schematic Library 



Editor will display all the available colors that your graphics card and monitor supports.

Draw Solid Schematic Library Editor allows you to turn the inside area color of Ellipses on or off. If 
this option is on, the inside area of the Ellipse will be displayed in the fill color. If this 
option is off, then only the Ellipses border will be shown.

Selection Toggle the selection state of Ellipses by turning this option on or off. If this option is on, 
the Ellipse will be outlined in the selection color defined in the Options Preferences 
dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Ellipse
Elliptical Arc



Polygon

Overview Polygons are graphical objects with a user-definable line width, vertex coordinates, and 
fill color. Each vertex of a polygon can be independently moved. Polygons are used for 
building library components, such as defining the component body or adding graphical 
symbols.

Fields
Border Width Specifies the border outline thickness of Polygons. There are four selectable 

border widths; smallest, small, medium and large.
Border Color The surrounding border of Polygons can be assigned a color. To assign a new color to 

the border, click in the color box to open the Color Selector dialog box. Schematic 
Library Editor will display all the available colors that your graphics card and monitor 
supports.

Fill Color The inside area of Polygons can be assigned a color. To assign a new color to the inside 
area, click in the color box to open the Color Selector dialog box. Schematic Library 
Editor will display all the available colors that your graphics card and monitor supports.

Draw Solid Schematic Library Editor allows you to turn the inside area color of Polygons on or off. If 
this option is on, the inside area of the Polygon will be displayed in the fill color. If this 
option is off, then only the Polygons border will be shown.

Selection Toggle the selection state of Polygon by turning this option on or off. If this option is on, 
the Polygon will be outlined in the selection color defined in the Options Preferences 
dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 



using the Edit Select and De-select commands to define a selection group.

See also
Place Polygon



Line

Overview Lines are graphical objects with any number of joined segments and a user defined 
width, start and end point, vertices and color. Each vertex of a line can be independently 
moved. Lines are used for building library components, such as defining component 
outlines or adding graphical symbols.

Fields
Line Width Specifies the line thickness of Polyline segments. There are four selectable 

Polyline widths; smallest, small, medium and large.
Line Style Specifies the line display type of Polyline segments. There are three selectable Polyline 

styles; solid, dashed and dotted. The dashed and dotted styles only apply to 'smallest' 
width Polylines.

Color Polylines can be assigned a color. To assign a new color to the Polyline, click in the color 
box to open the Color Selector dialog box. Schematic Library Editor will display all the 
available colors that your graphics card and monitor supports.

Selection Toggle the selection state of Polylines by turning this option on or off. If this option is 
enabled, the Polyline will be outlined in the selection color defined in the Options 
Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.



See also
Place Line



Bezier

Overview Beziers are curved line segments, used for building library components, such as defining 
component outlines or adding graphical symbols.

Fields
Curve Width Specifies the line thickness of the Bezier curves. There are four selectable line 

widths; smallest, small, medium and large.
Color Beziers can be assigned a color. To assign a new color to the lines and curves of the 

Bezier, click in the color box to open the Color Selector dialog box. Schematic Library Editor will display 
all the available colors that your graphics card and monitor supports.

Selection Toggle the selection state of Bezier curves by turning this option on or off. If this option is 
on, the Bezier curve will be outlined in the selection color defined in the Options 
Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Bezier



Text

Overview Single line free text is used to place notes or comments around a library component.

Fields
Text Free Text support up to 255 characters, including spaces.
X-Location The reference point coordinate of the free text, along the x-axis.
Y-Location The reference point coordinate of the free text, along the y-axis.
Orientation Text can be rotated through 360 degrees using 90 degree increments. There are 

four selectable orientations, 0 degrees, 90 degrees, 180 degrees and 270 degrees. While moving free 
text, you can rotate it around the cursor by pressing the spacebar.

Color Free text can be assigned a color. To assign a new color to the text, click in the color box 
to open the Color Selector dialog box. Schematic Library Editor will display all the 
available colors that your graphics card and monitor supports.

Font Free text support formatting, such as, True Type fonts, definable character sizes, italic, 
bold, underline, and strikeout styles.

Selection Toggle the selection state of the free text by turning this option on or off. If this option is 
on, the free text will be outlined in the selection color defined in the Options Preferences 
dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Text



IEEE Symbol

Overview IEEE Symbols are graphic qualifying symbols used for representing logic functions or 
devices. These symbols enable users to understand the logic characteristics of these 
functions or devices without requiring specific knowledge of their internal characteristics. 
The symbols can show the relationship of each input of a digital logic circuit to each 
output without showing explicitly the internal logic.

          An IEEE symbol comprises an outline or a combination of outlines together with one or 
more qualifying symbols. Input lines are placed on the left and output lines are placed on 
the right. When an exception is made to that convention, the direction of signal flow is 
indicated by an arrow.

Fields



Symbol There are over thirty different qualifying symbols supported by Schematic Library Editor. 
The symbols are graphic representations only and have no electrical properties.

          Dot: Logic negation at input (external 0 produces internal 1) or logic negation at output 
(internal 1 produces external 0).

          Right Left Signal Flow: Signal flow from right to left. If not otherwise indicated, signal flow 
is from left to right.

          Clock: Dynamic internal connection. Transition from 0 to 1 on left produces transitory 1 
state on right.

          Active Low Input: The L-level on the input produces the internal 1-state. Note: This 
qualifying symbol is designated the polarity symbol and shall point in the direction of 
signal flow.

          Analog Signal In: Input for analog signals, on a digital symbol.

          Not Logic Connection: Non logic connection. A label inside the symbol will usually define 
the nature of this pin. This symbol may be used to indicate a connection that does not 
carry any logic information, for example, a power supply connection.

          Postponed Output: Postponed output. The change of the internal state of this output is 
postponed until the input signal that initiates the change returns to its initial external logic 
state or logic level.

          Open Collector: Open-circuit output (L-type) (for example, NPN open-collector, PNP 
open-emitter, N-channel open-drain, or P-channel open-source). When not in its external 
high-impedance state, this type of output produces a relatively low-impedance L-level.

          HiZ: 3-state output. This output can take on a third external state, which is a high-
impedance state, having no logical significance.

          High Current: Output with more than usual output capability (symbol is oriented in 
direction of signal flow).

          Pulse: Monostable Elements.

          Delay: Delay Elements.

          Group Line: Line grouping for inputs and outputs. This symbol indicates that two or more 
terminals are needed to implement a single logic input/output. 

          Group Binary: Symbol used for binary grouping.

          Active Low Output: Active-low output in the case of right-to-left signal flow.

          Open Collector pull-up: Passive-pull-up output. Is similar to NPN open-collector output 
but is supplemented with a built-in passive pull-up.

          Open Emitter: Open-circuit output (H-type) (for example, PNP open-collector, NPN open-
emitter, P-channel open-drain, or N-channel open-source) When not in its external high-
impedance state, this type of output produces a relatively low-impedance H-level.

          Open Emitter pull-up: Passive-pull-down output. Is similar to NPN open-emitter output 
but is supplemented with a built-in passive pull-down. 



          Digital Signal In: Input for digital signals, on an analog symbol.

          Input Output: Bi-directional signal flow. This symbol is used to indicate a single line that 
serves as both an input and a output.

          Shift Left: Shifting input of a register from right to left.

          Sigma: Adder.

          Schmitt: Input with hysteresis, Bithreshold input.

          Shift Right: Shifting input of a register from left to right.

X-Location The reference point coordinate of the IEEE symbol, along the x-axis.

Y-Location The reference point coordinate of an IEEE symbol, along the y-axis.

Size Specifies the size of IEEE symbol. There are four selectable sizes; smallest, small, 
medium and large.

Orientation IEEE symbols can be rotated through 360 degrees using 90 degree increments. There 
are four selectable orientations, 0 degrees, 90 degrees, 180 degrees and 270 degrees.

Line Width Specifies the line thickness of the IEEE symbol. There are four selectable line widths; 
smallest, small, medium and large.

Color IEEE symbols can be assigned with any color. To assign a new color to the IEEE 
symbol, click in the color box to open the Color Selector dialog box. Schematic Library 
Editor will display all the available colors that your graphics card and monitor supports.

Selection Toggle the selection state of IEEE symbols by turning this option on or off. If this option is 
on, the IEEE symbol will be outlined in the selection color defined in the Options 
Preferences dialog box.

          Selections are generally made three ways; using this dialog box, using    SHIFT+LEFT 

MOUSE to add (or remove) individual objects to the current selection and by using the 
Edit Select and De-select commands to define a selection group.

Comments While moving an IEEE symbol, you can rotate it 90 degrees around the cursor and flip it 
along its x or y axis by using the fs16 SPACEBAR, X and Y keys. Press TAB to manually 
change the default values of the symbol by typing new values directly into a dialog box.

See also
Place IEEE Symbol



Pin

Overview Pins are special objects that have electrical characteristics and are used to direct signals 
into and out of Parts. Pins have user defined name and number, electrical type, length, 
color, orientation and other display options.

Fields
Name Pin names support up to 255 characters of text including spaces. The    name is 

positioned to the left or to the right of the pin depending upon its orientation.
          An inversion bar may be placed over the pin name characters by typing a backslash '\' 

after each character. For example, to place an inversion bar over the pin name 
'ENABLE', type 'E\N\A\B\L\E\'. To place the inversion bar over the first two characters, 
type 'E\N\ABLE'.



Number Pin numbers support up to 255 characters of text including spaces. The number is 
positioned along the top of the pin. The pin number will automatically increment if the 
first or last characters are numbers. For example, an initial pin number of 1 will 
automatically increment to 2, 3, 4... and so on. A number of 2A will increment 3A, 4A, 5A, 
and a number of A10 will increment A11, A12, A13.

X-Location The reference point coordinate of the pin , along the x-axis.

Y-Location The reference point coordinate of the pin , along the y-axis.

Orientation Pins can be rotated through 360 degrees using 90 degree increments. There are four 
selectable orientations, 0 degrees, 90 degrees, 180 degrees and 270 degrees.

Color Pins can be assigned a color. To assign a new color to the Pin, click in the color box to 
open the Color Selector dialog box. Schematic Library Editor will display all the available 
colors that your graphics card and monitor supports.

Dot Symbol If this option is enabled, a small circular inversion dot will be displayed at the end of the 
pin.

Clk Symbol If this option is enabled, a small triangular clock identifier will be displayed at the end of 
the pin.

Electrical Type The electrical properties of Pins. The Electrical Rules Check recognizes Pin types and 
reports violations. There are eight electrical types that can be assigned to Pins:

          Input - Specifies that the pin is to be used to direct a signal into a Part. 

          I/O - Specifies that the pin is bi-directional and can either be used as an input or an 
output pin.

          Output - Specifies that the pin is to be used to direct a signal out of a Part. 

          Open Collector - Specifies that the pin is to be used in an open-collector gate. Open-
collector gates are used in three major applications: driving a lamp or relay, performing 
wired logic, and for the construction of a common-bus system. 

          Passive - Specifies that the pin has no driving power source.

          HiZ - A three-state pin exhibits three output states, a low-level state, a high-level state 
and an open circuit or high-impedance state.

          Open Emitter - Specifies that the pin is to be used in an open-emitter gate. 

          Power - Specifies that the pin is connected to a power source or to ground.

Hidden If this option is enabled, the pin is hidden and is not displayed on the workspace. The pin 
also does not appear when placed on the Schematic Library Editor drawing workspace.

Show Name If this option is enabled, the pin name will be displayed and positioned to the left or to the 
right of the pin depending upon its orientation.

Show Number If this option is enabled, the pin number will be displayed and positioned along the top of 
the pin.



Pin Length Schematic Library Editor allows you to change the length of Pins. The length can be any 
integer (whole number) value. A value of 1 = 10mil = .254mm. The default is 30.

Selection Toggle the selection state of Pins by turning this option on or off. If this option is on, the 
Pin will be outlined in the selection color defined in the Options Preferences dialog box.

          Selections are generally made three ways; using the option in a dialog box, using 
SHIFT+LEFT MOUSE to add (or remove) individual objects to the current selection and by 
using the Edit Select and De-select commands to define a selection group.

See also
Place Pin
Toggle Hidden Pins



MainMenu

File Nested Menu
Edit Nested Menu

Place Nested Menu
Component Nested Menu

Tools Nested Menu
Options Nested Menu

Zoom Nested Menu
Info Nested Menu

Window Nested Menu
Help Nested Menu



File

New Create a new and empty component library file
Open... Open and load a component library file

Merge... Merge components from another library to current library file
Close Close the current window
Save Save current library with same file name

Save As... Save current component library with new file name
Save All Save all loaded component library files

Setup Printer... Printer and page setup
Print Print the current document with the last set printer options

Report Nested Menu
Update Schematic Update components in all opened schematic worksheet files

Exit Quit from Schematic Library Editor



Report

Component Display component information
Library Display library statistics

Component Rule Check Validate changes to current library



Edit

Undo Undo previous command
Redo Redo previous undo command

Cut Copy selected objects to clipboard and remove from workspace
Copy Copy all selected objects to the clipboard
Paste Place clipboard contents onto current library workspace

Paste Array... Define an array placement of clipboard contents
Clear Delete all selected objects from the current library workspace

Find Text... Search for and jump to a text string on the workspace.
Replace Text... Search for and replace text strings

Find Next Search for and jump to the next matching text string
Select Nested Menu

DeSelect Nested Menu
Toggle Selection Toggle selection-state of objects

Delete Select and delete objects on library workspace
Change Select and use dialog to change objects

Move Nested Menu
Align Nested Menu
Jump Nested Menu



Select

Inside Area Select all objects inside an area
Outside Area Select all objects outside an area

All Select everything on the current library workspace



DeSelect

Inside Area De-Select all objects inside an area
Outside Area De-Select all objects outside an area

All De-Select all selected objects



Move

Move Select and move objects on the library workspace
Move Selection Move selected objects to another area of the library workspace
Move To Front Move and place an object in the front of all other objects
Bring To Front Bring an object graphically to the front of all other objects
Send To Back Send an object to the back of all other objects

Bring To Front Of Bring an object to the front of another object
Send To Back Of Send an object to the back of another object



Align

Align... Align selected objects using alignment dialog box
Align left Align selected objects on the left side of their bounding rectangle

Align Right Align selected objects on the right side of their bounding rectangle
Center Horizontal Center objects around the vertical center line of the bounding rectangle

Distribute Horizontally+Shift Distribute equally the selected objects along the horizontal axis
Align Top Align selected objects on the top side of their bounding rectangle

Align Bottom Align selected objects on the bottom side of their bounding rectangle
Center Vertical Center objects around the vertical center line of the bounding rectangle

Distribute Vertically+Shift Distribute equally the selected objects along the vertical axis



Jump

Origin Jump to the origin of the library workspace (lower left)
New Location... Type in and jump to a new location on the worksheet



Place

IEEE Symbols Nested Menu
Pins Place electrical pin on the library workspace

Junction Symbol Place a Junction symbol on the library workspace
Arcs Place graphical arcs on the library workspace

Elliptical Arcs Place elliptical arcs on the library workspace
Ellipses Place elliptical shapes on the library workspace

Pie Charts Place pie charts on the library workspace
Line Place graphical lines on the library workspace

Rectangle Place rectangles on the library workspace
Round Rectangle Place round rectangles on the library workspace

Polygons Place graphical polygon shapes on the library workspace
Beziers Place curved lines on the library workspace

Text Place single line text on the library workspace
Graphic... Place PCX/BMP/GIF/TIFF/WMF/EPS graphical images on the library 

workspace



IEEE Symbols

Dot Place IEEE Dot symbol on the library workspace
Right Left Signal Flow Place IEEE Right Left Signal Flow symbol on the library workspace

Clock Place IEEE Clock symbol on the library workspace
Active Low Input Place IEEE Active Low Input symbol on the library workspace
Analog Signal In Place IEEE Analog Signal In symbol on the library workspace

Not Logic Connection Place IEEE Not Logic Connection symbol on the library workspace
Postponed Output Place IEEE Postponed Output symbol on the library workspace

Open Collector Place IEEE Open Collector symbol on the library workspace
HiZ Place IEEE Hiz symbol on the library workspace

High Current Place IEEE High Current symbol on the library workspace
Pulse Place IEEE Pulse symbol on the library workspace
Delay Place IEEE Delay symbol on the library workspace

Group Line Place IEEE Group Line symbol on the library workspace
Group Binary Place IEEE Group Binary symbol on the library workspace

Active Low Output Place IEEE Active Low Output symbol on the library workspace
Pi Symbol Place IEEE Pi symbol on the library workspace

Greater Equal Place IEEE Greater Equal symbol on the library workspace
Open Collector PullUp Place IEEE Open Collector Pull Up symbol on the library workspace

Open Emitter Place IEEE Open Emitter symbol on the library workspace
Open Emitter PullUp Place IEEE Open Emitter Pull Up symbol on the library workspace

Digital Signal In Place IEEE Digital Signal In symbol on the library workspace
Invertor Place IEEE Invertor symbol on the library workspace
Or Gate Place IEEE Or Gate symbol on the library workspace

Input Output Place IEEE Input Output symbol on the library workspace
And Gate Place IEEE And Gate symbol on the library workspace
Xor Gate Place IEEE Xor Gate symbol on the library workspace
Shift Left Place IEEE Shift Left symbol on the library workspace

Less Equal Place IEEE Less Equal symbol on the library workspace
Sigma Place IEEE Sigma symbol on the library workspace

Schmitt Place IEEE Schmitt symbol on the library workspace
Shift Right Place IEEE Shift Right symbol on the library workspace



Component

New Component Add a new component to library
Remove Component Remove component from the current library

Rename Component... Change the name of the current component
Remove Component Name Remove component name from group
Add Component Name... Add component name to group

Copy Component... Copy component from current library to another library file
Move Component... Move component from current library to another library file

New Part Add a new part to the currently displayed component
Remove Part Remove a part from the currently displayed component

Component Nested Menu
Show Normal Display component in standard ANSI notation

Show Demorgan Command Summary
Show IEEE Command Summary

Description... Change component description fields
Remove Duplicates Remove duplicate components from library



Component

Next Part Show the next part of the currently displayed component
Prev Part Show the previous part of the currently displayed component

Next Component Show the next component in the library
Prev Component Show the previous component in the library
First Component Show the first component in the library
Last Component Show the last component in the library



Tools

Schematic Capture Launch and Switch to the Schematic Sheet Editor
Windows Tools Nested Menu

User Tools Nested Menu
Setup... Setup user specific Programs to use with Tools Menu



Windows Tools

File Manager Run the Windows File Manager Program
Control Panel Run the Windows Control Panel Program

Windows Setup Run the Windows Setup Program
Calculator Run the Windows Calculator Program

Clock Run the Windows Clock Program
Notepad Run the Windows Notepad program

Text Editor Run the user specified text editor. (Defaults To Notepad.Exe)
Picture Editor Run the user specified Paint/Draw program (Default is Windows Paint)

CSV Editor Run the user specified program for editing CSV files



User Tools

User Program 1 Run user specified Program 1
User Program 2 Run user specified Program 2
User Program 3 Run user specified Program 3
User Program 4 Run user specified Program 4



Options

Preferences... Setup System Preferences
Workspace... Setup options for current workspace

Hot Keys... Setup Hot Key assignments
Auto-Pan... Setup Autopan options

Memory Monitor... Setup low memory/resources warning thresholds.
Status Bar Turn the Status Line on or off

Command Status Bar Turn the Command Status Line on or off
Scroll Bars Turn the scroll bars on or off
Main Panel Turn Main Panel on or off

Main Toolbar Turn the Main Toolbar on or off
IEEE Toolbar Turn the IEEE Toolbar on or off

Drawing Toolbar Turn the Drawing Toolbar on or off
Visible Grid Turn the visible grid on or off

Snap Grid Turn the snap grid on or off
Show Hidden Pins Show/Hide hidden pins in component

Open... Open and load an environment configuration file
Save As... Save current environment configuration to a file



Zoom

Window Select a rectangular area of the workspace and fit that area in the window
Point Select a rectangular area of the workspace and fit that area in the window
50% Set zoom scale to 0.5x

100% Set zoom scale to 1x (normal magnification)
200% Set zoom scale to 2x
400% Set zoom scale to 4x (highest magnification)

In Show less of the current workspace (higher magnification)
Out Show more of the current workspace (lower magnification)
Pan Re-Center the screen around the cursor

Redraw Update the screen display
All Fit all objects on the current workspace in the window

Workspace Show the entire workspace



Info

System Status... Display system information



Window

Tile Tile all open schematic windows
Cascade Cascade all open schematic windows

Arrange Icons Arrange all minimized open library document windows
Close All Close all open schematic windows



Help

Contents Help system topic index
Using Help Information about the Windows Help System

Basic Concepts Basic information about Schematic Library Editor
Commands Help information organized by menu structure

Printing Information about generating hard copy output
Reference Schematic Library Editor Reference

About... Display the version number and copyright of Schematic Library Editor



Hot Keys

 E Popup Edit Menu Popup the Edit menu
C Popup Component Menu Popup the Component menu
M Popup Move Menu Popup the Edit Move menu
P Popup Place Menu Popup the Place menu
J Popup Jump Menu Popup the Edit Jump menu
S Popup Select Menu Popup the Edit Select menu
X Popup De-Select Menu Popup the Edit De-Select menu
Z Popup Zoom Menu Popup the Zoom menu
O Popup Options Menu Popup the Options menu
A Popup Alignment Menu Popup the Alignment menu
H Popup Help Menu Popup the Help menu
F Popup File Menu Popup the File menu
I Popup Info Menu Popup the Info menu

W Popup Window Menu Popup the Window menu
F1 Help Index Help system topic index

Shift F4 Window Tile Tile all open schematic windows
Shift F5 Window Cascade Cascade all open schematic windows

Alt BackSpace Undo Undo previous command
Ctrl BackSpace Redo Redo previous undo command

Shift Delete Cut Copy selected objects to clipboard and remove from workspace
Ctrl Insert Copy Copy all selected objects to the clipboard

Shift Insert Paste Place clipboard contents onto current library workspace
Ctrl Delete Clear Delete all selected objects from the current library workspace

Shift MouseLeft Toggle Single Object Toggle selection-state of objects
Delete Delete Single Object Delete object that currently has the focus

MouseLeft Change Object Graphically or Set Focus Select and change objects on a 
library component

MouseLeftHold Change Object Graphically or Move Select and change objects on a library 
component

MouseDblLeft Change Single Object Use dialog to change object under the cursor
Ctrl MouseLeft Move Single Object Select and move objects on the library workspace

Ctrl PgDn Zoom All Fit all objects on the current workspace in the window
PgUp Zoom In Show less of the current workspace (higher magnification)
PgDn Zoom Out Show more of the current workspace (lower magnification)
Home Zoom Pan Re-Center the screen around the cursor

End Screen Redraw Update the screen display
Ctrl 4 Zoom 400% Set zoom scale to 4x (highest magnification)
Ctrl 2 Zoom 200% Set zoom scale to 2x
Ctrl 1 Zoom 100% Set zoom scale to 1x (normal magnification)
Ctrl 5 Zoom 50% Set zoom scale to 0.5x

Shift Up Shift Cursor Up Move the cursor up 10 snap grid points
Shift Down Shift Cursor Down Move the cursor down 10 snap grid points

Shift Left Shift Cursor Left Move the cursor up 10 snap grid points
Shift Right Shift Cursor Right Move the cursor right 10 snap grid points



Up Cursor Up Move the cursor up one snap grid point
Down Cursor Down Move the cursor down one snap grid point

Left Cursor Left Move the cursor left one snap grid point
Right Cursor Right Move the cursor right one snap grid point
Ctrl F Find Text Search for and jump to a text string on the workspace.

F3 Find Next Text Search for and jump to the next matching text string
Ctrl G Find and Replace Text Search for and replace text strings
Ctrl L Align objects on left Align selected objects on the left side of their bounding 

rectangle
Ctrl R Align objects on right Align selected objects on the right side of their 

bounding rectangle
Ctrl H Center objects around horizontal axis Center objects around the vertical 

center line of the bounding rectangle
Ctrl Shift H Distribute equally along horizontal axis Distribute equally the selected 

objects along the horizontal axis
Ctrl T Align objects on top Align selected objects on the top side of their bounding 

rectangle
Ctrl B Align objects on bottom Align selected objects on the bottom side of their 

bounding rectangle
Ctrl V Center objects around vertical axis Center objects around the vertical 

center line of the bounding rectangle
Ctrl Shift V Distribute equally along vertical axis Distribute equally the selected 

objects along the vertical axis



Tool Bars

Tools

IEEE

Library Tools



Tools

              Toggle Main Panel Turn Main Panel on or off

              File Open Open and load a component library file

              File Save Save current library with same file name

              Setup Printer Printer and page setup

              Zoom In Show less of the current workspace (higher magnification)

              Zoom Out Show more of the current workspace (lower magnification)

              Cut Copy selected objects to clipboard and remove from workspace

              Paste Place clipboard contents onto current library workspace

              Select Inside Area Select all objects inside an area

              De-Select All De-Select all selected objects

              Move Selection Move selected objects to another area of the library workspace

              Run Schematic Capture Launch and Switch to the Schematic Sheet Editor

              Toggle Drawing Toolbar Turn the Drawing Toolbar on or off

              Toggle IEEE Toolbar Turn the IEEE Toolbar on or off

              Undo Undo previous command

              Redo Redo previous undo command

              Help Index Help system topic index



IEEE

              Place IEEE Dot Place IEEE Dot symbol on the library workspace

              Place IEEE Right Left Signal Flow Place IEEE Right Left Signal Flow symbol 
on the library workspace

              Place IEEE Clock Place IEEE Clock symbol on the library workspace

              Place IEEE Active Low Input Place IEEE Active Low Input symbol on the library 
workspace

              Place IEEE Analog Signal In Place IEEE Analog Signal In symbol on the library 
workspace

              Place IEEE Not Logic Connection Place IEEE Not Logic Connection symbol on 
the library workspace

              Place IEEE Postponed Output Place IEEE Postponed Output symbol on the 
library workspace

              Place IEEE Open Collector Place IEEE Open Collector symbol on the library 
workspace

              Place IEEE Hiz Place IEEE Hiz symbol on the library workspace

              Place IEEE High Current Place IEEE High Current symbol on the library 
workspace

              Place IEEE Pulse Place IEEE Pulse symbol on the library workspace

              Place IEEE Delay Place IEEE Delay symbol on the library workspace

              Place IEEE Group Line Place IEEE Group Line symbol on the library workspace

              Place IEEE Group Binary Place IEEE Group Binary symbol on the library 
workspace

              Place IEEE Active Low Output Place IEEE Active Low Output symbol on the 
library workspace

              Place IEEE Pi Symbol Place IEEE Pi symbol on the library workspace

              Place IEEE Greater Equal Place IEEE Greater Equal symbol on the library 
workspace

              Place IEEE Open Collector Pull Up Place IEEE Open Collector Pull Up symbol 
on the library workspace

              Place IEEE Open Emitter Place IEEE Open Emitter symbol on the library 
workspace

              Place IEEE Open Emitter Pull Up Place IEEE Open Emitter Pull Up symbol on 
the library workspace

              Place IEEE Digital Signal In Place IEEE Digital Signal In symbol on the library 
workspace



              Place IEEE Invertor Place IEEE Invertor symbol on the library workspace

              Place IEEE Input Output Place IEEE Input Output symbol on the library 
workspace

              Place IEEE Shift Left Place IEEE Shift Left symbol on the library workspace

              Place IEEE Less Equal Place IEEE Less Equal symbol on the library workspace

              Place IEEE Sigma Place IEEE Sigma symbol on the library workspace

              Place IEEE Schmitt Place IEEE Schmitt symbol on the library workspace

              Place IEEE Shift Right Place IEEE Shift Right symbol on the library workspace



Library Tools

              Place Line Place graphical lines on the library workspace

              Place Bezier Place curved lines on the library workspace

              Place Elliptical Arc Place elliptical arcs on the library workspace

              Place Polygon Place graphical polygon shapes on the library workspace

              Place Text Place single line text on the library workspace

              New Component Add a new component to library

              New Part Add a new part to the currently displayed component

              Place Rectangle Place rectangles on the library workspace

              Place Round Rectangle Place round rectangles on the library workspace

              Place Ellipse Place elliptical shapes on the library workspace

              Place Junction Symbol Place a Junction symbol on the library workspace

              Place Graphic Place PCX/BMP/GIF/TIFF/WMF/EPS graphical images on the 
library workspace

              Paste Array Define an array placement of clipboard contents

              Place Pin Place electrical pin on the library workspace



Error Messages

Unrecognized File Format
Too Many Files Open
Text not found
Sector Not Found
Printing Aborted
Print Manager Aborted
Path not found
Out of Memory
Out Of Memory While Printing
Out Of Disk Space While Printing
Orcad STDXTEND.EXE must be in the PATH to Load Orcad 32-bit Binary File
Orcad DECOMP.EXE (Renamed to DECOMP32.EXE) must be in the PATH to Load Orcad 32-
bit Binary Library
Orcad 32To16.EXE must be in the PATH to Load Orcad 32-bit Binary Schematic
Not Enough Memory To Start Application
No selection
No selected pins
No printer found
No more Space For Access Codes
No memory left
No Error Markers Found
No Duplicate Components
Library Must Be Protel Advanced Schematic Format
Invalid OrCAD library file format
Invalid File Handle
Invalid File Access
Invalid Drive
Invalid Code, Please Re-Enter
Incorrect Access Code For Schematic
I/O Error Number : 
Hard Lock Device Not Found
General Error While Printing
File Not Open
File not found
File is Read Only
File Error : 
File Corruption Error
File Access Denied
Feature Not Enabled In This Version
Drive Write Error
Drive Seek Error
Drive Read Error
Drive Not Ready
Disk Is Write Protected
Cannot Switch To Target Application, Multiple Copies of Application Running



Unrecognized File Format

              This message occurs whenever a sheet file or library file Open command encounters an 
unrecognized format. Advanced Schematic will load Protel Schematic, Orcad STD III and 
STD IV sheet files automatically. The Library Editor will load Protel Advanced Schematic 
binary and OrCAD binary formats plus decompiled Protel (DOS) and OrCAD text format 
libraries. Other formats will generate this error message.

See also
Error Messages



Too Many Files Open

              The number of files specified in the FILES= command in your CONFIG.SYS file has 
been exceded. Close one or more files or increase the number of files specified in 
CONFIG.SYS.

See also
Error Messages



Text not found

              In the Text find and replace commands, the text that you specified was not found 
anywhere on the worksheet.

See also
Error Messages



Sector Not Found

              Internal error. Contact Protel for assistance.

See also
Error Messages



Printing Aborted

              You have pressed Cancel in the Print dialog box. Choose the Print command and re-print 
the job, if desired.

See also
Error Messages



Print Manager Aborted

              You have closed the print manager while a job is printing. Choose the Print command 
and re-print the job.

See also
Error Messages



Path not found

              You have specified a path that doesn't exist.

See also
Error Messages



Out of Memory

              While placing items, loading a file or general editing, the program has run out of memory. 
Clear the Undo stack or close other applications to make more memory available. 
Alternatively exit and restart Windows. If none of these options work, then you will need 
to add additional memory to your system to perform this operation.

See also
Error Messages



Out Of Memory While Printing

              The program has run out of memory. Clear the Undo stack or close other applications to 
make more memory available. Alternatively exit and restart Windows. If none of these 
options work, then you will need to add additional memory to your system to perform this 
operation.

See also
Error Messages



Out Of Disk Space While Printing

              When printing to file, sufficient disk space must be available. Either select another drive 
or clear enough disk space for the print file and re-attempt printing.

See also
Error Messages



Orcad STDXTEND.EXE must be in the PATH to Load Orcad 32-bit Binary File

              The DOS memory 32 bit memory utility STDXTEND.EXE is supplied with the OrCAD 
SDT 386-32 Bit system and is used by their 32 bit applications. Make sure that it is in 
your PATH.

See also
Error Messages



Orcad DECOMP.EXE (Renamed to DECOMP32.EXE) must be in the PATH to Load 
Orcad 32-bit Binary Library

              The DOS application DECOMP.EXE is supplied with the OrCAD SDT 386-32 bit system. 
Copy this file to DECOMP32.EXE and make sure that it is in your PATH. This allows 
Advanced Schematic to load both 16 and 32 bit Orcad Libraries.

See also
Error Messages



Orcad 32To16.EXE must be in the PATH to Load Orcad 32-bit Binary Schematic

              The DOS application 32To16.EXE is supplied with the OrCAD SDT 386-32 Bit system. 
Make sure that it is in your PATH. Advanced Schematic needs this utility to load Orcad 
32 bit schematics.

See also
Error Messages



Not Enough Memory To Start Application

              There is not memory and/or resource space to start the application

See also
Error Messages



No selection

              Use the Editcommands or SHIFT+LEFT MOUSE to select some items.

See also
Error Messages



No selected pins

              You have selected Information Selected Pins with no pins currently selected.

See also
Error Messages



No printer found

              You must selected a windows printer in File Plot/Print before choosing Generate Prints. 
Use Window Control Panel to install printers.

See also
Error Messages



No more Space For Access Codes

              Only 40 access codes can be added at one time

See also
Error Messages



No memory left

              While placing items, loading a file or general editing, the program has run out of memory. 
Clear the Undo stack or close other applications to make more memory available. 
Alternatively exit and restart Windows. If none of these options work, then you will need 
to add some more memory.

See also
Error Messages



No Error Markers Found

              The Jump to error markers command could not find any error markers in the current 
sheet. Use File:Reports:ERC to find errors.

See also
Error Messages



No Duplicate Components

              Remove Duplicates command has not found any duplicate components in the library.

See also
Error Messages



Library Must Be Protel Advanced Schematic Format

              The library file which you have tried to load, merge or Add to the libaray list, is not saved 
in a valid Protel or Orcad format. It may not be the right file (a Protel Schematic file for 
example) or it may have been damaged. If it is damaged, then you    will have to resort to 
a back-up version.

See also
Error Messages



Invalid OrCAD library file format

              The library file which you have tried to load or merge from (extension SRC) is not saved 
in a valid Orcad ASCII (decompiled) format. It may not be the right file (an Orcad file for 
example) or it may have been damaged. If this occurs, try loading the file in LIB (OrCAD 
binary) format. Advanced Schematic will perform the de-compilation automatically in this 
case. If the library has been succesfully Decompiled but still generates this error, then 
you should used the Orcad utility CONVERT.EXE to convert it to 16 bit before loading it 
into Library Editor.

See also
Error Messages



Invalid File Handle

              Internal error. Contact Protel for assistance.

See also
Error Messages



Invalid File Access

              Internal error. Contact Protel for assistance.

See also
Error Messages



Invalid Drive

              The requested drive is not recognized by the system. Please specify the correct drive.

See also
Error Messages



Invalid Code, Please Re-Enter

              You have entered an access code with an incorrect format. Correct format is four 
hexadecimal characters, followed by a hyphen (-) and four additional hexadecimal 
characters. Be sure that you type zero (0) and not the letter "O" where it appears in the 
code sequences.

See also
Error Messages



Incorrect Access Code For Schematic

              You have attempted to run this module without having typed the correct access code into 
the Set Acces Codes dialog box. To open this dialog box, choose the Help About 
command and click Set Access Codes. Carefully type the correct code into the box for 
this module and press Test to verify each code. Be careful to type zero (0) and not the 
letter "O" where it appears in the code sequences.

See also
Error Messages



I/O Error Number : 

              Internal error. Note the error message/number and contact Protel for assistance.

See also
Error Messages



Hard Lock Device Not Found

              You have attempted to run a protected Protel for Windows application without having first 
connected the external security device supplied with the system. Make sure that the 
device is properly connected to a parallel port and re-start Protel for Windows. If this is 
unsuccessful, the device may be either damaged or defective. In this case, contact your 
Protel representative for assistance. Warning: incorrect connection may damage the 
device -- make sure that the device is connected to a parallel, not serial port, with the 
"arrow" pointing toward the printer.

See also
Error Messages



General Error While Printing

              Communication with the printer has been interrupted. Check the printer connections, 
cabling, etc. and retry.

See also
Error Messages



File Not Open

              Internal error. Contact Protel for assistance.

See also
Error Messages



File not found

              The file name selected could not be found.

See also
Error Messages



File is Read Only

              You are trying to save to a file that is Read Only. Either change the files attributes or use 
Save As to write to a new file name.

See also
Error Messages



File Error : 

              Internal error. Note the error message/number and contact Protel for assistance.

See also
Error Messages



File Corruption Error

              The Schematic worksheet file which you have tried to load from (extension ASC) 
contains text which does not conform to the Protel Schematic file format. This error 
indicates that the program recognized the file as a valid schematic file, but then while 
actually loading it, some part of it was invalid. If you have been editing the file manually 
(with a text editor) then see the manual for more information or contact Protel Technical 
support. Or , if the file is a foriegn format, OrCAD for example, it may contain elements 
that are not recognised by the Protel loader.

See also
Error Messages



File Access Denied

              The file you are attempting to open is either currently in use or you are attempting to 
write to a read-only file.

See also
Error Messages



Feature Not Enabled In This Version

              This feature is not available in the the currently installed version.

See also
Error Messages



Drive Write Error

              The requested drive or file cannot be accessed. Make sure that the correct drive has 
been specified.

See also
Error Messages



Drive Seek Error

              The requested drive or file cannot be accessed. Make sure that the correct drive has 
been specified.

See also
Error Messages



Drive Read Error

              The requested drive or file cannot be accessed. Make sure that the correct drive has 
been specified.

See also
Error Messages



Drive Not Ready

              The requested drive is not available or responding. Make sure that the correct drive has 
been specified.

See also
Error Messages



Disk Is Write Protected

              The diskette is write protected. Remove or open the write protect tab.

See also
Error Messages



Cannot Switch To Target Application, Multiple Copies of Application Running

              For inter-application communications, multiple target copies create ambiguities. This can 
occur from Place Component from the library editor, Edit component from Schematic and 
cross probing from any application.

See also
Error Messages





Using Schematic Library Editor Help

This on-line guide provides an introduction to the Advanced Schematic Library Editor 
application, including many of the features, key concepts and terminology used throughout the 
system. A separate on-line help system is maintained for the Advanced Schematic application. 
The guide is intended to provide the general information you need to get up and running with 
the system and to learn to use the basic features required to design a circuit, generate a netlist 
and print artwork. Detailed information can be found in your Advanced Schematic 
documentation, including the Protel for Windows Environment Guide, Advanced Schematic 
User Guide, Schematic Editor Reference and Library Editor Reference.

Help methods

There are three methods for using On-line Help.

        1. You can run the Help application and switch to Help, as needed, using the Contents and 
Search facilities to browse the available topics.

        2. A second, powerful way to use help is to use context sensitivity. By default the F1 key is linked 
to the Help system. When you are running Advanced Schematic, pressing F1 will open the 
relevent topic when you are in placement mode or when a menu is selected.

        3. You can press the Help button in most dialog boxes. This will run context sensitive help for that 
dialog.

System overview
Assumptions made by this guide



System overview

Advanced Schematic includes two independent applications: the Schematic Editor and the 
Schematic Library Editor.

Advanced Schematic can generate single sheet, multiple sheet and fully hierarchical designs 
of virtually any size, limited only by the available memory and storage capacity of your system. 
Sheet sizes include A, B, C, D, E (or metric sizes A4-A0) plus user-defined sheets of up to 65 
inches square. Standard component libraries include over 15,000 parts, with standard ANSI, 
DeMorgan and IEEE display options (where applicable). 

Schematic Editor
Schematic Library Editor



Schematic Editor

The Schematic Editor is the primary Advanced Schematic application. This application allows 
the user to create, edit, check and print the sheet files that comprise a design project. All the 
tools and utilities needed to generate valid netlists, design reports and presentation quality 
schematic drawings are integrated into the Schematic Editor application. 

Open and view as many sheets and design files as desired. Any number of Advanced 
Schematic sheets can be opened in their own windows, limited only by available memory. Run 
multiple Windows (and Windows-compatible DOS) applications. Switch between sheets, files 
and applications with a click of the mouse.



Schematic Library Editor

The Library Editor is an independent application used to create, edit and manage parts 
libraries and their components. You can run the Schematic Editor concurrently with the Library 
Editor with special links that allow you to move conveniently back and forth between the two 
applications. The Schematic Library Editor includes many of the features of the Schematic 
Editor application, plus specialized tools and features for component part creation and library 
management.



File, Netlist and output format options

Advanced Schematic loads OrCAD SDT and Protel-Schematic (DOS version 3.3) files, along 
with Advanced Schematic files. Translation of imported drawings is 100% and full support is 
provided for all Protel and OrCAD SDT design objects and functions. De-compiled OrCAD 
SDT libraries (and Protel-Schematic (DOS) libraries) can be translated into Advanced 
Schematic format, as well. A large number of netlist output formats are supported. Windows 3 
features support for many output devices including dot matrix printers, PostScript printers and 
imagesetters, as well as plotters of many different types. 



About editing

Attributes can be edited by double-clicking directly on the item to open a dialog box. In 
Advanced Schematic, changes can be globally applied across an entire design using specific 
conditions to define the targets. For example, when editing wires you can change the color or 
wire size or both attributes. These changes can be globally applied to other wires on the 
sheet, or to other open sheets. Similar global options are provided for components and other 
objects.



About Libraries

Advanced Schematic includes a powerful system for managing schematic component 
libraries. Any number of part libraries can be opened and accessed simultaneously while you 
create your drawings. Comprehensive standard manufacturer libraries are included with Protel 
for Windows. Components can be browsed and placed directly from the independent 
Schematic Library Editor application. Simultaneous multi-user library access is supported for 
network installations.



Array placement options

Linear array placement allows automated step-and-repeat placement of objects in the sheet. 
This can include individual objects or complex selections of objects. The users can specify the 
number of repeats and set pre-defined x and y offsets, and text increments.

See also
Using the clipboard
Place Array command



Windows support for printing and plotting

Dot matrix and laser printing, color printing, pen plotting and PostScript output are all 
controlled from a common Print command. Any device supported by Windows can be 
selected. Advanced Schematic graphical design tools support the production of presentation 
quality artwork. 

Windows display options



Windows display options

Protel for Windows makes full use of all standard and 24 bit color graphics cards and monitors 
supported under Windows 3. On standard graphics adapters such as VGA, dithering can be 
used to simulate colors beyond the standard 20 Windows solid tones. Over 700 pre-defined 
standard colors on a special palette are provided, along with the ability to define custom 
colors. Protel for Windows makes full use of the Windows graphical environment, allowing the 
user to place TrueType fonts, place bitmap and vector graphics images and to assign colors 
independently to all display items.



Assumptions made by this guide

The documentation makes four assumptions about Advanced Schematic users:

        1. That users have a sound knowledge of the principles and terminology of schematic design and 
capture;

        2. That users are familiar with Windows 3 icons, menus, windows and using the mouse to make 
selections.

        3. That users have a basic understanding about how Windows manages applications (programs 
and utilities) and documents (data files) to perform routine tasks such as starting applications, 
opening documents and saving work. If you are new to Windows, please start with your 
Microsoft Windows 3.0 User's Guide.

        4. That users have a basic understanding of Microsoft DOS and its use of directories, file naming 
conventions, etc. 



Protel for Windows Environment Guide

The Protel for Windows design system currently includes printed circuit board layout, PCB 
design automation and schematic design applications. The Protel for Windows Environment 
Guide, delivered with your Advanced Schematic package, provides an overview of the Protel 
for Windows design environment, including many of the features and concepts used 
throughout the various modules of the system. It provides step-by-step instructions for 
installing PfW software, some applicable Windows fundamentals and information regarding 
technical support and product upgrades.



Advanced Schematic User Guide

The User Guide is designed to guide the new user through the many features of Advanced 
Schematic. It includes general coverage of the basic principles used througout the Advanced 
Schematic system, including concepts and an introduction to Advanced Schematic objects, 
tools and processes.



Advanced Schematic Reference

The Schematic Editor Reference includes detailed descriptions for each tool, command and 
dialog box option available in the Schematic Editor application. A comprehensive Index is 
included, making it easy to search for specific information, either by topic or by key word.

Menus and commands
Data Primitives
Hot Keys
Tool Bars
Menus
Error Messages



Schematic Library Editor Reference

The Schematic Library Editor is a separate Windows application used to create and edit and 
manage the contents of schematic parts libraries. The Library Editor has many of the same 
features as the main Advanced Schematic application, plus additional features for component 
editing. The Schematic Library Editor Reference provides detailed descriptions for the design 
objects, menu commands and dialog box options used with Library Editor, in a convenient 
separate volume.



The Advanced Schematic component model

In Advanced Schematic, component parts are organized into libraries that correspond to 
manufacturer data books.

Each component name in the library is associated with one or more component parts 
descriptions that become the representation of the component on the schematic sheet.

Because components can have multiple devices (e.g., the individual gates in TTL logic 
components), it is extremely convenient to be able to work with each part of a multi-part 
component individually while laying out the design.



Libraries of component models

While an image of the component part is "placed" into the schematic, the component 
information is always stored in the library. Component creation and editing are always 
performed at the library level, not on the sheet. This approach maintains library integrity and 
allows library changes to be used to globally update components in existing designs.

As parts are placed in sheets, a back-up image of each component is placed in a special 
cache, attached to each sheet file. This back-up library allows the user to distribute the 
schematic sheet files without having to supply the complete set of libraries used to create the 
design. The back-up library also allows the user to generate a permanent project library for the 
design. The component images stored in the back-up library can be updated by the source 
libraries, each time the sheet is loaded in the Schematic Editor.



Connectivity

Connectivity refers to a special feature of the Advanced Schematic environment -- the ability of 
the software to recognize the physical connections between certain electrical design objects 
inside the sheet and the ability to associate the logical connections that exist between various 
sheets in a multi-sheet design. Connectivity is also used to "anchor" objects together when 
wiring the circuit. For example, you can reposition a part in the sheet and any attached wires 
will drag with the part as it is moved. 

Most importantly, connectivity allows the schematic to perform netlisting and electrical rules 
checks.



Generating reports

Library Editor tools include two report generators which produce ASCII format text files:

Component report process
Library report process



Opening library files

In the Schematic Library Editor you can load any number of library files, using the Multiple 
Document Interface (MDI). Advanced Schematic will load the following formats: Advanced 
Schematic (text and binary formats); Protel Schematic (DOS version 3) .SRC (de-compiled) 
and OrCAD binary or .SRC (de-compiled) files.

When no open document (file) is displayed, the Menu bar displays three options: File, Info and 
Help. The Open Sheet File dialog box will display the current directory and any library files 
with the (default) Advanced Schematic file extension of .LIB. You can change the extension to 
filter the directory contents. For example, typing "*.*" in the File Name box will display all files 
in the current directory. 

Advanced Schematic allows the use of user-defined filenames (to the DOS limit of 8 
characters) and (optional) extensions of up to 3 characters. Extension use is unrestricted -- 
any extension can be used for schematic sheet files.

File Open process
Protel (DOS) library conversion



Save and Save All commands

        Save Edit Save updates the open library file, saving in the default (.LIB) binary format.

        Save All The Edit Save All command extends this concept, updating all open library files.

All libraries will be saved in the default (.LIB) binary format.

File Save process
File Save All process



Library and component management

In order to manage and use Advanced Schematic libraries efficiently, it is important that users 
understand the relationship between libraries, the component names used to access libraries 
and parts, which are the physical representations of components (symbols), placed in 
schematic sheets.

The Schematic Library Editor is an independent application for creating or modifying 
component parts and managing and editing libraries. Under Windows, the Schematic Editor 
and Library can be run simultaneously -- including multiple instances of either application, 
memory permitting. While the Schematic Editor and Library Editor run independently, special 
features provide convenient links between the two applications. For example, you can move 
directly from a part symbol in the sheet -- to editing its component information inside the 
source library.

Basic library concepts
Management of libraries
Schematic Library Editor
Component Browser panel



Advanced Schematic Libraries

Advanced Schematic libraries consist of component descriptions, represented by the 
individual part symbols that are placed in schematic sheets. Components can have one or 
many parts or subparts (e.g., the gates that comprise a multi-part component like a 74LS00 in 
the TTL library). The term component always refers to its complete library description -- either 
a specific manufacturer data book entity or a generic device (e.g., resistor, capacitor, diode, 
led, etc.). 

Many components share the same packaging -- they have identical graphical depictions, but 
exist as individual names in libraries. Perhaps these are identical devices from different 
manufacturers, or components that share the same packages but vary on some specification, 
such as a 120ns versus 80ns RAMs. While it is convenient to access these otherwise 
duplicate parts using either description, it would be wasteful to create and store a separate 
graphical version of each item.

Advanced Schematic uses the concept of component groups to associate multiple component 
names with a single description stored in the library. This keeps libraries efficient and 
manageable. For example, while the TTL library contains nearly 1800 component names, the 
graphical and data descriptions that represent these components number only about six 
hundred.

When a component part is placed in a schematic sheet, the displayed version of the part is a 
representation of the library version only. The actual component exists only in the library. This 
means that components and their parts are changed or edited only at the library level -- never 
at the sheet level. Library level changes are globally applied to each instance of a part when a 
sheet is loaded. 

This principle maintains strict data integrity in parts libraries and has been adopted by 
Advanced Schematic as the preferred model for most engineering environments, particularly 
where common libraries are shared by multiple users.

To allow for flexible use of library components, a special cache library is maintained for the 
current project. Any components used in a sheet are appended to the sheet file, each time the 
sheet is saved. This file includes a "read only" version of the library component for each part in 
the sheet. The user can protect the backup library, so that it will not be updated from libraries 
when the sheet is re-loaded. The backup library allows users to exchange or supply schematic 
sheet files, without having to distribute all of the component libraries used to create the design.

Component management
Component models
Management of libraries
Schematic Library Editor
Component Browser panel



Part information in the sheet file

While the component description is stored in the library, information is added to the sheet, at 
each instance when a part is placed. For example, the designator (or label) for each 
placement is part of the sheet, not a library attribute. Other sheet level attributes include 
information about the components position in the sheet, orientation, color assignments, 8 user-
definable text fields, etc.

At the same time that the part is placed in any project sheet, the library component information 
for the part is added to a cache. As individual sheet files are saved, the cache information is 
used to create a backup library in the sheet.

Components are grouped in libraries, by the component type or manufacturer, for 
convenience.



Components

Each component library consists of three general types of data:

        Graphical representations of each component part;

        The descriptions of component, including component text fields and other attributes;

        A separate listing of component names associated with the component attributes and 
graphics.



Graphical representation of components

Parts are graphical representations of components, component devices, logic and generic 
devices. Some components are represented by a single part, such a resisters or diodes, etc. 
Other components are represented by multiple parts for example, TTL logic components that 
include multiple gates. In Advanced Schematic, you place each of these parts independently. 

Depending upon the component, parts can be displayed using standard ANSI schematic 
notation, the DeMorgan equivalent (for gates) and IEEE standard notation.

Component description options



Part graphics

All Advanced Schematic parts use vector graphics. This means that each graphic element in 
parts is defined by its coordinates, line width, etc. -- not by a bitmap array. One key advantage 
of vector graphics is their device independence. This means that vectors can be displayed or 
printed at the highest available resolution -- resulting in smooth arcs and angles, while also 
providing a precision environment for complex graphics. Vector graphics also require less 
memory when displayed and have more compact library records.

Libraries from OrCAD SDT include display bitmap representations and vector information used 
by OrCAD SDT for printing and plotting. Advanced Schematic uses OrCAD vector information 
for both display and output when these libraries are used. 

Libraries from Protel Schematic 3 are bitmap images and do not include vector descriptions. 
When loading Protel Schematic sheets, Advanced Schematic will substitute vector versions of 
any component names that match the names in Advanced Schematic libraries. Other parts, for 
example user-generated parts, may exist as unique bitmaps only. These components will be 
converted to simple vector "block-type" parts when sheets are loaded into Advanced 
Schematic.

Changing objects graphically



IEEE component representations

Many components in the standard Advanced Schematic libraries have IEEE equivalents. 
Protel IEEE versions are not superficial shapes, but complete component descriptions that 
reflect the comprehensive depth of this standard. 

IEEE standards allow a number of alternative expressions of component attributes, and each 
manufacturers data book varies in its presentation of IEEE components. The graphical 
descriptions for IEEE versions are fully user-editable in the Schematic Library Editor, and a 
rich set of IEEE graphical tools are included. Protel's IEEE components were compiled from a 
proprietary natural language environment that yields extremely consistent (and therefore 
useful) representations.

IEEE equivalents can be specified before or after part placement and IEEE versions can be 
globally displayed to some or all parts placed in the current sheet.



DeMorgan logic

This option can be specified before, during or after part placement and if desired these 
equivalents can be globally assigned to some or all logic devices placed in the current sheet.



Parts of a component

Along with graphical depictions, libraries store a number of other component attributes. These 
attributes are all editable at the library level only -- not after parts are placed in schematic 
sheets.



Text fields

Each library component has 8 user definable text fields. These fields can hold up to 255 
characters. Library text fields cannot be edited from placed parts in schematic sheet files, but 
can be included in custom Bill of Materials reports.

In addition to the 8 library component text fields, 8 additional user-definable fields are available 
for each part, at the sheet level. These fields can be displayed or hidden (click Hidden Fields 
in the Change Component dialog box) and are editable in the sheet, with user definable fonts, 
sizes and colors. These fields can be up to 255 characters long and are available for Bill of 
Materials reports.

Component description options



Footprint

Four fields are provided for naming PCB footprint patterns for the component. The first field is 
the default value and will be used in (Protel format) netlist generation. Four fields allow the 
user to nominate alternate patterns for SMD versions, etc.

Component description options



Description

A description field of up to 255 characters is provided for part value or similar information. This 
field is displayed in the component browser when placing parts in the Schematic Editor and 
can be included in custom Bill of Materials reports.

Component description options



Default designator

A default designator prefix can be stored with each library item. When components are placed, 
designators will automatically include this prefix.

Component description options



Subparts

Multi-device components include graphical descriptions for each subpart. Each can be 
independently modified in the Schematic Library Editor.

New Part process
Remove Part process
Previous Part process
Next Part process
Show Normal version
Show DeMorgan version



Pins

Component pins are independent electrical objects. Inside the Schematic Library Editor, the 
user can define pin names and numbers for each component part. 

There are no restrictions of pin placement relative to other component graphics -- pins need 
not be placed in any particular order nor in contact with any other component graphic 
elements (body, etc.) to be functional.

Place Pins process
Toggle Hidden Pins process



Hidden pins

Any pin can be defined as hidden. Normally, hidden pins are used for component power nets. 
These pins are deemed to be connected to the named power nets during netlisting, assuming 
that power nets with matching labels are available on the sheet. Components vary in their 
identification of power nets and it is common for labels such as VCC, PWR,    +5, etc., to be 
used interchangeably. One way to avoid missing nets is to wire variously named equivalent 
power ports together somewhere on the schematic sheet, to avoid missing hidden (and 
therefor overlooked) power nets. When pins are displayed, they are always deemed to be un-
connected and it is assumed that the user will connect these pins manually.

The Hide/Display status of all hidden pins on a part can be changed at any time. Any pin can 
be defined as hidden in the Library Editor. Normally, hidden pins are used for component 
power nets. When hidden, these pins are deemed to be connected to the named power nets 
during netlisting, assuming that power nets with matching labels are available on the sheet. 
Once displayed, pins are deemed to be un-connected until the user connects them manually.

Place Pins process
Toggle Hidden Pins process

See also
Local hidden pins



Parts on sheet

When parts are placed in schematic sheets, a number of additional attributes are available for 
editing. These attributes are associated with the specific instance of the part in the sheet only 
-- they are not library attributes. To change any part, double-click on the placed part or use the 
Edit Change command. Each editable attribute can be globally edited, which changes applied 
to some, or all of the parts on the sheet.

Place (part) process



Part type

A part type text field is provided for component part names. This field can be up to 255 
characters long and is available for Bill of Materials reports.

Component description options



Designator

Part designators can have their prefix default predefined in the Library Editor (see Default 
designator, above). The user can override this default manually, when placing or editing parts 
in the sheet. If no initial numeric value is defined for a designator prefix, it will be placed as U?, 
R?, etc. Once a numeric value is used, designators will automatically increment to the next 
digit: U1, U2, etc. Complex cases for multi-device components are also supported, yielding: 
U1:1, U1:2, U2:1, U2:2, etc. Alpha a numeric designation is allowed. The File Annotate 
command automatically re-numbers all designators in a project.



Part number

A special text field is reserved for part numbers. This field can be up to 255 characters long 
and is available for Bill of Materials reports.

Component description options



Library name

This field identifies the source library for the component. It is user-editable at the sheet level 
and can be included in custom Bill of Materials reports.

Component description options



Colors

Part outline, pin color and (in many parts) fill colors are user selectable attributes. If parts are 
un-filled, changes made to this field will be ignored. Default colors can be assigned to each 
part at the library editor level, but these assignments can be overridden when editing placed 
parts. To apply the local (rather than default library) color, click Local Colors in the Change 
component dialog box.



About component text

Part text fields are created and stored at both the library level (when the part is defined) and at 
the sheet level when the part is placed. These text fields can be up to 255 characters long.

Be aware that the length of fields used in netlists: designator (label) type (description) and package (footprint 
or decal) may be limited, may not support (empty) spaces and may be case sensitive. 

The designator, type description and other text fields created at placement can be either 
hidden or displayed and can independently moved/rotated. Displayed text supports any 
TrueType font, with user-definable size (in points), style and color. Eight text fields are 
available when creating component parts in the Schematic Library Editor. These fields cannot 
be displayed in sheet files, but can be included in expanded format Bill of Materials reports.

Component description options



Opening libraries

The Library Add/Remove command    (shortcut: L, A) in the Schematic Editor is used to add 
libraries to the current open list in the Library Browser. There is no fixed limit on the number of 
libraries that can be opened concurrently.

Opening libraries is a pre-requisite to opening OrCAD files that have not been previously 
saved in Advanced Schematic format. Because OrCAD files cannot display components 
unless all libraries used in the file are accessible, opening sheet files without first opening 
libraries will result in missing components in the sheet.

File Open process
Basic library concepts



Management of libraries

When a component part is placed in a schematic sheet, the displayed version of the part is 
only a representation of the library version. Components are edited only at the library level. 

Restricting component editing to libraries maintains strict data integrity in parts libraries.

Component cache and backup libraries
Archiving the component cache
Updating sheet parts
Basic library concepts



Component cache and backup libraries

To make library access efficient, a special library cache is created as parts are placed in 
sheets. A single cache is maintained for all opened projects and this cache holds copies of 
components placed in any sheet in each project.

Each time any sheet in the project is saved, the cache is used to generate a backup library. 
This file includes a "read only" version of the library component for each part in the sheet. The 
user can protect the backup library, so that it will not be updated from libraries when the sheet 
is re-loaded. The backup version allows users to supply schematic sheet files, without having 
to distribute their complete component libraries.

It is useful to note that the cache holds copies of all the components currently "in use" in the 
environment. As you open another project, all of its components are copied from the sheet 
back-up libraries into the cache. If you remove sheets or close projects the components in 
those projects are not cleared from the cache. The cache is cleared when you exit the 
Schematic Editor. 

In extreme cases, where many sheets are being loaded during a session, it may be possible to 
fill the cache to the extent where system performance begins to slow. If this happens, save 
your projects, exit the editor and re-start the application.



Archiving the component cache

A benefit of caching is the ability to archive the cache contents into a single project library. 
Because the source libraries may change over time, archiving provides a convenient way of 
being able to work with an accurate version of the project at some future date. The Make 
Project Library (shortcut: L, M) command generates a project library based on the current 
sheet back-up library.

Basic library concepts



Updating

The Library Update All Parts command updates all parts in project sheets to be updated from 
current versions of source component libraries. This command allows changes in current 
source libraries to be globally applied to each instance of a component in an entire project.



Library Menus

Most of the menu commands in Library Editor match the form and function of the same 
commands in the main Advanced Schematic application. Some options are specific to Library 
Editor.

Menu Commands



File menu

NewOpens a new (empty) library file with the default name LIB_1.LIB. Any number of libraries 
can be opened at once, limited only by available memory;

OpenOpens an existing library file. The normal mask and path specifications can be used to 
screen for specific library types, by extension;

MergeOpens a second library and adds all components to the current active library file;

CloseCloses the current library; If the library has not been saved (or saved as) the prompt 
"Save Library before closing?" will be displayed;

SaveSaves the current active library;

Save AsSaves a renamed version of the current active library;

Save AllSaves all open library files;

PrintPrints the content of the current active Library Editor edit workspace;

Report ComponentGenerates an ASCII text file report for the current component description;

Report LibraryGenerates an ASCII text file report for the current library;

ExitQuits the Library Editor application.

Menu Commands



Edit menu

These commands work identically to the same commands in the main Advanced Schematic 
application, applying to library rather than sheet files.

Menu Commands



Place menu

The graphical objects that can be placed from this menu (or from the Drawing toolbar) are 
identical to the same objects in the main Advanced Schematic application. Special Library 
Editor commands include:

        IEEE Symbol Places special IEEE graphical symbols in the current active library window. 
These symbols generally conform to ANSI/IEEE standard 91-1984, although some minor 
modifications have been made to symbol proportions to facilitate on-screen display and 
printing. Symbols can be placed inside or outside the component body (or outline), without 
restriction;

        Pins Places a single component pin in the current active library window. Pins are automatically 
designated, as placed. Pins can be freely placed and do not have to be in direct contact with 
the component body (or outline, as in OrCAD SDT) to be functional;

        Text Places a single line of text, similar to the Place Annotation command in the main Advanced 
Schematic application.

Menu Commands



Component menu

The component menu includes a number of special commands for library editing:

        New component Opens a new, empty component window;

        vAuto Create Opens the Auto Create dialog box. Allows user to create complex components, by 
describing pin parameters;

        Remove component Removes the current component from the current library;

        Rename Component Prompts user to supply a new name for the current component;

        Remove Comp Name Removes a component from the current group;

        Add Component Name Adds a user-specified component name to the current group;

        Copy Component Copies the current component into another library. User is prompted to supply the 
name of the destination library;

        Move Component Moves the current component into another library. User is prompted to supply the 
name of the destination library;

        New Part Adds a subpart to the current component;

        Remove Part Deletes a subpart from the current component;

        Component Next Part/Previous Part -- toggles through the subparts for the current component. 
Next/Previous/First/Last component -- toggles through components in current 
library;

        Show Normal Toggles to Normal representation of part;

        Show DeMorgan Toggles to DeMorgan equivalent representation of part;

        Show IEEE Toggles to IEEE representation of part;

        Description Opens the Component Text Fields dialog box. User can specify a type Description, 
Default Designator (e.g., U? will generate incremented designators U1, U2, etc.), 
Footprint (e.g., decal or pattern) 1-4 (used to specify pattern for netlist), Text Fields 
1-8 (user-definable text, up to 255 characters per field) -- can be added to Bill of 
Materials (expanded format).

Menu Commands



Options Zoom Windows and Help menus

These menus and commands work identically to the main Advanced Schematic application: 
applying to library rather than sheet files.

Menu Commands



Tool buttons

Tool buttons are shortcuts for launching frequently used menu commands. The Schematic 
Library Editor includes a main toolbar, across the top of the workspace and floating toolbars, 
which the user can position anywhere in the workspace. All toolbars can be hidden. Each 
toolbar-launched process is available from menus, if preferred.

        Main toolbar This toolbar include a number of general purpose commands, such as File Open, Print 
and Zoom-In, Zoom-Out and Zoom-Workspace. Other buttons are provided for toggling 
the show/hide status of other toolbars and panels.

        IEEE tools Buttons on the IEEE toolbar provide direct access to IEEE graphical symbols used in 
component creation (Schematic Library Editor).

        Library tools This tool bar includes a special collection of tools used during component creation 
(Schematic Library Editor).

Toggle Main Toolbar process
Toggle Library Toolbar process
Toggle IEEE Toolbar process



Library Editor panel

All component editing is performed at the library level. To change an existing component, or to 
add a new component to an existing library, you must first open that library from the Library 
Editor. 

Opening a library is similar to opening a sheet file in the main Advanced Schematic 
application. Libraries can be loaded from Advanced Schematic, OrCAD SDT (in de-
compiled .SRC format), or Protel Schematic 3.x (.LIB binary format). 

The File New command (shortcut: F, N), opens an empty library named LIB_1.LIB. If the File 
New command is repeated, a second library named LIB_2.LIB will be opened, etc. Each 
library will open in its own window, with the library name displayed in the Title Bar. If you save 
a library in Protel (ASCII) text format, the default extension .ASC is used. Loading and saving 
of libraries is independent of the file extension used. Users are free to use any extension of up 
to three non-reserved characters.

Using the Library Editor is a straightforward process of loading a current library (or creating a 
new library file), searching for existing components and editing those components and their 
parts or creating new components from scratch. This process can be accomplished totally 
from within the Library Editor. You can place new components directly into any open sheet 
from the Library Editor.

When a library is loaded, all component names are listed in the Components window. You can 
view component parts (each device included in the component record) by moving the selection 
bar through this list. The four buttons, just below this window allow you to scroll through the 
entire library. The leftmost buttons move up the component list one item at a time; the left 
center button moves to the top of the component list; the right center button moves to the end 
of the list; the rightmost button moves down one component. 

The Group window, to the right, displays the names of other components in the current library 
that share the same component description as the highlighted component name, at left. The 
Add and Delete buttons, just below the Group window are used to add a new component 
name to the current group or delete a component name from the current group.

When a component is deleted from a group, it is removed from the library. 

The Component New Component command (shortcut: ALT C, N) adds a new component 
name, (COMPONENT_1) to the current library. If the command is repeated, a second 
component name, COMPONENT_2 will be added, etc.

Library menus



Creating new components

Components are created in the Library Editor workspace similarly to the same way that 
schematics are created in sheets. The main difference between these two activities is that the 
tools used vary with either task. For example, library components to not incorporate wires, 
buses or sheet entries but they do include pins, which are not placed in the sheet editor.

A component description -- the actual record in the library including the graphical 
representation of one or more component parts -- is independent of the name or group of 
names assigned to that description. It is the complete description that is the library entity, not 
the component name field(s).

When you use the Component New (Component) command, a name is added to the list for 
the current library, irrespective of whether you have created a description for that name. You 
can save even libraries with names of components that are not linked to any description. 
When you load these libraries, choosing these names in the component list box will open an 
empty workspace.

Advanced Schematic components can have any number of pins or parts, restricted only by the 
memory available to handle the individual item. Library workspace, where components are 
graphically created is limited to a "B" size sheet. The user can exercise absolute freedom in 
terms of the placement of pins, vector objects and even graphical objects (including bitmap 
formats). Pins do not have to be in contact with the component "body" as in other systems in 
order to function.

Using imported graphic images in components is allowed, however it is important to note that 
the graphic record is not stored "in" the library -- rather the library entry "points" to the filename 
for the graphic. If the path to the graphic object record file changes, Advanced Schematic may 
not be able to display the item.



Component Description fields

The Component Description command opens a dialog box that allows the user to edit 
additional fields that correspond to the graphical representation of a component's parts. Fields 
include:

        Description This field is provided to assign a name or component type description to the library 
entry. This description is displayed when you use the Library Browser as an aid in 
placing component parts in sheets. The description can be up to 255 characters in 
length and can be included in Bill of Materials reports.

        Default Designator This field is provided to assign a default designator prefix (U?, R?, etc.) to the 
library entry. The designator is numerically incremented as component parts are 
placed in sheets. The description can be up to 255 characters in length and can be 
included in Bill of Materials reports.

        Text fields (8) These fields are provided for any user-defined text, up to 255 characters in length. 
These fields can be used for manufacturer part numbers, house part numbers, 
price or substitution data, specifications, etc. This text is not displayed nor editable 
from the Schematic Editor but can be included in user-defined Bill of Materials 
reports.

        Footprint fields (4) These fields are provided for assigning up to four package description footprints (or 
decals) for the component. This data is used for netlist generation. The first field is 
the default.

        Sheet Part This field allows the user to assign component pin names to nets in other 
hierarchical sheets. The component then operates as though it were a sheet 
symbol, with the pins acting as sheet entries. To connect to the other sheet, ports 
with that sheet name must be present in another sheet in the project.

Component Description options



Component Browser panel

The Component Browser is provided as an aid in searching for, and placing component parts 
into sheets during schematic editing. This panel can be displayed as needed or hidden, to free 
additional workspace.

Library Add/Remove
Adding libraries to the current list



Library Add/Remove

The Library List command is used to add or remove component libraries from a current 
internal list maintained by Advanced Schematic. Holding this list in memory speeds library 
access, when placing parts in schematic sheets. 

When loading OrCAD SDT files, the required libraries must first be loaded into the current 
library list, prior to loading these files, or components will be missing from the sheets. This is 
not true for Advanced Schematic files, which have a cached back-up library of components 
used in the sheet, attached to each file.



Adding libraries to the current list

To add a library to the current library list, choose Library List (shortcut L, L) or click the Library 
List tool button on the main toolbar.

The Library List dialog box opens. Features of this dialog box include:

        Current File List This window lists all currently loaded libraries and is updated as libraries and 
added or removed from the list.

        File Name This window lists the name of the highlighted library from the Files window, described 
below. You can type the desired library name, if known, directly into this window. The 
current path and directory are also shown.

        Files This window lists files in the current directory that match the current file mask used in the 
File Name window. You can use this feature to specify the file type, by extension. 
Advanced Schematic does not restrict the use of extensions to identify library types. 
OrCAD SDT 3/4 libraries (in decompiled .SRC format), Advanced Schematic and Protel 
Schematic 3.x libraries can be loaded.

        Directories This window changes the current path and directory as you search for the desired library.

To add a library to the current list, move the selection bar through the files listed in the Files 
window and click the Add button. The library will be added to the Current File List window. 

To remove a library, move the selection bar through the Current File List and highlight the 
desired library, then click Remove. 

Click OK to close the Library List window and re-set the updated library list.



Configuration

Managing the configuration of your Advanced Schematic installation is covered under the 
following topics:

About Preferences
Workspace options



About Preferences

The Schematic Library Editor stores many user settings, such as printer/plotter setups, display 
colors, and many other options in a special file called LIBEDIT.INI that is automatically added 
to the Windows directory, the first time that you Exit the application. Thereafter, LIBEDIT.INI is 
updated each time you exit the application. When you start Advanced Schematic, the program 
looks for this file and your preferred settings are restored. Other settings belong to a specific 
workfile, such as the current sheet and color assignments used when the schematic file was 
created. When you re-load any schematic file, these settings are restored. If you select File 
New, the normal system defaults or (where applicable) user preferences are restored.

Managing Preferences

You can restore all original (system) default settings by deleting the LIBEDIT.INI file from the 
Windows directory. You can keep more than one .INI file (with different settings for different 
types of projects) by temporarily re-naming the file, or by moving it into another directory. For 
example, you might wish to create a directory that includes all documents for a project with a 
special .INI file.

Workspace options



Workspace options

The Options Preferences command is used to set-up the workspace design environment.

Options dialog box
Workspace colors
Saving default settings
Auto Backup
Grid options
Cursor options
Setup Hot Keys process



Workspace colors

Colors can be assigned to workspace display elements. 

The Options Preferences dialog box is used to assign colors to selections and the visible grid. 
These assignments are saved as system defaults in the LIBEDIT.INI files.

Workspace options



Library Editor workspace

The Library Editor environment is very similar to the Schematic Editor. However, the Library 
Editor does not use standard or user defined sheet sizes. A standard library workspace area is 
provided. This is equal to a "B" size sheet and can be oriented in either landscape or portrait 
orientation. You can print the current contents of the Library workspace(s), using the File Print 
command.

Workspace options



Coordinate system

To provide an absolute spatial reference as you work in the Schematic Editor and Library 
Editor, a coordinate system is linked to the workspace cursor and to the reference point of 
each placed object.

Coordinates are displayed at the left end of the status bar and in each object's Change dialog 
box. Some object Change dialogs list coordinates for individual vector or control points.

Each coordinate unit is equal to .01 inch (.254 mm). The absolute 0,0 coordinate or workspace 
origin is at the extreme lower left corner of the sheet (or Library Editor workspace). The range 
of coordinate units is 0-6500.

OrCAD SDT and Protel (DOS) Schematic origins are located at the top left corner of the 
workspace. Objects coordinate from these systems are converted in Advanced Schematic 
units, when the files are opened.

Toggle Snap Grid process
Toggle Visible Grid process



Workspace navigation

This section describes how processes and process launchers allow easy navigation of the 
Library Editor workspace.

Search For String
Jump to Origin



Search For String

The Edit Search For command allows you to conveniently locate a specific text string without 
having to zoom, pan or scroll through multiple screens

        String Type the target string in the Jump to String dialog box.

The cursor will jump to the named string. This option works with free text strings only -- not 
component text strings. The system will perform three searches:

First -- for a string that matches the specified string in both case, characters and length;

Then -- for a string with same characters and length but ignoring case;

Finally -- for a string with a partial character match (and ignoring case). 

For example, typing "Component" would find the string "Component" first. If no match is found 
it would next find the string "CompONENT" and finally "CompONENTs." When the string is 
found, the cursor will be relocated to the specified string.

With all of these options, Advanced Schematic will only re-draw the screen if the search target 
is off the present screen. When a re-draw is needed, the target will be centered in the active 
window.



Jump to Origin

        Jump to Origin Jumps to the absolute (0,0) coordinate. In the Advanced Schematic system, this is the 
lower-left corner of the workspace (see "Setting a new origin," below).



Changing your view of the workspace

As you click to move from document window (workspace) to window, you are moving the focus 
of the Windows environment. This also happens when you click in another application window 
to make that application active. The current focus determines the way that Advanced 
Schematic tools and features affect your design. One example is the way the current window 
is affected by scroll bars, panning and zooming.

Scrolling
Auto Pan
Zoom commands
Interrupting screen re-draws
Special navigation keys



Scrolling

Note the shaded bars along the right and bottom sides of the sheet window. Mouse users can 
use scroll bars to move horizontally or vertically in document windows. The position of the 
scroll box in the scroll bar indicates the relative position of the displayed portion of the 
document inside window. Drag the buttons to scroll in real time. Click over or under the button 
in the shaded area to scroll the visible portion of the screen with each click. Finally, click the 
arrow buttons at the end of the scroll bar to scroll one unit at a time. You can hide or display 
toolbars by using the Options Scroll Bars command.

Whenever the document window is sized to display the entire sheet (or library workspace), the 
scroll bars are automatically hidden, to provide a wider viewing area. 



Auto Pan

When the Options Preferences Auto Pan feature is enabled, your view of the current window 
will automatically pan up-down-left-right as you place, move or draw objects in the sheet. 
Panning takes place when the cursor reaches the edge of the display when placing, moving or 
re-sizing objects.

About Preferences



Zoom commands

The Zoom menu commands (and associated shortcuts) also affect your view of the current 
sheet window. You can set the zoom to view the entire sheet (up to 65 inches square) or zoom 
all the way in, to about a 4X magnification.

The Zoom command takes advantage of an 8087 (or equivalent) numeric co-processor, if 
present in your system. In some modes, zooming will be faster if you have an add-in co-
processor or a 486DX system.

Three zoom command shortcuts are provided: Pressing pgup    increases the screen 
magnification to the next highest level. Pressing pgdn will decrease the magnification to the 
next lowest level. Pressing SHIFT+PGUP will increase magnification in 0.1 increments; 
SHIFT+PGDN will decrease magnification the same amount. SHIFT+PGUP will zoom to the highest 
magnification; ctrl+pgdn is equivalent to Zoom All.

Menu Commands



Interrupting screen re-draws

Whenever you change the size and/or position of your view of the screen, the contents of the 
workspace will be re-drawn to reflect the change. You can terminate the re-drawing process by 
pressing SPACEBAR anytime when the re-draw is in progress. This saves time whenever you 
wish to immediately scroll or zoom again, without waiting for the re-draw to complete.



Special navigation keys

        PGUP Equivalent to the Zoom In command. Press SHIFT to Zoom at smaller intervals.

        PGDN Equivalent to the Zoom Out command. Press SHIFT to Zoom at smaller intervals.

        HOME Re-centers the screen at the current cursor position.

        END Re-draws the screen at the current cursor position.

        Arrow keys Control the cursor, alternative to using the mouse. Once click moves the cursor one snap 
grid unit (default is .10 inch). 

        SHIFT + arrows Move cursor at 10X snap grid units per click.



Cursor control

The cursor is the special pointing object that allows you to navigate Windows and Windows 
applications. When running Advanced Schematic, two basic cursor types are provided:

Windows cursor
Workspace cursor



Windows cursor

The familiar "pointer" cursor is used for all standard Windows operations, such as choosing 
from menus and dialog boxes. This cursor shape is automatically selected when the edge of 
the document window (workspace) is crossed, as when re-sizing the window, making menu, 
dialog box or toolbar selections.



Workspace cursor

Inside the workspace, the pointer (Windows) cursor changes to perform object placements 
and editing. This cursor operates on a gridded system, snapping from grid point to grid point, 
when Options Snap grid is toggled "on." The workspace cursor will cause the display to pan 
left/right/up/down when the edge of the workspace is contacted -- as when moving or re-sizing 
an object. Auto Pan can be enabled/disabled in the Options Preferences dialog box. This 
dialog box also provides three workspace cursor options:

        Large 90 This is a "bombsight" style cursor, useful for aligning placed or drawn object with other 
items in the sheet;

        Small 90 This is the default shape, a small cross with 90 degree orientation;

        Small 45 This shape is similar to the Small 90 option, but is oriented at 45 degrees. 



Grids

Advanced schematic provides reference coordinate units of .01 inch. These X and Y 
coordinates are displayed at the left end of the Status line. As you move the cursor inside the 
sheet, the coordinate display updates constantly to show your position. As an aid in accurately 
sizing and positioning objects in sheets, two grid systems are provided:

Snap grid
Visible grid



Snap grid

The snap grid defines an array of points in the workspace that restrict cursor movement and 
the placement of electrical design objects. When using the mouse to control the cursor, you 
will notice that the cursor moves freely between snap grid points unless you are using the 
mouse to place or move a selection. When the cursor keys are used, the cursor always 
"snaps" to the grid. The default Advanced Schematic grid is 10 units (1/10 inch or 2.54 mm). 
Users can specify a grid from 1 (1/100 inch or .254 mm) to 100 units (1 inch or 25.4 mm).

If you are using the cursor keys to move the cursor, you will find that Choosing SHIFT and a 
cursor key makes the cursor jump move 10 snap grid points for each click.

Toggle Snap Grid process



Visible grid

A visible grid is provided as a visual reference for placing and moving items. The grid can be 
toggled between display and hide.

The default visible grid is 10 units (1/10 inch or 2.54 mm). Users can specify a grid from 1 
(1/100 inch or .254 mm) to 100 units (1 inch or 25.4 mm).

Options include (default) line grid and dot visible grid. These grids are displayed using the Grid 
color assignment in the top of the dialog box. 

Toggle Visible Grid process



Processes

The Advanced Schematic environment, whether creating and editing sheets, or working in the 
Library Editor, consists of two basic types of elements: objects (or primitives) that describe the 
data in a design and processes, which are used by the system or the user to create, modify, 
save and report on the data objects. Objects include the sheet workspace, components, pins, 
wires, lines, graphical images, etc. Processes include menu commands and other discrete 
processes that manipulate data, such as report generators. 

Various methods of launching these processes are provided. For a detailed description of 
each menu command or other process, go to Processes and click on the process name.

Process launchers



Process launchers

A process launcher is any method that the user can access to invoke a process. Various 
methods are provided:

Menus
Tool buttons
Dialog box options
Mouse and keyboard
Toolbars
Hot keys



Menus and commands

Menus provide access to all commands. Advanced Schematic menu commands are organized 
to be as consistent with the Windows model as possible. This means that standardized 
operations, such as opening and saving files, printing or using standardized Windows editing 
operations such as Cut or Paste is handled in Advanced Schematic using the same methods 
that other Windows applications use. This makes an application more productive in an 
integrated environment where the typical user is working with a number of Windows 
applications. Some processes exist outside the menu command structure. These processes 
include items like poping-up menus or placing a component from the Browser dialog box. All 
processes can be assigned to key stroke combinations, using the Hot Keys dialog box.

Menu bar



Mouse and keyboard

Many processes are mapped to mouse and/or keyboard sequences. This provides convenient 
shortcuts for frequently used operations. A Hot key editing system allows the user to 
customize hot key assignments. Many generic processes (beyond menu commands) can be 
assigned. A number of default assignments are provided with Advanced Schematic.

For example, pressing P, J allows you to place a junction without having to open the Edit 
menu, then choose the Place and Junction commands. Using the LEFT MOUSE button for 
ENTER and the RIGHT MOUSE button for ESC will allow you to perform many operations 
without using the keyboard. Some keyboard commands provide the only practical way of 
performing an operation when you don't wish to move the mouse in the workspace such as 
choosing a new zoom level while moving a selection. 

If you double-click on any placed item, the Change dialog box for that item will be opened, 
allowing you to edit its attributes.

See also
Hot keys



Menu bar

The Menu bar displays the main menu commands for Advanced Schematic: File, Edit, Place, 
Library, Current, Options, Zoom, Info, Window and Help. Each menu command and dialog box 
option is documented in the Schematic Editor Reference.

Short menus
Pop-up Menus



Short menus

When no files are opened, a short menu bar is available, displaying the File, Library, Info and 
Help menus.



Pop-up Menus

Advanced Schematic includes special default hot key assignments for accessing menu 
commands. For example, pressing E (when the focus is on the application window) will "pop 
up" the Edit menu. This also provides a convenient way to avoid having to press ALT to enter a 
command key sequence. 

Processes are available to launch these and can be hooked to hot keys.



Toolbar

Many Library menu commands (and other processes) can be accessed from toolbars. Many of 
these tool button assignments are shortcuts for Place menu commands.

Place commands are used to create and place an object in a schematic and to create library 
components, which are special collections of objects.    Some objects, e.g., library parts are 
composed of a number of individual primitives or objects that are grouped together and 
manipulated as a single entity.

The Advanced Schematic Reference    and On-line Help system include detailed 
documentation for each tool.

Main tool bars
Library tools
IEEE tools



Main tool bar

The main toolbar, displayed across the top of the Library Editor application window, includes a 
number of general purpose tools. This fixed tool bar cannot be repositioned by the user, 
however it can be displayed or hidden (Options menu).

Toggle Main Toolbar



Library tools

The Library tools palette includes a special selection of general, electrical and graphical tools 
that support library-level component editing, including pins, arrays, text fields, etc.

Toggle Library Toolbar



IEEE tools

Included special graphical objects used when creating or editing IEEE library component 
representations.

All toolbar objects and processes can be accessed from menus, if preferred. This allows the 
user to hide the toolbars (including the Schematic Editor and Library Editor main toolbars), 
freeing additional workspace for editing sheets or components.

Toggle IEEE Toolbar



Hot keys

Advanced Schematic allows users to create custom hot key assignments for processes and 
save these assignments in key shortcut files, which can be saved and loaded for specific jobs.

Key assignments can be assigned to any process, not just the processes that are available 
from menu commands. Key assignments are made from the Options Hot Keys dialog box. 
Options include:

Keys

Process

Current Process

Description

Assign

Load

Save

Defaults

Setup Hot Keys process



Objects in the workspace

Your design is created by placing component parts (groups of objects that are stored as 
individual entities in component libraries) and individual objects (wires, buses, junctions, text, 
etc.) in the workspace. Not all objects are user created or placed. Some, such as Electrical 
Rule Check error markers and Special strings are generated by the system. 

The number of parts and individual objects in a schematic sheet (or project) is limited by 
available memory only (including virtual memory, supported by Windows 386 Enhanced 
mode).

For a detailed description of each data object, go to Data Primitives and click on the object 
name.

Creating objects
Selection
Focusing on objects
Changing Objects



Creating objects

A number of different methods are provided for creating and placing objects. For example, you 
can place individual part any time using the Place Part command or Part tool button.

Object tutorial -- Placing lines
Polyline behavior
Creating other objects



Object tutorial - Placing lines

Object creation is very straightforward in Advanced Schematic. Once you are familiar with a 
few basic concepts, you will be able to create the full range of objects available in the 
Schematic Editor and Library Editor applications. 

To place a line in the current workspace:

        Zoom in on the sheet (press PGUP two or three times) until you can see the visible grid. 
Choose the Line command from the Place menu (shortcut: P, L or click the Line tool 
button);

        The prompt "Select Line Start Point" is displayed on the Status line. Note that the 
Windows, pointer-style cursor changes into a    cross hair shape. This is the workspace 
cursor and is used each time you create or move an object.

        Click LEFT MOUSE (or press ENTER) once to define a start point for the line;

        The prompt "Place Line" is displayed on the status line.

        Drag the line segment in any direction. Click LEFT MOUSE (or press ENTER) to end this 
first segment of the wire;

        Note that the coordinates on the status line change as you move the cursor and the end 
of the line and that the prompt "Place Line" is still displayed.

        Move the cursor to continue with a new line segment, which is extended from the 
existing segment. Click LEFT MOUSE or press ENTER again to define this segment;

        If you make a mistake, you can press BACKSPACE to remove the last line segment. You 
can also press ESC or RIGHT MOUSE to "cancel" the current segment currently being 
placed.

        Click LEFT MOUSE again to end the segmented line;

        Note that "Place Line" is still displayed on the Status line. This allows you to end one 
series of connected lines and then begin a new series of line segments elsewhere in the 
workspace without having to choose the Place Line command again.

Place Line process



Polyline behavior

The segmented line is a single polyline object. If you position the pointer cursor anywhere 
directly over the line and click LEFT MOUSE again the line will change. It will now be 
highlighted (as a dashed line) and at each point where the line changes direction, a small 
square handle is displayed. These handles mark each vertex in the polyline object. If you 
position the cursor directly over the handle and click LEFT MOUSE again, you will be able to 
drag the vertex to a new position and the attached line segments will stretch. Clicking a 
second time anywhere on, or inside the boundary of a polyline object allows you to move the 
object to a new position. Click once again to "release" the focus on the object. You can add 
additional vertices by focusing on a polyline object, clicking on a line segment and pressing 
INSERT. To remove vertices, repeat this action, pressing DELETE. You can also rotate polyline 
objects by pressing SPACEBAR as they are moved.

Every object that has its shape created during placement: wires, buses, non-electrical lines, 
polygons, bezier curves, rectangles, rounded rectangles, arcs and ellipses all share this 
common polyline behavior as they are placed and graphically edited.

See also
Line placement mode
Selection and Focus



Line placement mode

Advanced Schematic provides two line placement modes that can be selected by pressing 
SPACEBAR as you create these items. Options include two orthogonal modes and any angle 
mode.

        Any Angle Allows wire to be placed at any angle;

        90/90 Line Constrains wire placement to horizontal or vertical orientation;

        45/90 Line Constrains wire placement to 0, 45, 90, 135, 180, 225, 270 or 315 degree orientation;



Creating other objects

Other objects are created and placed similarly to wires, buses and lines. These include objects 
like rectangles, polygons and arcs, ellipses and bezier curves. Some objects are predefined, 
such as vias or power ports.

For more information about creating and placing these items, see the Advanced Schematic 
Reference and Library Editor References. For more information about working with objects 
after placement, see the sections on Selection and Modifying Objects, later in this chapter.



Selection and Focus

Focus and selection provide two distinct and independent methods for changing objects in the 
workspace. These two methods distinguish Advanced Schematic from other Windows 
applications where focus and selection are merged in a single operation. For example, other 
applications display graphical editing handles on each item in a selection, although graphical 
editing is limited to one item at a time.

Providing two methods of changing items simplifies the display of selections and provides 
additional control over processes to be performed on individual items and groups. For 
example, you can focus on, and graphically edit a series of selected single items, without 
changing the current selection.

Focusing on a single item
Selection
Moving items
Select and De-select commands
Selection and other Windows commands



Focusing on a single item

When you position the cursor over an item and click LEFT MOUSE it becomes the current 
focus. Only one item can be in focus at a time. This is similar to the way you can change the 
focus in Windows by clicking on an open window to make it active. Inside Advanced 
Schematic sheets, you can tell which object is the current focus, because its graphical editing 
handles, are displayed and the item is displayed in outline form. To move the focus, click on 
another item or click in a clear area of the sheet to release the focus.

Graphical editing
Handles and polyline behavior
Add a vertex or control point
Remove a vertex or control point

See also
Selection and Focus



Graphical editing

When an item is the focus, you can graphically edit its characteristics. For example, you can 
change its size or shape by dragging any of the handles. You can also move the object in 
focus by dragging the center handle (arrows). You can also use the shortcut CTRL+LEFT 
MOUSE to move an item. Finally, the item in focus can be deleted by pressing DELETE. 
Moving and deleting individual items is described in more detail under Moving items, below.

Change (Graphically) process



Handles and polyline behavior

Some design objects have special graphical editing characteristics that derive from their 
polyline behavior. For example, when you place wires, buses or graphical lines, you define a 
vertex each time the wire, bus or line changes directions. These vertices are displayed as 
handles when the item is in focus. These items can have complex shapes (hence "polyline"), 
but can be manipulated (moved, cut, copied, pasted, cleared or deleted) as a single item.

Similarly, polygons have movable vertices and bezier curves have control points which 
function similarly to vertices. 

One key characteristic that all of these objects have in common is the ability to add or delete 
vertices (or in the case of beziers, control points) from a placed item.

Change (Graphically) process



Add a vertex or control point

To add a vertex or control point to a polyline object:

        Click on a polyline object to place it in focus;

        Click on the outline (or anywhere inside a solid object). You can tell that the object is in 
focus, because it will be displayed as an outline, with the graphical editing handles 
visible.

        Move the cursor over any line segment. Click on the segment and press INSERT;

        A handle, representing the new vertex (or control point) will be displayed under the 
cursor.

        Drag the handle to define the shape of the polyline object.

Change (Graphically) process



Remove a vertex or control point

Sometimes you will want to remove a vertex (or control point) handle when reshaping a 
polyline object. To remove a vertex to control point:

        Click on a polyline object to place it in focus;

        Click on the outline (or anywhere inside a solid object). You can tell that the object is in 
focus, because it will be displayed as an outline, with the graphical editing handles 
visible.

        Move the cursor over any handle. Click LEFT MOUSE to grab the handle;

        The handle will be free to move, under the cursor.

        Press DELETE to remove the vertex (or control point).

Change (Graphically) process



Selection

In Advanced Schematic, individual items can be edited one at a time or you can designate 
groups of items to be changed together.

Selection is performed on both individual items and groups of items and is generally used with 
clipboard operations: copy, cut, paste and clear. Selection also works with Advanced 
Schematic's global editing feature, which can apply global edits to selected or unselected 
items only.

Unlike focus, selection does not display an object's graphical editing handles. Items are 
selected, added to a current group of selected items or removed from the current selection 
using a variety of methods. The simplest method is to move the cursor over an individual and 
press SHIFT+LEFT MOUSE. This adds the item to the current selection. Pressing 
SHIFT+LEFT MOUSE again will remove the item from the selection.

Items can be added to (or removed from) the current selection either singly or in groups, using 
both menu commands and mouse/keystroke shortcuts. Once selected, items can be moved, 
grouped, un-grouped, exported to another file, cut, copied, pasted into another window or 
location in the current sheet window or cleared.

Selection and highlighting
Making selections
Selection and Focus
Select and De-select commands
Toggle Selection
Using the clipboard - Cut/Copy/Paste
Moving items
Selection and other Windows commands
Importing selections



Selection and highlighting

When you select an object, its outline color changes from its normal layer color to the 
Selection color (default black) assigned from the Options Preferences dialog box. The item 
remains selected until you remove it from the selection using either the De-select command or 
the SHIFT+LEFT MOUSE shortcut.

Highlighting is related to selection but works within an operation, such as re-routing a wire or 
when generating a netlist. You can see wires highlight during both of these processes. As 
objects highlight, you will notice that highlighted item is not displayed in the Selections color 
but is temporarily outlined in black.

Both selection and highlighting are based on the geometry of objects in the workspace. In 
other words, physically connected items are included in the selection. This allows you to use 
selection to trace the connectivity of your design -- like a "continuity" check as you manually 
route connections and to perform other selection-based operations, such as Cut, Copy or 
Paste. 

Selection is very powerful, but can cause unexpected results, because items remain selected 
until de-selected. Use the Edit De-Select All command (shortcut: x, a) to clear the current 
selection before you begin a "new"process that uses selection. If you forget to de-select, use 
the Edit Undo command to step back to the point of the unintentional result (see below).



Making selections

Selections are made using one of three methods:

        Use direct selection: SHIFT+LEFT MOUSE to add or delete individual items to the 
current selection;

        Use the Edit Select, De-select and Toggle Selection commands to define the objects in a 
selection;

        Use the Change dialog boxes to change the selection status of a single object or of a 
group of objects, by using global editing.

Because items remain selected until they are de-selected, you can combine these methods.

A fourth method achieves the effect of selection without changing the selection status of the 
items involved:

        Choose a process, like the Edit Cut command, then select a single target item for that 
action.

This method, allows you to perform selection-oriented processes on single items, without 
requiring pre-selection.

Using the mouse and keyboard



Direct selection using the mouse and keyboard

Direct selection is the most flexible way to designate one or more items to be moved, copied, 
cut and pasted into a new location or deleted. To select one item at a time:

        Hold down SHIFT and click LEFT MOUSE with the cursor position over an item;

        The item will be re-drawn in the Selection color (see the Options Preferences command). 
You can do this repeatedly, each time adding another item to the current selection.

        If you hear a "beep" or nothing appears to be selected, try zooming in closer (press 
PGUP) and make sure that the cursor is directly over the item you wish to select.

        The Snap to Center option (Options Preferences command) will cause the cursor to 
"snap" to the nearest object, when making the selection. This can make it easier to 
select items from a dense layout, or when zoomed out from the drawing.

        To add another item to the current selection:

        Hold down SHIFT and click LEFT MOUSE over another item;

        To release individual items from the selection:

        Hold down SHIFT and click on any selected item.

        When released, the item will be re-drawn in its original (layer) color. Other selected items 
remain selected until they are either individually released (SHIFT+LEFT MOUSE) or until 
an Edit De-select command is executed.

        You can use the Zoom commands (and hot key shortcuts PGUP and PGDN) at any time 
when making or releasing selections.



Moving items

Items can be moved individually whenever they are the current focus -- that is, whenever you 
position the cursor over an item and click LEFT MOUSE to display an object's graphical 
editing handles. Click again and the object will be free to move. A final click will place the 
object at the cursor position. 

Moving or deleting one object
Moving selections
Rotating selections
What gets moved?
Bring to front, Send to back



Moving or deleting one object

Note: the special Move Handle, illustrated in the User Guide and Reference manuals is 
no longer displayed when objects are in focus.

To move a single object:

        Move the cursor inside the object and click LEFT MOUSE once to focus the item and 
display its handles;

        Move the cursor anywhere inside the object and click LEFT MOUSE again;

        Drag the highlighted object to a new location;

        Note that the status line displays the reference coordinates of the object during the 
move. Items will "snap" to the snap grid during the move. You can rotate or flip most 
objects during this kind of move (see also, Move Selection, below). To rotate an object 
90 degrees press SPACEBAR. To flip the object along its vertical axis, press X. To flip 
the object along its horizontal axis, press Y.

        Click LEFT MOUSE to complete the move. To clear the object from the sheet, simply 
press DELETE while the item is in focus.

        You can click LEFT MOUSE on an empty area of the sheet to remove the focus from the 
object.



Moving selections

The Edit Move Selection command (shortcut: ALT m, s) allows you to move a complex 
selection as a single entity.

Moving selections within a routed schematic can sometimes produce unexpected results. For 
example, if a part is partially within a selection and some wires connected to it are inside the 
selection, then the wires will be dragged off the part during the move, possibly undoing the 
connective integrity of the drawing. Use the Undo and Redo commands to recover from an 
unitended change.

A complex selection containing many items can be moved as a single entity. When you select 
a Move command the current cursor location becomes the reference point for moving. This 
process is performed using the Edit Move options:

        Choose Edit Move Selection (shortcut: E, M, S);

        You will be prompted "Select Reference Point"

        Position the cursor at a convenient referen ce point and press ENTER or LEFT MOUSE;

        The reference point will be used to provide a convenient way of aligning the selection 
when completing the move. The selection will be highlighted and free to move. Note how 
the cursor maintains its relative position to the selection

        Move the selection to a new location and press ENTER or LEFT MOUSE;

        You will again be prompted "Select Reference Point."

        Select another reference point to move the selection to another location or press ESC or 
RIGHT MOUSE to leave this command.



Rotating selections

While moving a selection, you can rotate it around the cursor and flip it along its x or y axis 
using the following hot key shortcuts: 

        SPACEBAR each press rotates the selection 90 degrees clockwise.

        X flips the selection along its X axis;

        Y flips the selection along its Y axis.

Note: Many individual items need not be selected in order to be rotated. Focus on a single 
object (component, symbol, etc.) and click a second time to move the object. The commands 
listed above are effective for most objects.



What gets moved?

If one end of a wire is inside the selection rectangle, only that end will be moved. If the center 
of pins and junctions fall within the selection, the whole item will be selected with the selection. 
Wires or parts are only moved if they lie entirely within the selection. If a part with wires is 
partially within a selection and some wires connected to it are completely within the selection, 
then the wires will be dragged off the part damaging the connective integrity of the schematic 
layout.



Bring to front, Send to back

Graphical objects can be placed in sheets so that they overlap. When you place a new item, it 
is placed at the "front" of other items, by default. When you move items, they retain their 
position in the display, relative to other overlapping items. Four special move commands are 
provided for changing the "stacking" order of items in the display:

Bring to Front
Send to Back
Bring to Front Of
Send to Back Of



Select and De-select commands

The Edit Select commands allows you to select all items inside or outside of an area, all items 
in one sheet, or all objects. You can also select by net or physical connection. These options 
allow you to extend the selection (or de-selection) beyond a few items. 

Edit De-Select provides the same options, less the Net and Connection commands. These 
commands are used to define complex selections that can be moved, copied or deleted, etc. 
as a single item. The Edit Toggle Selection command allows you to turn the selection state of 
individual objects "off" or "on" which duplicates "direct" selection performed using 
SHIFT+LEFT MOUSE, described above. Shortcut: press X to choose from the De-Select 
options.

Select and De-select commands include:

Inside Area
Outside Area
All



Importing selections from another schematic

Any part of a schematic sheet can be imported into another schematic file. This is done by: 

        Opening a new file document window (File Open Sheet command);

        Using the Edit Copy command to copy the file (or a selection of the file) into the Protel 
clipboard;

        Using the Edit Paste command to add the file (or selection) to the current schematic.

        The imported selection will be displayed with the cursor positioned at the pre-defined 
reference point. The selection can be moved, rotated or flipped during placement. The 
following section, "Moving a selection," describes the process of positioning a selection 
in the workspace.

        When a selection has been added to the current layout, any duplication of existing part 
designators (U1, R1, etc.) is left unresolved. The File Annotate command can be used to 
automatically resolve all duplicate designators in the sheet.



Selection and other Windows commands

As illustrated above, standard Windows commands, such as Cut and Paste, can be used to 
manipulate a selection. These commands work with the internal Advanced Schematic 
clipboard that operates like the standard Windows clipboard. 

For example, the Edit Cut command (shortcut: SHIFT+DELETE) will copy a selection to the 
clipboard and remove the selection from the workspace, and the Clear command simply 
deletes the current selection and no copy of it is retained in the clipboard.

Under Windows each application has its own range of supported clipboard formats. The 
internal Protel clipboard is not the same as the clipboard used by other Windows applications. 
This is because the Protel clipboard stores object attributes, such as net assignment, that are 
not supported in other Windows applications. However, you can generally Copy or Cut text 
from another application and Paste that text into Text frame (text) windows.



Using the clipboard - Cut/Copy/Paste

Cutting a selection
Clipboard Reference option
Copying a selection
Pasting a selection
Clearing a selection
Delete
Place Array



Cutting a selection

The Edit Cut command clears the current selection from the workspace and copies it to the 
Advanced Schematic clipboard. The Edit Paste command can be used to place the selection 
back into any open Advanced Schematic sheet window.

Advanced Schematic uses its own internal clipboard format for graphical selections, not the 
standard Windows clipboard.

To cut the current selection from the active window:

        Make sure that the current selection includes only those items you wish to cut;

        Use the shortcut SHIFT+RIGHT MOUSE to add items to the current selection or to de-
select any selected items.

        Choose Edit Cut (shortcut: SHIFT+DELETE);

        You will be prompted "Select Reference Point." A reference point is a coordinate relative 
to the selected item(s). When you paste the selection, the reference point will locate the 
cursor at this same relative position, allowing you to accurately position the selection.

        The clipboard holds the last selection only, each time you use the Cut command, you 
overwrite the previous selection.

        Position the cursor at the desired reference point and click LEFT MOUSE or press 
ENTER.

        The selection will be cleared from the display and copied to the clipboard

        When using a mouse, the cursor is not "tied" to the current snap grid. However, when 
you designate a reference point during Cut or Copy, the grid point nearest to the cursor 
will be used.

Cut process



Clipboard Reference option

The Options Preferences dialog box includes a Clipboard Reference option which 
enables/disables the (default) process that prompts the user to designate a reference point 
when using the Edit Cut and Edit Copy commands.

The reference point pre-sets a cursor position for placing/moving the clipboard contents back 
into a sheet.



Copying a selection

The Edit Copy command copies the current selection to the (internal) Advanced Schematic 
clipboard (not the standard Windows clipboard). The Edit Paste command can be used to 
place a copy of the selection back into any open Protel document window.

The clipboard holds the last selection only, each time you use the Copy command, you 
overwrite the previous selection. 

        To copy the current selection from the active window:

        Make sure that the current selection includes only those items you wish to copy;

        Use the shortcut SHIFT+LEFT MOUSE to add items to the current selection or to de-
select any selected items.

        Choose Edit Copy (shortcut: CTRL+INSERT);

        You will be prompted "Select Reference Point." A reference point is a coordinate relative 
to the selected item(s). When you paste the selection, the reference point will locate the 
cursor at this same relative position, allowing you to accurately position the selection.

        Position the cursor at the desired reference point and click LEFT MOUSE or press 
ENTER.

        The selection will be copied to the clipboard.

        When using a mouse, the cursor is not "tied" to the current snap grid. However, when 
you designate a reference point during Cut or Copy, the grid point nearest to the cursor 
will be used.

Copy process



Pasting a selection

The Edit Paste command can be used to place the current clipboard contents into any open 
Protel document window. Advanced Schematic has its own clipboard format. The standard 
Windows clipboard is not used.

To copy the current selection from the clipboard:

        Choose Edit Paste (shortcut: SHIFT+INSERT);

        You will be prompted "Select Location to Place Selection" and a highlighted outline of the 
selection will be displayed. The cursor position relative the selection is determined by the 
Reference Point designated when Cut or Copy was used to add the selection to the 
clipboard

        Position the selection in the workspace and click LEFT MOUSE or press ENTER.

        You can repeat the Paste command to duplicate the selection.

        When a selection has been added to the current layout, any parts that have been added 
will be not be re-designated to avoid duplication of existing designators. Resolving 
duplicate designators is done using the File Annotate command.

Paste process



Clearing a selection

The Edit Clear command deletes the current selection from the workspace without copying it 
to the clipboard.

To clear the current selection from the active window:

        Make sure that the current selection includes only those items you wish to clear;

        Use the shortcut SHIFT+LEFT MOUSE to add items to the current selection or to de-
select any selected items.

        Choose Edit Clear (shortcut: CTRL+DELETE).

The selection will be cleared from the display. Use the Edit Undo command (shortcut: 
ALT+BACKSPACE) to restore the cleared selection.

Clear process



Delete

Using the Edit Delete command is similar in many ways to using selection and the Cut or 
Clear command described in the previous section. However, with Delete, you simply the 
cursor over the item, click LEFT MOUSE and it is deleted from the sheet. If you "miss," the 
system will simply "beep" allowing you to try again. This provides an efficient way to clear 
several objects from the layout. 

Unlike the Edit Clear command, Delete is independent of selection. In other words, the current 
selection is not discarded when you use the Delete command. 

If the Question Delete option is enabled (Options Preferences dialog box), the warning 
message "Confirm Delete will be displayed as you select each deletion. 

All deletions can be restored by using the Edit Undo command (shortcut: ALT+BACKSPACE). 
If you have deleted a series of items, they will be restored one-at-a-time starting with the last 
deleted item. The Edit Redo command uses the same first-in/last-out logic. Redo reverses the 
Undo operations, one-at-a-time.

Delete process

See also
Delete key



Place Array

When you use the Edit Cut (or Copy) command, you are placing a copy of the current 
selection in the clipboard. The Place Array command provides a powerful way to place 
multiple duplicates of any clipboard selection into the workspace. To use this feature:

        Select the item(s) that you wish to repeat place as an array;

        Choose Edit Cut if you wish to clear the selection from the workspace prior to placing the 
array, or choose Edit Copy if you wish to retain the selection in the workspace;

        clipboard. This allows you to pre-designate the cursor position when pasting the selection 
back into the workspace from the clipboard.

        Being careful to keep the cursor on the snap grid, press ENTER or LEFT MOUSE to designate 
a reference point;

        The reference point can be at any position relative the selection and will be used in positioning 
the items in your array.

        Choose Place Array (shortcut: p, y)

        The Array dialog box options define the array. Array parameters include:

        Placement Variables

        Item Count This option sets the number of times the selection is to be placed.

        Text increment This option is used for designators on pins or parts. Setting this to 1 (default) will assign 
array designators in-series, for example U1, U2, U3 and so on. This feature follows the 
same rules as the automatic designator incrementing when placing parts or pins.

        Repeated items are placed in a linear array, using the spacing values specified under 
Spacing.

        Spacing

        These values specify the horizontal (and/or vertical) distance between each item as it is 
placed. Each unit is equal to .1 inch. To place an array:

        Enter the desired values and click Place. Click OK to store the current parameters for later use 
or Cancel to return the parameters to their previous settings;

        "Select Starting Point For Array."

        Position the cursor where you want the array to begin, then press ENTER or LEFT MOUSE;

        Use the arrow keys (rather than the mouse) to keep the starting point (and thereby the 
selection) on the snap grid.

        The selection will be placed as an array in the drawing window. If a portion of the array will be 
placed outside the workspace boundaries the warning message "Selection Is Outside Drawing 
Window"

        You can disable the requirement to provide a reference point when placing a selection into the 
clipboard (Cut or Copy command) by turning the Clipboard Reference option "off" in the 
Options Preferences dialog box.

Setup Array process
Place Array process



Changing Objects

The Change command is used to modify specific attributes of placed items. Each item or 
object has its own range of editable attributes. You can change one item or extend changes 
across your entire design using powerful global editing options. All changes to objects are 
simply changes to fields of the object.

Moving and object is modifying its location field(s), either graphically or using a dialog.

To change any placed item, move the cursor over the item and double-click LEFT MOUSE. 
This shortcut will open the Change (item) dialog box for the selected item.

You can also use the Change command from the Edit menu:

        Choose Edit Change (shortcut: E, C);

        The prompt "Select (item)" will appear on the status line.

        Position the cursor over the target item and press ENTER or LEFT MOUSE;

        A dialog box opens, displaying the editable attributes for the item. It is now possible to 
change any or all attributes of the selected item, such as a wire width or color. These 
options are described in the next section, Global Changes.

        The system will not prevent changes that violate specified electrical design rules. An 
Electrical Rules Check (ERC) should always be performed before a netlist is generated.

Change process
Global changes
Undo/Redo



Global changes

Changes can be made to a single selected item or they can be applied globally across the 
entire drawing using flexible, powerful global editing options. Virtually every editable attribute 
can be globally applied. A simple example would be changing the color assigned to a wire. 
Typically, the designer would want this new applied to the whole net associated with that wire. 
Perhaps the color change should be made to a whole range of selected wires. These options 
(and more) are supported by the Change commands described below. The possible 
applications for global changes are limited only by the imagination of the design engineer. 

The large number of global change options may make this feature appear somewhat complex 
at first. However, the principles of applying global changes are reasonably simple, once 
understood. When mastered, this feature can be an important productivity tool that can save a 
great deal of manual editing of a schematic.

Matching attributes for global changes can be assigned by clicking the Options button in any 
of the Change (item) dialog boxes. When you click Options, the dialog box expands to display 
the parameters for global matches. 

Each Change (item) dialog box may contain different options since every object type has 
some unique attributes.

The power of these options can contribute to some unanticipated results -- particularly when 
complex selections are globally edited. It's always safest to De-Select All (shortcut: X, A), then 
create a fresh selection before you globally edit a selection. Remember, the Undo/Redo 
features can allow you to recover several operations, if required.

Aligning items
Object colors

See also
Editing objects graphically



Aligning items

Globally editable attributes include the location coordinates for each item. Using coordinates in 
global editing provides a very powerful system for aligning items in the sheet.

Global changes



Editing objects graphically

If you position the pointer cursor anywhere directly over any polyline item and click LEFT 
MOUSE, the item will change as it is placed in focus. It will now be highlighted (as a dashed 
line) and at each point where the line changes direction, a small square handle is displayed. 
These handles mark each vertex in the polyline wire. If you position the cursor directly over the 
handle and click LEFT MOUSE again, you will be able to drag the vertex to a new position and 
the attached wire segments will stretch. At the center of the line will be a special handle with 
four arrows. This is called the move handle. Clicking on this handle allows you to move the 
entire polyline object without changing its shape.

Every object that has its shape created during placement: wires, buses, non-electrical lines, 
polygons, bezier curves, rectangles, rounded rectangles, arcs and ellipses all share this 
common polyline behavior as they are placed and graphically edited. Editable attributes are 
described in the Advanced Schematic Reference and Library Editor Reference.

Change (graphically) process



Editing objects using dialogs

Change (Single item) process



Object colors

Each object primitive (everything that is placed) in the sheet be assigned individual color 
attributes. This allows the user to color code wires, classes of parts or individual items. For 
example, the user might want to display all VCC net objects in red and GND objects in green. 
Color assignments can be used for printing schematic sheets as well, if the output device 
supports the use of color by standard Windows device drivers. Examples include multi-pen 
plotters and color PostScript printers.

Many types items have a separate color assignment for their outline and fill area. Examples 
include graphical rectangles, block components and text frames. Items with text fields can 
have colors individually assigned to each text field as well.



Undo/Redo

Advanced Schematic includes a full multi-level Undo and Redo facility. Each procedure is 
stored in a stack-like arrangement. When the Undo command is called, the last completed 
process is undone. Choosing the Undo command again will undo the next-to-last process, and 
so on. Processes are grouped together in Undo for convenience. For example, if you choose 
Delete Wire and then delete two wires, undoing this operation will return both of the wires. A 
new set of processes is started every time you select a new command.

The Redo facility is also multi-level and will reverse all of the previous "Undos" during the 
current session. Every time you undo something, the operation is stored in a separate stack. If 
you then select Redo, the last undo operation that you did will be reversed and then the next-
to-last and so on.

Undo (and Redo) store each change you make to your sheet from the time you begin the 
current editing session. To clear the Undo stack, choose Edit Save As. If you perform many 
complex operations, you may find that system performance will noticeably slow, as Advanced 
Schematic maintains an increasingly large Undo stack. Clearing the Undo stack will restore 
lost performance and will also de-fragment and compact the current sheet file, which will also 
improve response during hard disk access.

Undo process
Redo process



Dot matrix impact printers

Dot matrix printers create letters and images with arrays of dots. The most common of this 
type of printer creates dots by driving pins against an ink ribbon and into paper. These types 
printers can produce output quickly but do not provide very good resolution. Resolution refers 
to the ability of a printer to reproduce an image accurately, usually measured in dots per inch 
(dpi). A few dot matrix printers produce resolutions up to about 150dpi. Some dot matrix 
printers have the ability to print colors, please refer to your printer's documentation for more 
information. If you need to produce presentation quality output, dot matrix printers are not 
recommended.

Print process



Plotters

Plotters use one or more pens to draw lines on a page. Plotters are especially useful for 
producing large-scale drawings for presentation. Some plotting devices    have the ability to 
produce color by assigning a different pen number to colors. Windows 3 is supplied with driver 
support for color plotting. The resolution of a plotter is limited by point size of its pen(s). For 
example, the smallest dot a plotter can make is the size of its pen's nib. About .3mm is the 
smallest practical size for fluid ink. Color plots are usually generated using disposable 
cartridge pins with fiber tips, which are much coarser than high quality pen points. Detail about 
communicating with and controlling the output quality of pen plotters is provided in the chapter 
titled Hardcopy.

Using pen plotters presents several problems and limitations. Most pen plotters are vector 
devices. The Windows environment is biased toward rasterized output and the more 
contemporary printing technologies that it supports. The reproduction of fonts on plotters, for 
example is limited by the page description language that a plotter uses to produce output. 
Reproduction of colors will also be limited to the colors of your plotters pens and the 
combination of those colors. Unfortunately, most Windows plotter drivers do a very poor job of 
handling color plotting. Advanced Schematic has been written to work around the tendency of 
these drivers attempts to "rasterize" the plotter output. For example, in many applications, 
Windows drivers attempt to recreate the dithering of non-solid colors found on screen. Under 
the best conditions, plotters tend to produce uneven tones when printing larger areas of color, 
this is because a plotter usually overlaps pen strokes to fill an area.

Print process



Ink jet printers

Ink jet or bubble jet printers create images by spraying ink on a page. Ink jet printers produce 
fairly good resolution (about 240 to 300dpi), but are fairly slow. Edges of images and letters 
can be blurred and softened when reproduced on an ink jet printer because the ink tends to 
spread out on the page.

Ink jet printers can produce fonts and images of fairly good quality, because most are well 
supported by rasterized Windows output. The TrueType fonts used in Advanced Schematic will 
be shown fairly accurately. However, caution should taken when trying to print a design with 
fine detail, very fine lines will tend to thicken and smaller type sizes will blur or become 
illegible. Some models are now being produced with "plotter" size sheet capacity. Excellent 
results can be obtained with color ink jet printers.

Print process



Laser printers

Laser printers have recently become a very popular printing device for producing presentation 
quality output. These devices provide high quality rendering of line (solid black) and grayscale 
artwork. Laser printers can produce resolutions from 300 to 600 dpi. 

Many laser printers support the PostScript page description language, which allows highly 
accurate reproduction of TrueType fonts that are supported by Advanced Schematic. Since 
laser printers use toner instead of ink, edges of fonts and images tend to be very sharp. Laser 
printers are an excellent choice for presentation quality output. While still relatively expensive, 
color laser printers are beginning to be widely available, especially from service bureaus in the 
desktop publishing field.

Print process



Using color

To assign a new color to workspace elements or objects:

Click inside the color box for the workspace element or object;

Object color boxes are found in the Change dialog box for the object. To open the Change 
dialog box, double-click on the placed object or choose the Edit Change command, then click 
to select the item.

Choose from over 200 pre-defined colors by clicking on your choice in the Color dialog box; 
Click OK to complete the color assignment.

Customizing display colors
More about color assignment



Customizing display colors

To customize one of the more than 200 available colors from the Color Selector dialog box: 
You can set the Red/Green/Blue values between 0 and 255 units.

As you make color assignments, it is important to make sure that your assignments don't 
conflict in some way that will obscure vital details when you edit your layout. It is 
recommended that you start with the sheet and selection assignments, if you wish to change a 
number of the defaults. 



More about color assignment

If your system supports 256 colors, your system color palette on will be set to display as many 
available colors as possible. Advanced Schematic dynamically reprograms the palette as 
colors are assigned.

Unless the graphics Card/driver you are using is supplied with a Windows 24 bit driver, 
Windows will use a system palette that allows multiple applications to share color 
assignments. Windows will take the first 20 colors in this palette for itself and simulate 
unavailable colors using dithering (mixing two or more solid colors). All 20 defaults are defined 
by Microsoft and all drivers are expected to provide color matches as close as possible to 
these.

When using applications that take advantage of 256 color palettes, use of more than the 
standard 20 Windows default colors may cause "stealing" of colors from the system or from 
other applications. For example, if you have a bit-map as your background for Windows that 
used 256 colors then the quality of the display of the bit-map will deteriorate as you select 
more colors for Advanced Schematic.

In standard VGA and EGA there are only 16 available colors. Windows "takes" all 16 and color 
requests from applications are either dithered or matched to the nearest solid color. The 
application can request either dithered or solid colors.



Using fonts

Advanced Schematic directly supports TrueType fonts, including bold and italic formats and 
scaling. TrueType fonts and supplied with Windows and are available from third-party 
suppliers in a wide variety of typefaces. Postscript scaleable fonts, and Windows non-
scaleable raster fonts can be used, when they are part of vector image files imported into 
Advanced Schematic sheets.

Note: Some printing or plotting devices do not have full support for scaling and rotation, in 
particular they may not support vertical text. 

Place Text (Single line) process



Image files

The Place Graphic command (shortcut: P, G) is used to import a graphic image into schematic 
sheets or the library workspace. Bitmap and vector images can be imported and scaled 
directly in sheets from a variety of graphics formats.

Images are linked during loading, they are not stored in the library. Only the image file path is 
stored in the library.

Advanced Schematic supports the import of the following image formats;

        BMP All uncompressed Bit map images. Windows device-independent bit map format, 
introduced with Windows 3.0 and increasingly supported by Windows applications.

          PCX Paintbrush format, used in Windows Paintbrush and other paint programs and supported 
by many desktop publishing and graphics programs. Supported colors include, 
monochrome, 16 color, 256 color, 24-bit color.

          TIFF Tag Image File Format, supported by many desktop publishing programs. Supported 
compression types, uncompressed, LZW, Packbits, Modified Huffman encoding, CCITT 
Group 3 1D, CCITT Group 3 2D, CCITT Group 4. Supported colors include, 
monochrome, 16 color, 256 color, 24-bit color

        GIF All non-interlaced Graphic Image files.

          EPS Encapsulated postscript files with and without display images. If the EPS file doesn't 
contain a TIFF or Windows Metafile display image then the filename of the EPS image 
will be displayed.

          WMF Only Windows Metafiles which conform to the Aldus Placeable Metafile Format are 
supported. Most applications which export or import Metafiles support this format.

Because the image "points" to a source file, this file will need to be accessible, when printing. 
These files must be supplied with sheet files, if you are sending files off-site for printing.

Place Graphic process



Hardcopy

The Library Editor Uses the same set-ups as the Advanced Schematic application. The Print 
command will print the current component in the following format:

One column will include all Normal display mode parts associated with the component.

A second column will include DeMorgan equivilents (if relevant)

A third column includes any available IEEE representation.

Descriptions, Footprints and 8 text fields are included below the graphical representations. 

The Batch Mode option will print this information for all components in the current library.

The Scale to Page option in the Print Setup dialog box will fit all of this information to the sheet 
size.

PostScript options
Generating a print or plot
Large format and pen plots



PostScript printing

Many laser printers support the PostScript page description language, which allows highly 
accurate reproduction of TrueType fonts that are supported by Advanced Schematic. Since 
laser printers use toner instead of ink, edges of fonts and images tend to be very sharp. Laser 
printers are an excellent choice for presentation quality output. Color PostScript printings are 
now widely available, as well.

Windows is supplied with drivers for PostScript-compatible imagesetting equipment. This 
technology, which produces output at 1000 to 2400 dpi, was developed to generate typeset 
quality images for the graphic arts and printing industries and is widely available in service 
bureaus. For information about PostScript imaging, contact a service bureau. 

See also
More about PostScript prints



Generating a print or plot

Advanced schematic printing and pen-plotting are handled similarly to other Windows 3.0 
applications. Windows manages the printing (or plotting) process and provides a range of 
raster and PostScript printer drivers and vector plotter drivers. These range from 9 pin dot 
matrix printers and multi-pen plotters, to high-resolution raster imagesetters. 

To print or plot from the active Schematic Editor or Library Editor windows, choose the File 
Setup Printer command. Options include:

Select printer
Batch mode prints
Color mode
Setting margins
Print command
Setup Printer command

See also
Setting-up pen plotters
Scaling prints and plot
Tiling
Options



Scaling prints and plots

Prints and plots can be scaled to a known factor or automatically scaled to fit within pre-
defined page margins. 

        Scale Type a scale factor from .001 % to 400%. 

        Fit on Page The check print or plot will be expanded or contracted to fit within your pre-defined 
margins, on the page size selected up for the target printer. The plot will be shrunk or 
expanded to use the available space, keeping the correct aspect ratio. 

        Orientation Set the portrait/landscape mode on the printer to match the sheet orientation.

Print process

See also
Tiling Prints
Setting margins



Tiling Prints

When the size of the sheet or library document to be printed exceeds the print area available 
on the target device, Advanced Schematic will automatically cut the print into two or more 
sheets or tiles. A pre-defined overlap maintained, so that no area of the print will be lost at the 
tile edge. You can preview the result of tiling    by pressing the Preview button. 

It is often possible to reduce the number of sheets required to tile a print, by changing the 
printer page orientation and adjusting margins. Experiment while in Preview mode to obtain 
the best match, before choosing the Print/Plot command.

Note: if you have defined too wide a margin for the sheet and have not selected the 
Scale for Fit option, the sheet will be printed again, for each overlap - so you could end 
up with as many as four prints - one for each user-defined margin.

Print process

See also
Scaling prints and plots
Setting margins



Print Options

This button opens the standard Printer Setup dialog box, where options for the target device 
are available. Depending upon the device, options include: sheet size/orientation, the number 
of copies of each document, etc. 

        Printer Options

This Options button from this dialog box provides direct access to the Printer's own setup 
dialog box, also available from the Windows Control Panel. These options add, remove or 
configure or set-up communications for the specific output device. The available options vary 
with the features of the selected device. Windows supports background printing from the Print 
Manager. The queuing of prints and other options can also be controlled from the Print 
Manager. See your Microsoft Windows User's Guide or printer or plotter documentation for 
additional information.

If printing or plotting from another computer, plots will need to be generated as files. To do this, 
open the Control Panel's Printer dialog box and click Configure. Select File from the ports 
menu. You will be prompted to name the file when generating the plot.

This dialog box is supplied by the printer driver and is not generated by Advanced Schematic. 

Once all options have been entered, Click Print to proceed with the print or plot, OK to save all 
the set-ups or Cancel to leave the Printer Setup dialog box without saving the new 
parameters. As the print or plot is generated (either directly to the output device, or to a 
filename) the current page and layer being printed is displayed in a dialog box.

If printing or plotting to a file, you will be prompted to supply an Output File Name.

Print process



More about PostScript prints

Some PostScript printers will "time out" and discard the current data when they don't receive 
the end of page marker within a specified time. This can cause problems where you seem to 
be missing pages from your plots. If you experience this problem using a PostScript printer or 
any other printing device then you should go to the Control Panel, select the printer icon, 
select the printer and click the Configure button. Change the Transmission Retry to 500 
seconds, or some other large number. This will allow the printer sufficient time to catch up 
before the Print Manager gives up.

Print process



Large format and pen plots

Windows is currently shipped with drivers for a number of large format plotters, particularly the 
new ink jet and electrostatic plotters.

Support is also provided for a number of traditional pen plotters, including Hewlett Packard 
HP-GL format models. Many other plotters can be configured to support the HP-GL language. 
See your plotter documentation for more information about available emulation modes. 

Current Windows pen plotting drivers, particularly for older model plotters, have a number of 
reported limitations. This is because some drivers, including the generic HP-GL driver, treat 
vector pen plotting similarly to raster plotting. This results in a number of problems, for 
example, poor rendering of filled arcs, inefficient (slow) plotting and other problems, especially 
when handling complex geometry. New or improved plotter drivers are reportedly under 
development for some types of plotters. For up-to-date information about plotter driver support 
under Windows, contact Microsoft or your plotter manufacturer.

If you plan to do your plotting from another computer, you will need to generate your plot as a 
file. To do this, open the Control Panel's Printer dialog box and click Configure. Select File 
from the ports menu. You will be prompted to name the file when you generate the plot.

Print process



Setting-up pen plotters

The options available will depend upon the type and model plotter selected. Guidelines should 
be documented in your plotter manual. Most plotters will require the following setup decisions:

        Pen speed

Determining the correct pen Speed is largely a matter of trial-and-error. Some users may find 
they have to choose a slower speed to get properly "filled" solid areas. The condition of the 
pen points, freshness of ink, etc., can have a significant impact on plot quality. Some plotters 
have force and acceleration options in addition to pen speed. Consult you plotter manual for 
recommended setting for the paper or film and pen combination you intend to use.

        Assigning pens

If generating pen plots for a multi-pen plotter, you can assign different pens to different colors. 
Pen size and pen number assignments are made from the Printer Options dialog box.

Producing good quality pen plots
Plotter pens and plotting inks
Setting the pen speed
Communications with Serial plotters
Baud rate, data bits, etc
Communication problem
Print process



Producing good quality pen plots

Pen plotters can be used to produce very sophisticated design artwork, when the many 
variables affecting plot quality are understood and applied to the process. But, there are 
inherent problems with pen plotting that need consideration. The variables that directly effect 
plot quality include:

Accuracy of the plotter -- particularly its "repeatability" or ability to return accurately to specific 
coordinates, over the entire plot area; 

Type and condition of plotting pens;

Plotting film or paper;

Type and age of the ink selected;

Environmental factors - i.e. temperature and humidity;

Pen speed and pen size settings.

Other factors include the experience of the operator and the maintenance and storage of 
equipment and materials. Following a few simple rules ensures that the best quality possible is 
obtained. 

Perhaps the most important factor is the quality of the paper (or drafting film) and the pens that 
you use. Use inexpensive paper and fibre tip pens for check plots - save the best pens and 
film for the final plot. 

Print process



Plotter pens and plotting inks

There are a wide range of plotting pens on the market. Felt, and plastic tipped pens are 
convenient to use, but only suitable for draft plots. Pens used for master artwork must be 
capable of providing a consistent ink flow, must not dry out when the pen is lifted off the film 
for short periods and must be of the correct diameter for the selected plot scale.

The pens that have been found to be the most suitable are those with tungsten carbide, cross-
grooved points. A latex-based ink will provide a dense plot without the ink running or drying out 
in the pen. Your local plotter supplier will make specific recommendations.



Setting the pen speed

Pen speed is a critical, and often overlooked factor in plot quality. It will be worthwhile to make 
a series of experimental plots to determine the optimum settings for your combination of 
plotter and materials. You may also improve the plot result by making small adjustments to the 
pen size selection. Slight changes will adjust the amount of "overlap" obtained when filling in 
solid areas -- with further adjustments needed as the pen wears during normal use. 



Communications with Serial plotters

Most plotters are controlled via an RS232-C (serial) interface. A cable connects the plotter and 
computer to provide two-way communication. Correctly configuring this combination of 
computer software, serial port, cable and plotter can be a challenge, even for experienced 
engineers. 

If you are installing a serial plotter for this first time, this section explains the relevant RS232-C 
conventions. 

The RS232-C standard defines the signals for bi-directional communication where there is no 
inherit distinction between the computer and the output device. In the jargon of serial 
communications both devices are referred to as DTE, or Data Terminal Equipment. Signals, 
such as Transmitted Data are assigned to the same pins in both devices, unlike the parallel 
standard where each pin has a single function.

Each serial "terminal" needs an intermediary device or devices to connect the "transmitted" 
data pin of one DTE to the "received" data pin of the other, and vice versa, and to correctly 
configure the handshaking signals. 

These intermediate devices are called Data Communications Equipment (DCE), which 
connects to DTE, transmits and receives the data over a channel but is neither the source nor 
the final destination of the data. A modem is a DCE - it both modulates data for transmission 
over a single voice channel and demodulates it back to digital data.

More about plot communication
Having problems?



Baud rate, data bits, etc

Once a correct serial connection between the computer and plotter is achieved, the correct 
communications parameters must be selected.

Windows allows you to change these settings using the Control Panel Printer dialog box.

Your plotter manual should indicate the default settings of the plotter and will contain 
information on changing the communications setup. Some plotters do not have default 
settings, as such, but use DIP switch settings which must be configured before the plotter is 
operated. 

You will need to match these parameters using the Printer dialog box. Once set, these settings 
are stored with your Windows preferences (Exit Windows, enabling the Save Settings option). 

A baud rate of 2400 bps is standard for many plotters, and a good place to start, if you don't 
know the specific recommendations for your plotter. This is an intermediate baud rate and 
should yield error-free data transmission with cables up to 50 feet (15 meters).

Your plotter manual should also document interfacing and handshaking settings.

See also
Having problems?



Pen plot problems

If you are having problems plotting and you are confident that you have the right cabling and 
parameter settings, check the following: 

Inspect the cable connections and make sure that no wires have broken. Also check that your 
Windows settings match the plotter baud rate, parity, etc.;

Confirm that you are using the selected serial port;

If your plot progresses normally at first, then starts putting stray lines or arcs all over the 
layout, this generally indicates improper handshaking. You may also have a problem with one 
or more pin assignments and your cabling may need modification;

Another possible solution is to keep the plotter cable as short as possible and keep it away 
from power cords and other "noise" sources.

If you are using a long cable, you may have to reduce the baud rate to obtain error-free 
transmission. Due to the distributed resistance and capacitance of cables, there is a trade-off 
between cable length and baud rate for reliable data transmission; 

Remember, if you change the communications settings at the plotter, you will have to match 
the new settings in Windows under the printer's Set-up dialog box.

Make sure that you have specified the correct plotter driver. For example, is your plotter a 
"true" Hewlett-Packard (HP-GL) or a "compatible"? Many plotters emulate HP-GL in addition to 
their own plotting language. If you are using a dual-language plotter you may have to 
configure the plotter for the correct language. This is done using Control Panel or dip switch 
settings, depending upon the plotter type and model. See you plotter manual for details.

Finally, erratic plotter behavior can be the result of plot file corruption -- usually the result of a 
disk failure or system error during file creation. If you have been unable to solve your plotting 
problem, try plotting one of the (supplied) demonstration files, as a cross-check.



OrCAD compatibility

Both schematic sheet files and libraries from OrCAD SDT 3/4 can be used with Advanced 
Schematic. OrCAD SDT 3/4 3 files are loaded using the File Open Sheet command, just like 
Advanced Schematic files. All OrCAD SDT 3/4 design objects are supported by the Schematic 
Editor. When you choose File Save, the file will be saved in any of the three following formats: 
Protel binary (the Advanced Schematic native format), Protel ASCII (a text version of the 
Advanced Schematic format) or OrCAD binary.

SDT libraries
Basic library concepts



OrCAD    libraries

OrCAD SDT 3/4 component libraries can be converted into Advanced Schematic libraries. The 
first step is to convert the OrCAD format library into its decompiled (.SRC) format. Load the 
decompiled version into the Protel Schematic Library Editor and then save in Protel Binary 
Format.

Basic library concepts



Protel Schematic 3 (DOS) compatibility

As with OrCAD SDT 3/4 files and libraries, both schematic sheet (.S**) files and libraries from 
Protel Schematic 3.x can be used with Advanced Schematic. Protel Schematic 3 files are 
loaded using the File Open Sheet command, just like Advanced Schematic files. When you 
choose File Save, the file will be saved in any of the three following formats: Protel binary (the 
Advanced Schematic native format), Protel ASCII (a text version of the Advanced Schematic 
format) or OrCAD binary. There is no option for saving files in the Protel Schematic 3 format. 
Users of earlier version Protel Schematic or Tango Schematic system must first convert files to 
Protel Schematic 3 format before these files can be opened in Advanced Schematic.

Schematic 3 libraries
Basic library concepts
Protel (DOS) library conversion



Libraries (Schematic 3)

The way that Advanced Schematic handles libraries, components and library editing is 
fundamentally different than the way these functions are performed in Protel Schematic 3. 
Please refer to the relevant sections of this guide for detailed explanations regarding 
Advanced Schematic library concepts.

Protel Schematic libraries are organized into a "flat" structure where each component has a 
unique description. All graphical representations of Schematic 3 library components (except 
their pins) are rendered as bitmap images. Advanced Schematic library parts are vector 
graphic based. When converting files into Advanced Schematic format, the differences 
between the two library systems must be reconciled to preserve connectivity. This is done in 
two basic ways: a library of equivalent vector (Advanced Schematic) components is 
maintained. These components are automatically substituted for like-named standard 
Schematic 3 versions. For custom components, a substitute vector component is created.

Basic library concepts
Protel (DOS) library conversion
Other bitmap components
Pin Editing
Connector components
Advanced Schematic Libraries



User created bitmaps (Schematic 3)

Protel Schematic 3 libraries and sheets may include user-generated bit map graphics that 
cannot be substituted from PROTEL.LIB when Schematic 3 sheet files are loaded into 
Advanced Schematic. 

A special library and vectorization support is provided for converting Schematic 3 user libraries 
into Advanced Schematic format at the time the sheet is loaded.

Basic library concepts
Protel (DOS) library conversion



Pin Editing (Schematic 3)

Schematic 3 allows users to edit pin attributes, including pin positions, on the fly, from inside 
the schematic editor. This is not possible in Advanced Schematic, where all changes must be 
made at the library level, using the Schematic Library Editor application. Because the Library 
Editor can be run at the same time the Schematic Editor is running, it is a simple matter to 
switch tasks and make library level changes, then return to the editor. Special links are 
provided that allow the user the move directly from one editor to another. For example, from 
the Library Browser window in the Schematic Editor, the Edit button will switch the user 
directly into the Library Editor. The library for the selected part will be opened and the 
component will be displayed in the edit workspace. Similarly, pressing the Place button on the 
Library Editor main panel will return the user directly to the Schematic Editor, with the part 
ready to place in the current sheet window.

Basic library concepts
Protel (DOS) library conversion



ASCII file formats

Advanced Schematic sheet and library files have default binary formats. These binary files are 
compact and efficient when loading or saving. To make it easier for users to directly access 
data, the system includes options to generate ASCII versions of these files. 

Other files are generated in ASCII format only. These include netlists, Bills of Material and 
other reports.

Detailed information for ASCII version sheet and library files can be obtained by contacting 
Protel Technical Support.



Advanced Schematic Glossary

        annotation Component reference designators (or labels) that appear on the schematic sheet, 
in netlists or on a printed circuit board.

        ANSI International standard for technical drafting. See also ISO.

        any angle Non-orthogonal drawing mode where (non-electrical) lines or wires that can be 
placed at angles other than 45 or 90 degrees.

        arc Circular or semi-circular design elements. Protel for Windows generates arcs of 
degree resolution.

        array Multiple instances of a single item, placed using the Place Array command.

        ascend To move from a child sheet, back to its parent sheet in a hierarchical design. 

        ASCII American Standard Code for Information Interchange. Standard seven bit code for 
representing alphanumeric data and computer instructions.

        attributes The characteristics of an item that can be edited, or changed. For example, wire 
attributes include width, color, etc.

        back annotate Updating schematic information from changes made to the printed circuit board 
layout.

        backup library A special library that includes component records for each part placed in a 
schematic sheet. This library is attached to the sheet file when the sheet is saved. 

        bezier curve Complex graphical curves, placed as precision arcs defined by a series of control 
points.

        Bill of Materials Or, BOM. A list of the components (including quantities). 

        body See outline.

        border Graphical device outlining the edge of the sheet workspace, normally including 
coordinate references for the sheet.

        browse Viewing library names from the Protel for Windows workspace.

        bus A special wire type that symbolically represents a collection of individual nets.

        cache A temporary record of each component used in a project. This cache is used to 
create a backup library, attached to each sheet file. See also, backup library.

        child A subsheet descended from another (parent) sheet in a hierarchical design.

        Clear To remove a selection permanently from the workspace. Same effect as Delete. 
See also Cut, Copy.

        clearance Air gap specified for routing a net. Field of the directive primitive

        clipboard Reserved memory used to hold Cut or Copy command selections.

        clock Pin type that symbolically represents clock function, represented by a small 
triangular shape at the pin base.

        command Any process that is performed by choosing a menu option, e.g., Place Component 
or File Save.

        comment Optional component text field created when a component is placed. Normally used 
to hold a component value, description or part number.



        complex (in hierarchy), when a sheet can appear more than once in a project.

        component The specific schematic library package that represents either a manufacturer 
catalog listing or a generic type. See also part.

        component field Any of 8 different library fields that hold optional component text.

        component txt Text that is associated with a schematic part or PCB component.

        connection The logical or physical link between any two netlist nodes.

        connectivity The logical relationship of components and wires.

        control point The special graphical handles used to define a bezier curve. 

        de-select Releasing the selected condition of an item (or group) in the document window. 

        default Program settings or options that remain activated until changed by the user. 

        descend To move from a schematic sheet, to a child sheet, represented by a sheet symbol, 
in a hierarchical design.

        designator Also called component label. The unique identifier assigned to each component in 
a circuit.

        device See part.

        directive A special symbol used to attach PCB layout information to a specific net, such as 
routing priority, track width, etc.

        discrete Generic component types such as transistors, capacitors, etc.

        dot Pin type that symbolically indicates inversion, represented by a small circular 
shape at the pin base.

        DXF Format for AutoCAD files.

        electrical rules Connectivity-based features that check for shorts, undriven inputs, unconnected 
wires and similar electrical design violations.

        fill Color or pattern assignment for the inside of graphical items.

        flat design A non-hierarchical multi-sheet schematic where Ports are used to indicate 
connections to other sheets.

        fwd annotate Updating a printed circuit board layout with changes made to the schematic.

        focus The current active individual which displays its graphical editing handles. The 
object in focus can be moved, deleted or re-sized. See also selection, handle.

        global In relation to the use of net identifiers (net label, port, sheet entry), refers to 
identifiers whose scope includes an entire project. See also local.

        global change Any change that can be assigned to like attributes of other primitives of the same 
type. 

        group Refers to one or more library component names associated with the same 
component description. Library entries can have any number of component names 
that share the same specification and graphical description.

        handle Small arrows displayed on an object that is the current focus.

        hardware arc When plotting, arcs which are created by the plotter, from coordinate, line width 
and radius information.

        hidden pin Component power-type pin that is normally hidden when the component is 



displayed. 

        hierarchy The concept of hierarchy applies generally to any multi-sheet schematic. Sheet 
Symbols are placed within one sheet to represent another sheet (or subsheet). 

        highlight A special display state that outlines items as an aid to identification or editing. For 
example, when placing or moving wires, they are displayed in a highlighted 
condition. See also selection.

        hot key Any key that has a process assigned in Advanced Schematic. 

        IEEE International ANSI/IEEE Standard 9-984 for graphical representation of circuits.

        IGES Initial Graphics Exchange Specification. A general use standard for exchanging 
graphical information between platforms or applications.

        intersheet (connection) In multi-sheet flat designs, these are connections that represent a net 
that crosses from one sheet to another.

        ISO International Standards Organization. See also metric.

        isolation See clearance.

        junction Special symbol, used to electrically (logically) connect two wires. 

        label See designator.

        library Collection of components, devices or symbols, stored in Advanced Schematic 
library form.

        line Any line that is non-electrical in the drawing. Electrical lines are referred to as 
wires.

        link The process of listing all associated sheets for a design.

        local In relation to net identifiers, refers to net labels whose scope is limited to a single 
sheet.

        master sheet The "topmost" sheet in a multi-sheet design project. 

        merge To move components from one library to another.

        min X, Y The minimum X or Y coordinate of items in the Protel for Windows workspace. This 
describes the left-most and bottom-most coordinates used in the file or plot.

        Module port See port.

        multi Multi-device component. Schematic component whose devices (gates) can be 
represented by individual logic symbols.

        net label Special text symbol used to associate a wire with a specific net.

        netlist A text file that lists all the connections of an electronic circuit. 

        object Any individual item that can be placed in Advanced Schematic sheets. 

        orthogonal Drawing mode, where wires are constrained to either vertical, horizontal or 45 
degree placement. See also any angle.

        outline The symbolic shape used to describe individual components or devices.

        package The physical description, or "footprint" of a component, e.g., DIP6, defined by the 
number and location of pins, dimensions, etc.

        parent Any sheet that includes sheet symbols for another subsheet (child) in a hierarchical 
design. 



        part field Optional text fields added when placing the component. See also component field.

        part Graphical representation of a library component or one part of a multi-device 
component. 

        pin Graphical representation of a component pin on schematic component symbols. 
Schematic pins are connected using wires.

        pipe-link An OrCAD design element, used to list the subsheets associated with a master 
sheet in a flat, multi-sheet design.

        polygon Multi-sided filled graphical (non-electrical) object.

        polyline Lines that can be rendered with multiple joined segments and manipulated as an 
individual entity. Wires, buses and graphical lines are all polylines in Advanced 
Schematic.

        port A symbol used to indicate a connection to another sheet in a flat design.

        power port Special component symbol, normally used to indicate a power source.

        primitive Refers to any individual object, or object primitive. See object.

        process Any event generated by Advanced Schematic, including menu commands, dialog 
box options or shortcuts that either changes an attribute of an object, imports data 
into, creates data or exports data from Advanced Schematic. 

        process launcher Any user initiated action that begins a process. 

        project All the sheet files that are associated within a single design, irrespective of their 
hierarchical or flat organization.

        Project Mgr Advanced Schematic system for opening, saving and manipulating multi-sheet 
schematics. 

        project window Special windows displayed at the left of the sheet window when the Project 
Manager is active. This window displays an image representing each open sheet 
file.

        root sheet See master sheet.

        selection A method of grouping items which are manipulated as a single entity.

        serial Refers to RS-232C and RS-422 standard for data terminal equipment (DTE) 
communications. 

        sheet An individual schematic file, displayed in its own window. Each schematic sheet, 
including hierarchical subsheets, are saved as individual files.

        sheet symbol A graphic representation of a schematic sheet that can be placed on another sheet, 
indicating hierarchy. 

        signal Any net. Generally used to refer to any non-power net.

        Simple (hierarchy) where each sheet in a project is unique. See also Complex hierarchy.

        snap grid An invisible array of regularly spaced points on the screen that defines the possible 
cursor positions.

        software arc When plotting, arcs which are generated by Protel for Windows using straight line 
chord segments. See also hardware arcs.

        Status line The window at the bottom-left of the screen that displays the current X and Y 
cursor coordinates, defaults; and user prompts.



        step-and-repeat See array.

        stimuli A special symbol used to indicate the point at which the function of a signal 
(expressed as an algorithm) is applied to a circuit during simulation.

        string Individual element of free or component text.

        subpart see device.

        subsheet In multi-sheet schematics, any schematic sheet file associated with a master or 
parent sheet. See also hierarchical design.

        symbols Various graphical and electrical or logical objects placed on the schematic to 
represent components, devices or blocks of circuits.

        test vector A special symbol used to indicate the point at which a non- algorithmic stream of 
signal values is applied to a circuit during simulation.

        text frame A graphical object placed on the schematic sheet that holds up to 32,000 
characters of formattable text. Parts, netlabels and other objects have their own 
text fields of up to 255 characters.

        title block Area of the schematic sheet reserved for the drawing title, revision information, etc.

        tool Any menu command that is available as a push button on a Tool palette.

        trace see probe.

        vertex The joint of any two straight line segments in polyline objects: wires, buses, lines 
and polygons. 

        visible grid A user-definable display layer that provide a visual reference for positioning items 
accurately on-screen.

        wire An electrical (logical) conductor in the schematic drawing, represented by a special 
line type.

        worksheet See sheet.



SLM.EXE (Schematic 3)

Advanced Schematic Library Editor Application.

To create, edit and manage your component libraries,

Choose File Open. You can also launch the Library Editor as a separate application from the 
Advanced Schematic (sheet) Editor by pressing the Run Library Editor button from the Main 
toolbar or by choosing the Run Library Editor command from the Library menu.

Basic library concepts
Protel (DOS) library conversion



Schematic Library Editor Help

        Using Schematic Library Editor Help
        New Features for this Release

  

        Reference

        Processes
        Data Primitives
        Main Menu
        Hot Keys
        Error Messages
        Tool Bars

        Concepts

        Library and component management
        Configuration
        Processes
        Objects in the workspace
        Hardcopy
        Report generation
        Glossary

        Compatibility

        OrCAD SDT 3/4
        Protel Schematic 3 (DOS)



Select Printer

The available output device options will include those that have been installed using the 
Windows Control Panel (see your Microsoft Windows User's Guide for details). Most devices 
are supported by drivers delivered with your Windows software. You should note that new and 
updated drivers are released for both new and existing devices on a regular basis. For the 
latest information about print drivers, contact Microsoft Windows support or the device 
manufacturer. 

Rotation of fonts is not supported for all printers and the substituted fonts will only be used if 
the text on your schematic is in a standard horizontal (or landscape) orientation, and within the 
size capability of the printer. PostScript printers support rotation of fonts at any angle

Setup Printer process



Batch Mode prints

When using this option from the Schematic Library Editor, this option prints either a single 
(current) component or a batch of all components in the current library. This option allows you 
to print out an entire component library in a single operation. When you choose this option, all 
representations of a component are printed, including each part (or device) DeMorgan and 
IEEE equivalents, when applicable. Component description fields are also added to the sheet. 
This option works with all other print/plot options, including scaling, etc.

Print process



Color mode (printing)

Two choices are available: color mode takes Advanced Schematic screen color assignments 
and uses these to assign colors to the print or plot, based upon the options available in the 
print or plot driver. Monochrome PostScript or HP-PCL devices will print grayscale 
representations of color. The number of gray levels, and the assignment of color to grayscale 
depends upon the driver and device. The Monochrome option, prints images in solid 
black/white only. No dithering or grayscale support is provided. This option is appropriate for 
low resolution dot matrix and single pen plotting.

Print process



Setting margins (printing)

The user has total control over margins, limited only by the margin limits built into printers or 
plotters that do not allow printing to the sheet edge (e.g., PostScript printers). When used with 
the Scale and Scale to Fit Page options (described below), this option will size the print area to 
fit as closely within the margins as allowed by the aspect ratio of the print area. The Preview 
option allows you to preview the result of all settings and make adjustments before printing.

Print process

See also
Scaling prints and plots
Tiling prints



Basic library concepts

Libraries consist of component descriptions, represented by the individual part symbols that 
are placed in schematic sheets. Components can have one or many parts or subparts (e.g. 
gates in TTL components). The term component always refers to a complete library 
description -- either a specific manufacturer data book entity or a generic device (e.g., resistor, 
capacitor, diode, LED, etc.).

Many components share the same packaging -- they have identical graphical depictions, but 
exist as individual names in libraries. These can be equivilent devices from different 
manufacturers, or components with the same package but a different function (e.g. 120ns 
versus 80ns RAM). While it is convenient to access these otherwise duplicate parts using 
either description, it    would be wasteful to create and store a separate graphical version of 
each item.

Advanced Schematic uses the concept of component groups to associate multiple component 
names with a single description stored in the library. This keeps libraries efficient and 
manageable. For example, while the TTL library contains 

nearly 1800 component names, the graphical and data descriptions that represent these 
components number only 600 or so.

When a component part is placed in a schematic sheet, the displayed version of the part is a 
representation of the library version only. The actual component exists only in the library. This 
means that components and their parts are changed or edited only at the library level -- never 
at the sheet level. Library level changes are globally applied to each instance of a part when a 
sheet is loaded. 

This principle maintains strict data integrity in parts libraries.

Component management
Component models



Keys (Hotkey)

Select the key (or mouse button) for hot key assignments. Assignments can include the ALT, 

CTRL and SHIFT keys.

Setup Hot Keys process



Process (Hotkey)

Selects the process for hot key assignment.

Setup Hot Keys process



Current Process (Hotkey)

This box lists the current process assigned to the selected key combination.

Setup Hot Keys process



Description (Hotkey)

This box describes the purpose or use of the current process.

Setup Hot Keys process



Assign (Hotkey)

Adds the key and process selections to the current hot key file (.KEY extension).

Setup Hot Keys process



Load (Hotkey)

Loads an existing key file (.KEY extension) for editing. The Library Editor has its own hot key 
set, independent of the default Advanced Schematic set, named LIBEDIT.KEY.

Setup Hot Keys process



Save (Hotkey)

Updates the current key file (.KEY extension) with items assigned during the current editing 
session. Overwrites any previous assignments in the current hot key file.

Setup Hot Keys process



Defaults (Hotkey)

Resets the default hot key assignments. Any new assignments that have not been saved as a 
new hot key file will be over-written.



Move Handle

The Move Handle, referred to in the reference manuals and User Guide is no longer displayed 
when the object is in focus. You can now move (focused) objects by placing the cursor 
anywhere inside the boundary of the object and clicking LEFT MOUSE. When the object is in the 
desired position, click LEFT MOUSE again.

See also
Selection and Focus



Inside Area (Select)

Allows you to define a rectangular selection area. Only those objects that lie completely inside 
the area are included.

To choose the items inside a selection rectangle: 

        Choose the Edit Select Inside Area command (shortcut: s, i);

        You will be prompted "Select First Corner."

        Move the cursor then press ENTER or LEFT MOUSE to define the first corner of the 
selection rectangle;

        The prompt changes to "Select Second Corner."

        Move the cursor to enclose the selection area in the highlighted rectangle;

        Press ENTER or LEFT MOUSE to complete the selection.

The newly selected objects will be highlighted using the selection color. Any previously 
selected items will remain selected until de-selected.

See also
Outside Area



Outside Area (Select)

This option selects everything in the sheet outside the selection rectangle. The rules for 
inclusion in the selection are the same as for the Inside Area command. The procedure for 
defining the selection rectangle is the same as for Inside Area.



All (Select)

This command selects everything placed in the sheet.



Connection (Select)

Choose Select Connection (shortcut: S, C) to select the free objects (wires, buses, junctions,) 
that connect using the physical geometry of the system. Non-electrical objects will not be 
selected, even if they touch the connected items.



Toggle Selection

The Edit Toggle Selection command allows you to turn the selection state of individual objects 
"off" or "on" which duplicates "direct" selection performed using SHIFT+LEFT MOUSE. 
Shortcut: press X to choose from the De-Select options.

To use this feature:

        Choose the Edit Toggle Selection command (shortcut E, N);

        You will be prompted "Select object"

        Click on an object type to add or remove the item from the current selection;

        The prompt "Select object" will be continuously displayed.

        Press ESC to leave the Toggle Selection command.

See also
Select and De-Select commands



Bring to Front

This command moves an object to the front of other items in the display. When you use this 
command, you are prompted to choose the item to be moved. When you click on the item, it 
moves to the front of the display without changing its x or y coordinates.



Send to back

This command sends an object to the back of other items in the display. When you use this 
command, you are prompted to choose the item to be moved. When you click on the item, it 
moves to the back of the display without changing its x or y coordinates.



Bring to Front Of

This command moves an object to the front of another item. When you use this command, you 
are prompted to choose the item to be moved. When you click on the item, you are then 
prompted to choose the "target" item. The item to be moved will be re-located in front of the 
"target" without changing its x or y coordinates.



Send to Back Of

This command moves an object behind another item. When you use this command, you are 
prompted to choose the item to be moved. When you click on the item, you are then prompted 
to choose the "target" item. The item to be moved will be re-located behind the "target" without 
changing its x or y coordinates.



Cursor shape

Options include: large 90 degree cross (cross hair type), small cross or 45 degree cross.



Snap to Center

If Snap to Center is enabled the cursor will jump to the center of a pin, wire, etc., as it is 
moved. If you have the Snap to Center off, the cursor position will remain relative to the point 
where the selection was made.

When you select a component with Snap to Center Option on, then the cursor will jump to the 
reference point of the component (generally pin 1). If this option is off then when you select a 
component the cursor will remain in the same position relative to the component.



Save Defaults

This option allows user settings, preferences and defaults to be written to SCH.INI and 
LIBEDIT.INI files when exiting the Schematic Editor and Library Editor applications. These 
settings, preferences and defaults are then loaded the next time you run Advanced Schematic.



Auto Backup

Sets interval (in minutes) for generating an automatic backup of the active workfile. To disable 
this feature, type 0. The default interval is 30 minutes.



Auto Backup File Count

Auto Backup works on the basis of a rotating file system. This option allows you to specify the 
number of backup files that will be automatically created as you work. For example, if you 
have a file called TEST.SCH then the first backup will be saved as TEST.AB0. At the backup 
interval, a second backup, TEST.AB1, etc., up to the total number of files selected. The next 
backup would again be TEST.AB0, overwriting any previous version with that name. The 
default value is 1.



Dialog boxes

Dialog boxes launch processes and other perform other functions, such as changing the 
attributes of data primitives. An example would be using a Change dialog box to enter new 
coordinates for an object. Some dialog box functions launch processes. For example, clicking 
the OK button in the Array dialog box launches the process Execute Paste Array process. 



Objects

Object (for object primitive, or primitive) is a generic term that refers to the individually editable 
items that are the building blocks in your design, such as a wire or a junction.



Connector components (Schematic 3)

Schematic 3 allows the user to define a special component type: Connector. Connector 
components (usually a single bitmap part) are a special catagory of multi-part component, 
where each placed "part" represents an individual pin with a common designator. This feature 
is not supported in Advanced Schematic.

To acheive the effect of "connectors" simply place a port, linked to the component and pin 
number (located elsewhere on the sheet). This allows the same flexibility with pin location 
across a single (or multiple) sheets. 



Local hidden pins

One problem with hidden pins is that all hidden pins are deemed to be "global" when a netlist 
is generated. In other words, all hidden pins labeled VCC on all sheets are connected together 
in a common net. This can be a problem if the designer intends to split these supply nets. In 
simple cases, the designer can merely un-hide and manually wire the individual pins. 
However, this can quickly grow into a tedious task, in complex, hierarchical designs.

To overcome this limitation, the user can place an "unspecified" type port on the sheet, wired 
with a net label which matches the hidden pins net (e.g. VCC). The port should be given a 
unique name. This will make all pins with the same label "local" to the sheet. These pins will 
not be connected to other hidden nets with the same names on other sheets. 



LIBEDIT.EXE (OrCAD)

Advanced Schematic Library Editor Application.

To create, edit and manage your component libraries.

        Choose Edit Library from the Library menu. You can also launch the Library Editor as a 
separate application from the Windows Program Manager.



Copy (or Move) Component

This command allows you to copy (or move) a component from one library to another. When 
you choose this command, a dialog box opens, listing are current active libraries. Choose from 
one the the available library names and the component will be copied to, or moved to the 
destination library. 



New Features for this Release

A number of new commands have been added to the Library Editor. Select a topic for 
information about these features:

        Commands

        Align Objects
        Align objects on bottom
        Align objects on left
        Align objects on right
        Align objects on top
        Center objects around horizontal axis
        Center objects around vertical axis
        Distribute equally along horizontal axis
        Distribute equally along vertical axis
        Find and Replace Text
        Find Next
        Find Text
        Memory Monitor Setup
        Open Environment Configuration File
        Popup Alignment Menu
        Save Environment Configuration File
        Setup Autopan
        Toggle Command Status Bar



Undo Limit option

This option, under Options Preferences, allows the user to set the number of Undo/Redo 
levels. The default is 50. This allows the user to backtrack through (and restore) 50 individual 
operations. The legal range is 0-16000. Because each operation must be stored in memory to 
enable Undo/Redo, setting a higher number may result in performance deterioration, while 
editing. If you notice Advanced Schematic slowing down after using the application for a while, 
try selecting a lower number. The more memory you have installed in your machine, to higher 
the limit you can set without hurting the performance of your system.

New Features list



Using Wildcard search fields

Wildcards can be used to define text strings when global editing all primitives that have text 
fields. This applies to parts,net labels, annotations (single line text), sheet symbols, sheet 
entries, ports and power ports.

Global text fields

When the Change dialog box for these primitives is opened, pressing the Global button opens 
the global editing options for that primitive. Three text entry boxes are displayed for each text 
field. The leftmost box shows the current text information for the item. The center field (under 
Attributes to Match By) is labeled Wildcard. The rightmost field is under Copy Attributes.

Syntax for Wildcard searches

The center field (Wildcard) defines which strings will be edited. If * is displayed (the defaualt), 
all strings for this field are available to be globally edited. This can be limited by defining 
specific cases, for example S* will limit the fields to strings beginning with S, etc. Wildcards 
are case in-sensitive.

The Copy Attributes (right) field defines the changes to be made to the string. Defining the 
change follows this syntax: {oldtext=newtext}. This means change portion of the string 
"oldtext" to "newtext". You can use multiple sets of brackets to define complex replacements. 
In this case the leftmost replacement is made, then the next on, etc. Although this is very 
powerful, you must take care, because the first change can effect subsequent replacements, 
possibly generating an unexpected result. Any mistakes can be corrected with the Undo 
command, however. You can further limit the replacement by typing {!Text=text} to make the 
changes case sensitive. In this case, "Text" becomes "text". Otherwise replacement is case in-
sensitive by default.

New Features list



Run command options

The Tools menu allow the user to execute other applications directly. This allows the user to 
avoid using the Windows run command or searching through the Program Manager to launch 
other programs. 

File Manager, Control Panel, Calculator, Clock and Notepad are default options.

Tools Setup is also used to assign Editors to three    Advanced Schematic processes:

Text Editor: assigns the editor for editing and viewing report files;

Picture Editor: assigns the editor for placed graphic images;

CSV Editor: assigns the editor for CSV format Bill of Materials files.

Tools Setup is also used to assign links to other EDA applications and four additional User 
Commands.

Run command setup
New Features list



Protel (DOS) library conversion

Advanced Schematic uses vector, rather than bitmap graphics to display parts. A special 
library, PROTEL.LIB contains substitute vector parts for all bitmap components from the 
standard libraries delivered with Protel Schematic 3.3 (the DOS version). 

When you load Schematic 3.3 sheet files, these components will be substituted automatically 
for the bitmap versions.

When a user-created component bitmap shape cannot be matched to PROTEL.LIB, Advanced 
Schematic will automatically "vectorise" these parts and report them as "unmatched." In many 
cases, the automatically vectorised components are perfectly acceptable, however, in some 
cases you may wish to improve their vector rendering. 

The follow procedure can be used to edit these un-matched components and add these 
additional parts to PROTEL.LIB so that they can be automatically substituted the next time you 
load a Schematic 3 sheet file.

        1. In the Schematic (sheet) Editor, use Library Add to open the special PROTEL.LIB, which 
should be in the same directory as the Advanced Schematic applications. PROTEL.LIB 
parts are named using a special Bitmap ID#    which "describes" the orginal bitmap 
shape in the DOS version.

        2. Open your Schematic DOS sheet file.    Any components which cannot be matched 
(based upon shape) will be reported after the sheet is loaded. A text file named 
(filename).$$$ listing un-substituted parts will be generated and displayed using the 
default text editor (see under Run command). Leave this text file open -- you will need 
the information in this file later in this procedure.

        3. Use the Library Make Project Library command to create a new library from the open 
sheet (or sheets). This library will include all project parts -- both substituted and non-
substituted. Make sure that you save the library in Binary (.LIB) format.

        4. Launch the Schematic Library Editor. 

        5. Open both your Project library AND the PROTEL.LIB library.

        6. Using the text report, search the project library for the unmatched components. Click in 
the Components list box to display the first unmatched part. Advanced Schematic will 
have "vectorised" this part, substituting vectors, where possible for the bitmap patterns. 
Although some patterns may not be completely or optimally vectorised, it is a simple 
matter to manually clean-up the component, if desired, using the standard graphical 
editing tools in the Library Editor.

        7. Using Rename Component, name the component using the Bitmap ID# in the report 
text, including the minus (-) sign, if any.

        8. Using the Component Copy or Move command, add the renamed component into the 
PROTEL.LIB library. 

        9. Repeat this process for each unmatched component, being careful to rename the 
component with the precise Bitmap ID# in the report.

        10. Save the PROTEL.LIB library, which now includes your newly vectorised parts. You can 
discard the project library.

When loading any subsequent Schematic 3 files, parts which match the (now cleaned-up) 
original bitmap version will be automatically substituted. So, it is only necessary to perform 
one "clean-up" per unique pattern. 

New Features list



Edit File Types

File Types allows the user to assign a new file mask. For example, you may wish to change 
the default extension to search for other file types.

File masks are non-restrictive when opening files. Advanced Schematic identifies file types 
independently of the extension and converts other file types into Advanced Schematic formats 
automatically.






